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Foreword
After 17 years on the road, performing 35 Power Excel seminars a year, I had decided during to retire from 
the travel circuit. I still do a few online-only webinars. Check the MrExcel.com homepage for upcoming 
events.
The book you are reading was the book that I used in those seminars. I would update the book for a new 
edition of Excel, print 5000 copies and hit the road. This 2022 update is current through March 18, 2022.
See what is new in each edition on the second page of the book: "What is New in this 2022 Edition" on 
page 292.
You will see a number of shortlinks in this book in the format mrx.cl/short. The idea is that it will be easier 
for you to type mrx.cl than a long URL.

Sample File Downloads
The files used in this book are available for download from mrx.cl/2022bookfiles.

Edge Index
The numbers in the color blocks on the right side of the numbered pages form an edge index in the print-
ed book. The numbers roughly correspond to: 0 is front matter, 1 is favorite techniques, 2 is charting and 
visualization, 3 is data analysis, 4 is formulas, 5 is tools, and 6 is the index and back matter.
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#1 Double-Click the Fill Handle to Copy a Formula
You have thousands of rows of data. You’ve added a new formula in the top row of your data set, some-
thing like =PROPER(A2&" "&B2), as shown here. You need to copy the formula down to all of the rows of 
your data set.

Many people will grab the Fill Handle and start to drag down. But as you drag down, Excel starts going 
faster and faster. There is a 200-microsecond pause at the last row of data. 200 microseconds is long 
enough for you to notice the pause but not long enough for you to react and let go of the mouse button. 
Before you know it, you’ve dragged the Fill Handle way too far.

The solution is to double-click the Fill Handle! Go to exactly 
the same spot where you start to drag the Fill Handle. The 
mouse pointer changes to a black plus sign. Double-click. 
Excel looks at the surrounding data, finds the last row with 
data today, and copies the formula down to the last row of 
the data set.

In the past, empty cells in the column to the left would 
cause the “double-click the Fill Handle” trick to stop work-
ing just before the empty cell. But as you can see below, 
names like Madonna, Cher, or Pele will not cause problems. 
Provided that there is at least a diagonal path (for example, 
via B76-A77-B78), Excel will find the true bottom of the 
data set.

In my live Power Excel seminars, this trick always elicits a gasp from half the people in the room. It is my 
number-one time-saving trick.
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alternatives to Double-Clicking the Fill Handle

This trick is an awesome trick if all you've done to this point is drag the Fill Handle to the bottom of the 
data set. But there are even faster ways to solve this problem:

 ● Use Tables. If you select one cell in A1:B112 and press Ctrl+T, Excel formats the range as a table. Once 
you have a table, simply enter the formula in C2. When you press Enter, it is copied to the bottom.

 ● Use a complex but effective keyboard shortcut. This shortcut requires the adjacent column to have no 
empty cells. While it seems complicated to explain, the people who tell me about this shortcut can do 
the entire thing in the blink of an eye.

Here are the steps:

1. From your newly entered formula in C2, press the Left Arrow key to move to cell B2.

2. Press Ctrl+Down Arrow to move to the last row with data—in this case, B112.

3. Press the Right Arrow key to return to the bottom of the mostly empty column C.

4. From cell C112, press Ctrl+Shift+Up Arrow. This selects all of the blank cells next to your data, plus the 
formula in C2.

5. Press Ctrl+D to fill the formula in C2 to all of the blanks in the selection. Ctrl+D is fill Down.

Note: Ctrl+R fills right, which might be useful in other situations.

As an alternative, you can get the same results by pressing Ctrl+C before step 1 and replacing step 5 with 
pressing Ctrl+V.

Be careful when you are joining text with a date or with currency.  Even though your cells are formatted 
to show a currency symbol and two decimal places, the formula can't see the number formatting. You can 
explicitly add formatting using the TEXT function as shown here.
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1Thanks to the following people who suggested this tip: D. Carmichael, Shelley Fishel, Dawn Gilbert, @Knutsford_admi, Francis 
Logan, Michael Ortenberg, Jon Paterson, Mike Sullivan and Greg Lambert Lane suggested Ctrl+D. Bill Hazlett, author of Excel for 
the Math Classroom, pointed out Ctrl+R.

#2 Break apart Data
You have just seen how to join data, but people often ask about the opposite problem: how to parse data 
that is all in a single column. Say you wanted to sort the data in the figure below by zip code:

Tip: After March 2022, you could easily isolate the Zip code with =TEXTAFTER(A2," ",-1).  See "#98 
Text Before or After a Specific Delimiter" on page 208.

Select the data in A2:A99 and choose Data, Text to Columns. Because some city names, such as Sioux Falls, 
are two words, you cannot break the data at each occurrence of a space. Instead, you need to use a comma 
to get the city in column A and the state and zip code in column B, so choose Delimited in step 1 of the 
wizard and click Next.
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In step 2 of the wizard, deselect Tab and select Comma. The 
preview at the bottom of the dialog shows what your data 
will look like. Click Next.

Caution: For the rest of the day after you use 
Text to Columns, Excel will remember the choices 
you've chosen in step 2 of the Convert Text to 
Columns Wizard. If you copy data from Notepad 
and paste to Excel, it will be split at the comma. 
This is often maddening because most days, the 
data is not parsed at the comma, but for the rest of 
today, it will be. To fix it, close and re-open Excel.

Step 3 of the wizard asks you to declare each column as 
General, Text, or Date. It is fine to leave the columns set as 
General. 

After you‘ve split the state and zip code to column B, select 
B2:B99 and again choose Data, Text to Columns. This time, 
since each state is two characters, you can use Fixed Width 
in step 1 of the wizard. To preserve leading zeros in the zip 
code, select the second column and choose Text as the 
data type in step 3 of the wizard.
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Tip: A lot of data will work well with Fixed Width, even it doesn‘t look like it lines up. In the next 
figure, the first three rows are in Calibri font and don‘t appear to be lined up. But if you change the 
font to Courier New, as in rows 4:7, you can see that the columns are perfectly lined up.

Sometimes, you will find a data set where someone used Alt+Enter to put data on a new line within a cell. 
You can break out each line to a new column by typing Ctrl+j in the Other box in step 2 of the wizard, as 
shown below. Why Ctrl+j? Back in the 1980's IBM declared Ctrl+j to be a linefeed. Ctrl+j also can be typed 
in the Find & Replace dialog box. 

There are three special situations that Text to Columns handles easily:

 ● Dates in YYYYMMDD format can be changed to real dates. In step 3 of the wizard, click the column 
heading in the dialog, choose Date, then choose YMD from the dropdown.

 ● If you have negative numbers where the minus sign shows up after the number, go to step 3 of the 
wizard, click the Advanced Button, and choose Trailing Minus for Negative Numbers.

 ● Data copied from a Table of Contents will often have dot leaders that extend from the text to the page 
number as shown below. In step 2 of the wizard, choose Other, type a period, and then select the 
checkbox for Treat Consecutive Delimiters as One.

#3 Convert Text Numbers to Numbers Quickly
It sometimes happen that you end up with a long column of numbers stored as text and you need to con-
vert those to real numbers.

During 2020, the logic behind Convert to Number was rewritten. In the past, using this feature could 
take minutes, as Excel would recalculate the worksheet after each cell was converted to a number. Today, 
however, it is super-fast. Simply select the range of cells where the first cell is a number stored as text. An 
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on-grid drop-down will appear to the left of the top text number. Open the drop-down menu and choose 
Convert to Number.

Note that this option only appears if you have File, Options, 
Formula set to these:

Before Convert to Number was rewritten, my favorite method of converting Text Numbers would be to 
select the column of text numbers and press Alt+D E F. This would run the column through the defaults of 
Text to Columns.

For completeness, there is a third method. Select a blank cell and enter the number 1. Copy the 1 to the 
clipboard. Then select the cells with text numbers. From the Paste drop-down menu, choose Paste Special. 
In the Paste Special dialog, choose both Values and Multipy. When you multiply the 1  times text numbers, 
they will convert to real numbers. You can also copy any blank cell and then Paste Special Add. This adds a 
zero to the text numbers.
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#4 Filter by Selection
The filter dropdowns have been in Excel for decades, but there are two faster ways to filter. Normally, you 
select a cell in your data, choose Data, Filter, open the dropdown menu on a column heading, uncheck 
Select All, and scroll through a long list of values, trying to find the desired item.

One faster way is to click in the Search box and type 
enough characters to uniquely identify your selec-
tion.  Once the only visible items are (Select All Search 
Results), Add Current Selection to  Filter, and the one 
desired customer, press Enter.

But the fastest way to Filter came from Microsoft 
Access.  Microsoft Access invented a concept called 
Filter by Selection. It is simple: find a cell that contains 
the value you want and click Filter by Selection. The 
filter dropdowns are turned on, and the data is filtered 
to the selected value. Nothing could be simpler.

Starting in Excel 2007, you can right-click the desired 
value in the worksheet grid, choose Filter, and then 
choose By Selected Cells Value.

Guess what? The Filter by Selection trick is also built into Excel, but it is hidden and mislabeled.

Here is how you can add this feature to your Quick Access Toolbar: Right-click anywhere on the Ribbon 
and choose Customize Quick Access Toolbar.

There are two large listboxes in the dialog. Above the left listbox, open the dropdown and change from 
Popular Commands to Commands Not In The Ribbon.

In the left listbox, scroll to the command AutoFilter and choose it. That’s right: The icon that does Filter by 
Selection is mislabeled AutoFilter.

In the center of the dialog, click the Add>> button. The AutoFilter icon moves to the right listbox, as shown 
below. Click OK to close the dialog.
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Here is how to use the command: Say that you want to see all West region sales of widgets. First, choose 
any cell in column B that contains West. Click the AutoFilter icon in the Quick Access Toolbar. 

Excel turns on the filter dropdowns and automatically chooses only West from column B. 

Next, choose any cell in column E that contains Widget. Click the AutoFilter icon again.

You could continue this process. For example, you could choose a Utilities cell in the Sector column and 
click AutoFilter.

Caution: It would be great if you could multi-select cells before clicking the AutoFilter icon, 
but this does not work. If you need to see sales of widgets and gadgets, you could use Filter by 
Selection to get widgets, but then you have to use the Filter dropdown to add gadgets. Also. Filter 
by Selection does not work if you are in a Ctrl+T table.
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How can it be that this feature has been in Excel since Excel 2003, but Microsoft does not document it? It 
was never really an official feature. The story is that one of the developers added the feature for internal 
use. Back in Excel 2003, there was already an AutoFilter icon on the Standard toolbar, so no one would 
bother to add the apparently redundant AutoFilter icon.

This feature was added to Excel 2007’s right-click menu—but three clicks deep: Right-click a value, choose 
Filter, then choose Filter by Selected Cell’s Value.

Bonus Tip:  Filter by Selection for Numbers Over/under
What if you wanted to see all revenue greater than $20,000? Go to the blank row immediately below your 
revenue column and type >19999. Select that cell and click the AutoFilter icon.

Excel will show only the rows of $20,000 or above.
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#5 Total the visible rows
After you’ve applied a filter, say that you want to see the total of the visible cells.

Select the blank cell below each of your numeric columns. Click AutoSum or type Alt+=.

Instead of inserting SUM formulas, Excel inserts =SUBTOTAL(9,…) formulas. The formula below shows the 
total of only the visible cells.

Insert a few blank rows above your data. Cut the formulas from below the data and paste to row 1 with the 
label Total Visible.

Now, as you change the filters, even if the data fills up more than one full screen, you will see the totals at 
the top of your worksheet.
Thanks to Sam Radakovitz on the Excel team for Filter by Selection – not for suggesting Filter by Selection, but for formalizing 
Filter by Selection! Thanks to Taylor & Chris in Albuquerque for the Over/under technique.
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#6 The Fill Handle Does know 1, 2, 3…
Why does the Excel Fill Handle pretend it does not know how to count 1, 2, 3? The Fill Handle is great for 
filling months, weekdays, quarters, and dates. Why doesn’t it know that 2 comes after 1?

In case you’ve never used the Fill Handle, try this: Type a 
month name in a cell. Select that cell. There is a square dot 
in the lower right corner of the cell. This dot is called the Fill 
Handle. Hover over the Fill Handle.  The mouse cursor chang-
es from a white cross to a black plus. Click the handle and 
drag right or drag down. The tooltip increments to show the 
last month in the range.

Note: If it is not working, select File, Options, 
Advanced. The third checkbox toggles the Fill 
Handle.

When you let go of the mouse button, the months will fill in. 
An icon appears, giving you additional options.

The Fill Handle works great with months 
or weekdays.

The Fill Handle also works with quarters in many formats.

To do both quarters and years, you have to type a number, 
then Q, then any punctuation (period, space, apostrophe, 
dash) before the year.
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When you type 1 and grab the Fill Handle, Excel gives you 1, 
1, 1, … Many people say to enter the 1 and the 2, select them 
both, then drag the Fill Handle. Here is a faster way. 

The secret trick is to hold down Ctrl while dragging. Hold 
down Ctrl and hover over the fill handle. Instead of the 
normal icon of a plus sign, you will see a plus sign with a 
superscript plug sign. When you see the ++, click and drag. 
Excel fills in 1, 2, 3, ….

Note: Andrew Spain of Spain Enterprise in Huntsville, Alabama taught me a cool variation on this 
trick. If you start dragging without Ctrl, you can press Ctrl during the drag. A + icon appears at the 
bottom of the drag rectangle to indicate that you are going to fill instead of copy. If you need a 
great Excel Consultant, find Andrew at spainenterprise.com

How were we supposed to figure out that Ctrl makes the Fill Handle count instead of copy? I have no idea. 
I picked up the tip from row 6 at the IMA Meonske seminar in Kent, Ohio. It turns out that Ctrl seems to 
make the Fill Handle behave in the opposite way: If you Ctrl+drag a date, Excel copies instead of fills.

I‘ve heard another trick: Type 1 in A1. Select A1 and the blank B1. Drag. Excel fills instead of copies.

right-Click the Fill Handle for More Options

If you right-click and drag the Fill Handle, a menu appears with more options, like Weekdays, Months, and 
Years. This menu is great for dates.

What if your payroll happens on the 15th and on the last day of the month? Put in 
both dates. Select them both. Right-click and drag the Fill Handle. When you finish 
dragging, choose Fill Months.

Teach the Fill Handle a New List

The Fill Handle is a really handy tool. What if you could use it on all sorts of lists? You can teach Excel a new 
list, provided that you have anywhere from 2 to 240 items. Here is the easy way:

1. Type the list in a column in Excel.

2. Select the list.

3. Select File, Options, Advanced. Scroll almost to the bottom and click Edit Custom Lists.

https://spainenterprise.com/
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In the Custom Lists dialog, click Import.

Excel will now understand your list as well as it understands Sunday, Monday, Tuesday. Type any item from 
the list It does not have to be the first item.

Grab the Fill Handle and drag. Excel fills from your list.

I use this trick for lists that should be in Excel, such as a list of the U.S. states and a list of the letters of the 
alphabet.
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Bonus Tip: Fill Jan, Feb, ..., Dec, Total

A person in one of my seminars wanted to have Jan fill into 13 
values: Jan, Feb, Mar, Apr, May, Jun, Jul, Aug, Sep, Oct, Nov, Dec, 
Total. 

While you can edit any custom list that you create, you cannot 
edit the first four lists in the Custom Lists dialog. 

However, if you use the preceding tip to add a new custom list 
with the 13 values, that list wins. If two custom lists have the 
value Jan, the lowest one in the dialog box is the one that is used.

If you fiscal year ends March 31,  you could set up a list with Apr, 
May, Jun, ..., Jan, Feb, Mar, Total.

Bonus Tip: Fill 1 to 100,000 in a Flash

What if you have so many items that you can't drag 
the Fill Handle? Follow these steps:

1. Type the number 1 in a cell.

2. Select that cell.

3. On the Home tab, toward the right, in the Editing 
group, open the Fill dropdown and choose Series.

4. Select Columns.

5. Enter a Stop Value of 100000.

6. Click OK.

What if you have to fill 100,000 cells of bagel flavors?

1. Type the first bagel flavor in A1.

2. Select A1.

3. Type A100000 in the Name box and press Shift+Enter to select from the current cell to A100000.

4. Home, Fill, Series… and click AutoFill in the Type box. Click OK to fill from the custom list.
 Thanks to the person in row 6 at the Meonske Conference in Kent, Ohio, for suggesting this feature.

#7 Fast worksheet Copy
Yes, you can right-click any sheet tab and choose Move or Copy to make a copy of a worksheet. But that is 
the very slow way to copy a worksheet. The fast way: Hold down the Ctrl key and drag the worksheet tab 
to the right.
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The downside of this trick is that the new sheet is called January (2) instead of February – but that is the 
case with the Move or Copy method as well. In either case, double-click the sheet name and type a new 
name.

Ctrl+drag February to the right to create a sheet for March. Rename February (2) to March.

Select January. Shift+select March to select all worksheets. Hold down Ctrl and drag January to the right to 
create three more worksheets. Rename the three new sheets.

Select January. Shift+select June. Ctrl+drag January to the right, and you’ve added the final six worksheets 
for the year. Rename those sheets.

Using this technique, you can quickly come up with 12 copies of the original worksheet.

Illustration: Walter Moore

Bonus Tip: put the worksheet Name in a Cell
If you want each report to have the name of the worksheet as a title, use either of these

=TEXTAFTER(CELL("filename",A1),"]")

=TRIM(MID(CELL("filename",A1),FIND("]",CELL("filename",A1))+1,20)) &" Report"

The CELL() function in this case returns the full path\[File Name]SheetName. By looking for the closing 
square bracket, you can figure out where the sheet name occurs. 

If you plan on using this formula frequently, set up a book.xltx as described in "#8 Use Default Settings 
for All Future Workbooks" on page 19. In book.xltx, go to Formulas, Define Name. Use a name such as 
SheetName with a formula of =TEXTAFTER(CELL("filename",book.xltx!$A$1),"]"). Then, 
in any new workbook =SheetName&" Report" will work.
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Bonus Tip: add a Total row and a Total Column with One autoSum
Say that you want to add a total row and a total column to a data set. Select all the numbers plus one extra 
row and one extra column. Click the AutoSum icon or press Alt+=.

Excel adds SUM functions to the total row and the total column as shown in the figure below.

Bonus Tip: power up the Status Bar Statistics
When you select two or more numeric cells, the total appears in the status bar in the lower right of the 
Excel window. When you see a total, right-click and choose Average, Count, Numerical Count, Minimum, 
Maximum, and Sum. You can now see the largest, smallest, and average just by selecting a range of cells.

Tip: Left-click any number in the status bar to copy that number to the clipboard.

Bonus Tip: Change all Sheets with Group Mode

Any time your manager asks you for something, he or she comes 
back 15 minutes later and asks for an odd twist that wasn't speci-
fied the first time. Now that you can create worksheet copies 
really quickly, there is more of a chance that you will have to make 
changes to all 12 sheets instead of just 1 sheet when your manager 
comes back with a new request.

I will show you an amazingly powerful but incredibly dangerous 
tool called Group mode.
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Say that you have 12 worksheets that are mostly identical. You need to add totals to all 12 worksheets. To 
enter Group mode, right-click on any worksheet tab and choose Select All Sheets.

The name of the workbook in the title bar now indicates that you are in Group mode.

Anything you do to the January worksheet will now happen to all the sheets in the workbook.

Why is this dangerous? If you get distracted and forget that you are in Group mode, you might start enter-
ing January data and overwriting data on the 11 other worksheets!

When you are done adding totals, don’t forget to right-click a sheet tab and choose Ungroup Sheets.

Bonus Tip: Create a SuM That Spears Through all worksheets
So far, you have a workbook with 12 worksheets, 1 for each month. All of the worksheets have the 
same number of rows and columns. You want a summary worksheet in order to total January through 
December.

To create it, use the formula =SUM(January:December!B4).

Copy the formula to all cells and you will have a summary of the other 12 worksheets.

Caution: I make sure to never put spaces in my worksheet names. If you do use spaces, the for-
mula would have to include apostrophes, like this: =SUM('Jan 2025:Mar 2025'!B4).

Tip: If you use 3D spearing formulas frequently, insert two new sheets, one called First and one 
called Last. Drag the sheet names so they create a sandwich with the desired sheets in the middle.
Then, the formula is always =SUM(First:Last!B4).

Here is an easy way to build a 3D spearing formula without having to type the reference: On the sum-
mary sheet in cell B4, type =SUM(. Using the mouse, click on the January worksheet tab. Using the mouse, 
Shift+click on the December worksheet tab. Using the mouse, click on cell B4 on the December worksheet. 
Type the closing parenthesis and press Enter.
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Bonus Tip: use INDIrECT for a Different Summary report
Say that you want to build the following report, with months going down column A. In each row, you 
want to pull the grand total data from each sheet. Each sheet has the same number of rows, so the total is 
always in row 12.

The first formula would be =January!B12. You could easily copy this formula to columns C:F, but there is 
not an easy way to copy the formula down to rows 5:15.

The INDIRECT function evaluates text that looks like a cell reference. INDIRECT returns the value at the ad-
dress stored in the text. In the next figure, a combination of the ADDRESS and COLUMN functions returns a 
series of text values that tell Excel where to get the total.

Wrap the previous formula in =INDIRECT() to have Excel pull the totals from each worksheet.

Caution: INDIRECT will not work for pulling data from other workbooks. Search the Internet for 
Harlan Grove PULL for a VBA method of doing this.

Thanks to Othneil Denis for the 3D formula tip, Olga Kryuchkova for the Group mode tip, and Al Momrik for status bar.
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#8 use Default Settings for all Future workbooks
Do you have favorite worksheet settings in Excel? I do. There are things I do to every new workbook I 
create.

In a few minutes, you can teach Excel your favorite settings. Then, every time you create a new workbook 
with Ctrl+N or insert a new worksheet, the worksheet will inherit all of your favorite settings.

The key step is to save the workbook as a template into a specific folder with two specific names. 

Start with a blank workbook with a single worksheet.

Apply all your favorite settings. There are dozens of possibilities. Here are a few that I use:

On the Page Layout tab, change the Scale to Fit so the Width is 1 page. Leave Height set to Automatic and 
Width set to 1 Page.

Create a custom header or footer. Use the dialog launcher in the bottom right of the Page Setup group. Go 
to the Header/Footer tab. Choose Custom Footer. Type whatever is your company standard in the footer. 
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Create custom margins. I like narrow margins – even more narrow than the built-in Narrow margin set-
tings. I’ve been using 0.25-inch margins since the 1990s, and they‘re automatically set for me because I‘ve 
added that to my template.

Choose a theme. I like the colors from Slipstream, but I prefer the Effects from Office 2007–2010. 

When you set a pivot table default theme, it only applies to the current workbook. Excel never saves your 
preference. Create a tiny two-cell data set. Create a pivot table. Change the default formatting. Delete the 
pivot table and the data set. The template will remember the setting.
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Would you use cell styles more often if they weren’t 
so ugly? Do you hate that input cells are orange? Go 
to Cell Styles, right-click Input, and choose Modify as 
shown below. Click the Format button and choose a 
different input color.

If you develop some favorite functions stored as LAMBDA functions in the Name Manager, you can store 
those functions in your Book.XLTX workbook. Read more in "#95 Store Complex Formula Logic in LAMBDA 
function" on page 190.

I‘ve just shown you some of my favorite settings. I'm sure you have your own favorites. Maybe you always 
set up a name to define the tax rate. Add it to your template, and you will never have to set it up again. 
Turn off gridlines. Do whatever you always do.

Once you‘ve finished customizing your workbook, you need to figure out which file type you use most 
often. For people who never use macros, this is often XLSX. But I always use macros, so my default file type 
is XLSM. Maybe you want workbooks to open faster, and you use XLSB. There is a template format related 
to each of these file types, and you can just change the extension as needed. So, for me, I save the work-
book as XLTM. You might save it as XLTX.

As soon as you choose one of these file types, the Save As dialog box moves to a templates folder. You 
need to save the workbook in a different folder.

In the folder bar, type %AppData% and press Enter to get to the AppData\Roaming\ folder on your com-
puter. From there, navigate to Microsoft\Excel\XLSTART.

Save the workbook with the reserved name Book plus the appropriate extension. Use Save As again and 
save the workbook in the same folder but use Sheet plus the same extension as the name.

Of course, you only have to set this up once. After you do it, any time you use Ctrl+N to create a new work-
book, the new workbook will inherit all of the settings from your template named Book. 

Why did you have to also save templates named both Book and Sheet? Any time you insert a new work-
sheet into an existing workbook, Excel uses the Sheet template.

My rant about New and New…

I’ve been using Book.xltm for 30 years. In all versions of Excel from Excel 95 up through Excel 2003, the 
Excel Standard toolbar had an icon called “New”. Click that icon, and Excel loaded the Book template. 
Everything was great.
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The File menu offered a New… option, but hardly anyone used it because it was half as many clicks to 
simply click the New icon on the Standard toolbar. New respects your custom settings in the Book tem-
plate. New… does not.

If you’ve set up custom Book and Sheet templates, do not click the Blank Workbook template. Simply dis-
miss this opening screen by using the Esc key, and your custom Book template loads.

If you get tired of pressing Esc, go to File, Options, General and deselect the checkbox Show the Start 
Screen When This Application Starts.

Bonus Tip: Changes to Book Template  are Cumulative
I‘ve had the opportunity to speak at three consecutive Excelapalooza conferences near Dallas. The confer-
ence team arranges two simultaneous tracks about Microsoft Excel. While I am presenting in one ballroom, 
Lawrence “Mac” McClelland is presenting another track in another ballroom. I picked up this tip from Mac:

Anything you do to Book.xltx is cumulative. Build the workbook with your favorite settings today. If you 
discover some new settings that you would like to add to Book.xltx in the future, follow these steps:

1. Press Ctrl+N to open a blank version of Book.xltx.

2. Make any changes you would like.

3. Select File, Save As.

4. Change the file type to XLTX or XLTM, depending on whether you regularly use macros.

5. Change Folder to the XLStart folder.

6. Save the file as Book.xltx to replace the existing Book.xltx.

7. Repeat steps 3–5 and save the file as Sheet.xltx.
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Bonus Tip: replace the Comma Style in Book.xltx
The Excel team offers Currency, Percent, and Comma icons in the center of the Home tab of the Ribbon. 
The tooltip says the Comma Style formats with a thousands separator. I despise this icon.

Why do I despise this icon? Because it turns on Accounting style. Sure, that 
gives you a thousands separator, but it also adds several things that I hate: 

 ● It turns on two decimal places. 

 ● It uses a right indent of 1 character to move the last digit away from 
the right edge of the cell.

 ● It uses parentheses for negative numbers.

 ● It displays zero with a single dash about four spaces away from the 
right edge of the cell.

There is no way to replace the Comma icon with my own icon or even to change what style it applies. So, I 
find that I have to click the Dialog Launcher icon at the bottom right of the Number group:

Tip: The Dialog Launcher icon is a diagonal arrow pointing down and to the right. It is found in 
many groups in the Ribbon and usually offers far more choices than are available in the Ribbon.

Then choose Number from the Category list, choose the checkbox for Use 1000 Separator, and click twice 
on the down arrow to change 2 decimal places to 0 decimal places. Click OK to close the Format Cells 
dialog. It takes six clicks to create a simple number format with a comma as the thousands separator. That 
is why I despise the Comma icon: People who can live with right indents, parentheses, and zeros displayed 
as dashes can apply that style in one click, but people who just want a comma have to go through six 
clicks.
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The great news: There is a solution. The bad news: Microsoft makes it hard to use the solution. The good 
news: If you add the solution to the Book.xltx file, the solution will become mostly permanent for all files 
that you create. Here is what you do:

1. While you are creating Book.xltx, as discussed in "#8 Use Default Settings for All Future Workbooks", type 
1234 in a cell. Format the cell using the six clicks discussed above (or your favorite format). Keep that cell 
selected.

2. Open the Cell Styles gallery. Near the bottom, choose New Cell Style….

3. In the Style box that appears, type a descriptive name for your style, such as CommaGood.

4. If you only want to apply the Number format, unselect the checkboxes for Alignment, Font, Border, Fill, 
and Protection.

5. Click OK to create the new style.

New styles appear at the top of the Cell Styles gallery, and you now have one-click access to the 
CommaGood style.

Caution: Any cell style added using this method applies only to the current workbook, making this 
tip almost useless.

Tip: If you add the CommaGood style to your Book.xltx file, the CommaGood style will be available 
on all future workbooks that you create with Ctrl+N.

Thanks to Jo Ann Babin for an idea similar to this one.
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#9 recover unsaved workbooks
The Auto Recover feature is a lifesaver. It is turned on automatically in Excel 2010 and newer.

Say it is 4:59 PM on Friday, and you are trying to get the heck out of work. You have a bunch of files open in 
Excel and issue the Alt+F, X command to exit Excel.

Standing between you and the after-work happy hour are a bunch of dialogs like this one:

There is no need to save this file, so you click Don't Save. Next file? Don't Save. Next file? Don't Save.

Tip: Hold Shift while clicking Don‘t Save to perform Don‘t Save All.

Now you are in a rhythm, clicking Don‘t Save in perfect synchronization with Excel presenting the mes-
sage. Then, as you click Don‘t Save the last time, you realize that this workbook had a lot of unsaved chang-
es. And you really needed to save it. You should have clicked Save.

You look at your watch. It will take two hours to re-create all of those changes. Your happy hour plans 
are sunk. But wait! Excel has your back. If the workbook was open for at least 10 minutes and created an 
AutoRecover version, Excel kept a copy for you.

Follow these steps to get it back:

1. Open Excel.

2. In the left panel, choose Open Other Workbooks.

3. In the center panel, scroll all the way to the bottom of the recent files. At the very end, click Recover 
Unsaved Workbooks.
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4. Excel shows you all the unsaved workbooks that it has saved for you recently.

5. Click a workbook and choose Open. If it is the wrong one, go back to File, Open and scroll to the bottom 
of the list.

6. When you find the right file, click the Save As button to save the workbook. Unsaved workbooks are 
saved for four days before they are automatically deleted.

use autorecover versions to recover Files previously Saved

Recover Unsaved Workbooks applies only to files that have never been saved. If your file has been saved, 
you can use AutoRecover versions to get the file back. If you close a previously saved workbook without 
saving recent changes, one single AutoRecover version is kept until your next editing session. To access it, 
reopen the workbook. Use File, Info, Versions to open the last AutoRecover version. 

You can also use Windows Explorer to search for the last AutoRecover version. The Excel Options dialog 
box specifies an AutoRecover File Location. If your file was named Budget2025Data, look for a folder within 
the AutoRecover File folder that starts with Budget. 

While you are editing a workbook, you can access up to the last five AutoRecover versions of a previously 
saved workbook. You can open them from the Versions section of the Info category. You may make chang-
es to a workbook and want to reference what you previously had. AutoRecover versions open in another 
window so you can reference, copy/paste, save the workbook as a separate file, etc. New: If your file is 
saved in OneDrive, see "Bonus Tip: Roll Back to a Previous Version of the Workbook" on page 29.

Note: An AutoRecover version is created according to the AutoRecover interval AND only if there 
are changes. So if you leave a workbook open for two hours without making any changes, the last 
AutoSave version will contain the last revision. 

Caution: Both the Save AutoRecover Information option and Keep The Last AutoRecovered 
Version option must be selected in File, Options, Save for this to work. 

Tip: Create a folder called C:\AutoRecover\ and specify it as the AutoRecover File Location. It is 
much easier than trawling through the Users folder that is the default location.

Note: Under the Manage Version options on the Info tab you can select Delete All Unsaved 
Workbooks. This is an important option to know about if you work on public computers. Note that 
this option appears only if you’re working on a file that has not been saved previously. The easiest 
way to access it is to create a new workbook. 

Thanks to Beth Melton and Paul Seaman and for clarifying the differences between AutoRecover and Recover Unsaved Files.
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#10 Search while using File Open
When you choose File, Open, Excel will show you a list of recently opened workbooks. The size of this list 
is controlled by File, Options, Advanced, Display. The maximum numbers of recent workbooks or folders 
is 50. If you choose Quickly Access This Number Of Recent Workbooks, then a few workbooks will show in 
the left pane of the File menu, even in File, Home.

During 2020, a new Search box was added to the top of the File Open view. This Search box extends fur-
ther back than the recent 50 workbooks. Type a word and Excel will present you with a list of workbooks 
previously opened with that word in the title. You can also search by collaborator.

Bonus Tip: pin an Item to the Top of the recent Files
If you hover over any workbook in the File Open screen, a thumbtack appears. Click the icon to pin that 
item to the top of the recent files list. 

What if you want to remove a sensitive item from the Recent files? Right-click it for options.
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#11 Show Changes From Last 60 Days
The Show Changes feature debuted in June 2021. For any workbook that is stored in OneDrive or 
SharePoint Online, Excel is tracking every change to the workbook. Changes are saved for 60 days.

Let's say that you have a workbook which had been stored on your local hard drive. Do a File, Save As and 
save it in OneDrive. At that point, every change made to a worksheet will be logged. In the figure below, 
you type a new value in B5. The formulas in many other cells recalculate. But this is simply logged as a 
change to B5.

If someone edits a formula, that will be logged as a change and is viewable in Excel Online. 

Here is how to get to Excel Online. 

1. First, in Win32, go to File, Account and note how your are 
signed in to Office. You will need to sign in to Excel Online using 
the same credentials.

2. Open a modern browser such as Microsoft Edge or Google 
Chrome. In the address bar, type Excel.New

3. Look at your avatar in the top right corner (it might be your 
initials). Click and see how you are signed in. I am signed in to 
Office in Windows as X and for some reason, I am signed in to the 
browser as Y. If this sign-in does not match the sign-in in from 
step 1, then click Sign Out. Try Excel.New again. Hopefully, they 
will ask you to sign in and you have an opportunity to sign in with 
the correct identity. This is not a sure thing. There are two differ-
ent login systems at Microsoft - one for Consumers and one for 
Enterprise. The Consumer sign-in says that my Enterprise identity 
is not found in their database and that I don't exist. After a few 
more tries, I mysteriously ended up at a sign-in box that offered 
my Enterprise identity. 
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4. Once you are signed in correctly, go to File, Recent. The workbook that you have open in Win32 should 
be at the top of the list. Open that workbook in the browser.

5. On the Review tab in Excel Online, choose Show Changes. A Changes panel appears on the right side 
with all changes made to the workbook.

6. A quick way to filter to only the changes for a cell or range is to select the cell, right-click, and choose 
Show Changes.

If you need to clear the Changes pane, use Excel Onlne and File, Info, Reset Changes Pane.

Tip: It is important to realize that Show Changes is working perfectly in Excel for Windows and 
Excel for Mac. The only role that Excel Online plays in the equation is that the Changes pane is only 
visible in Excel Online. By the time you read this, it might be available in the Review tab of Excel for 
Windows.

Bonus Tip: roll Back to a previous version of the workbook
The Show Changes log has dramatically improved the Version History available in Excel Online. When you 
go to File, Info, Version History, a panel is displayed with past versions that you can roll back to. In Desktop 
Excel, the only choice is to blindly open a version from a specific date. The same panel in Excel Online 
shows who made edits in each version. Click a version to see which cells were edited.

Click any item in the Version History panel to show a preview of which cells were changed by which 
person. The changed cells are outlined in various colors to match the person who made the edits. If you 
find a version that you want to save, use the Save a Copy button to re-generate that version of the work-
book. Note that you can not make edits when Version History is shown. Use the Back To Document link in 
the top left to return to editing.

Tip: Microsoft isn't really saving many versions of the same workbook. They are saving the current 
workbook and the log of past changes. When you click Save a Copy, they are creating a new ver-
sion of the workbook by reversing the changes saved in the Save Changes log.
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#12 Simultaneously Edit a workbook in Microsoft 365
For decades, some people have been wanting a better way to have multiple people in the same work-
book at the same time. The old Shared Workbook functionality was awkward. People resorted to "only one 
person having write access at a time", which led to someone opening the file and then forgetting to close 
it before going for a two-hour lunch and tying up the file that whole time.

After Google's spreadsheet product began offering the 
ability for multiple people to edit the same worksheet, the 
Excel team spent many years developing a feature that they 
call co-authoring. The feature was released to Microsoft 365 
customers in the summer of 2017.

The feature works great if everyone you are sharing with 
are on the same tenant. For example, if everyone is using a 
signin ending @YourCo.onmicrosoft.com, then you are on 
the same tenant.

To start, choose one person to be the owner of the work-
book. This person should already have a One Drive For 
Business or SharePoint Online folder set up. The owner of 
the document should use File, Save As and choose to save 
the document in either One Drive or SharePoint Online.

The owner of the workbook clicks the Share icon in the top 
right corner of Excel.

The Share panel asks you to invite people by e-mail address. 
The people you share with will receive an Outlook e-mail 
with a link to the file. They can also see the workbook in File, 
Open, Shared With Me.

If you are not in the same tenant, look at the bottom of the 
panel, you can generate a sharing link.

Generate a sharing link where anyone with the link can edit 
the workbook.

Copy the link and send it to others on your team.
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The next step is the annoying part. When they follow the link from Outlook, the workbook will open in 
Excel Online. The best step at this point is to use File, Open in Excel.

Tip: I actually avoid opening the workbook from Outlook. Instead, I go to File, Home. In the middle 
of the screen is a tab for Shared With Me. I find the file there and open it in Excel Online.

While you and others are working in a document, your active cell will be outlined in green. The active cells 
for others will be other colors. If you want to know who is editing a cell, hover over that cell.

Some people complain that when a dozen people are all moving around the same spreadsheet, having so 
many cell indicators moving around is annoying. Microsoft has heard this complaint and is trying to figure 
out the best way to mute or at least tone down Presence.

Co-authoring will work fine provided everyone avoids editing the same cell at the same time. When some-
one (probably your manager), dives in to edit a cell that you are already editing, then a confusing set of 
rules decides whose edit wins. Rather than dealing with these rules, be happy that co-authoring mostly 
works and have everyone agree not to edit the same cell at the same time.

Co-authoring is a whole new experience. There are good things and bad things that you need to get used 
to when you are co-authoring.

Bonus Tip: avoiding the veto
A "veto" is when Excel reports that your changes could not be synchronized. Microsoft is working hard to 
minimize these. They've already reduced them by 90%. But they still happen. One of my training clients 
learned that occassionally clicking Save will minimize the chance of a veto. Microsoft confirms this.

Bonus Tip: autoSave is Necessary, But Turn it Off when Not Co-authoring
The reason that co-authoring is possible is because of AutoSave. Every time that you make a spreadsheet 
change, that change will be saved to OneDrive so that others can (almost) instantly see what you just 
typed. AutoSave is necessary if you want ten accountants editing a budget worksheet at the same time.

But let's talk about workbooks that will never be used with co-authoring. These are the run-of-the-mill 
workbooks that I use 99.9% of the time. I do not want AutoSave to be active for those workbooks. I want 
to open Excel, know that I can do some "what-if" changes and then close the workbook without saving. If 
AutoSave is on, those changes are automatically saved. It is terrible.
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Or - you likely recognize the scenario: You have a report for January. You need a report for February. You 
open the January report, change the headings, and then do File, Save As to save for February. This work-
flow has been fine for decades. But if you allow AutoSave to be on, you will be destroying the January 
report as soon as you edit A1 and type February over January.

You have four choices. 1. Change your workflow to 
do the Save a Copy before you make any edits.  2. 
Always save to a local drive and AutoSave will not 
automatically be enabled. 3. Toggle AutoSave off for 
each workbook. Click the "On" icon shown here to 
turn AutoSave off for the current workbook.

The best choice is 4. Go to File, Options, Save, and unselect the choice for AutoSave OneDrive and 
SharePoint Online Files By Default.

Bonus Tip: undo an autoSave
What if you have to undo an AutoSave? Your manager said to merge two regions and then 20 minutes 
later calls the merger off. AutoSave has been saving after every change in your workbook.

Click the drop-down menu next to the title bar. Click on Version History.

Excel will offer to let you open a previous version of the file. They don't save a version after every change. 
I (Bill Jelen) made 50 changes to this workbook in the last 20 minutes. The Version History is offering me 
three versions from those twenty minutes. Note that although all of the changes were made by Bill Jelen, 
AutoSave is crediting the changes to Mary Ellen Jelen. No one at Microsoft can explain this apparent bug.

#13 Save Filter & Sorting in Sheet view
Do you share a workbook with co-workers? Does you co-worker want to Filter or Sort the workbook differ-
ently than you do? Eight years ago, I was ready to strangle my co-worker Scott when he kept filtering our 
project list to show only his projects.

Amazingly, the Excel team has provided a new solution called "Sheet View". It debuted for Microsoft 365 in 
March 2020.

Caution: Sheet View only works if you store your workbook in OneDrive or SharePoint online. It is 
fine for everyone to access the workbook on the PC, but it has to be saved in the cloud.
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Caution: There is a pretty bad bug in Sheet View if you have a team of people working in Desktop 
Excel. Everything is fine when the first person creates a Sheet View. But when the second person 
creates a Sheet View, the default view changes for everyone. Microsoft's solution to this bug: If 
your team is all using Windows versions of Excel and people want to use Sheet View, then every-
one needs to create a Sheet View and use it.

Tip: I will extend their advice and suggest that someone creates a Sheet View called Show All and 
have that view be unfiltered.

Below is a small workbook that Andy and Betty share. The Ribbon is showing the new Sheet View settings 
that are found on the View tab.

Tip: Before you create a view for Andy or Betty, create an unfiltered view called All or Everyone or 
Default.

To create a new Sheet View, click New.
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The new view is initially called Temporary View. Apply any formatting or sorting. In the image below, Andy 
has filtered to his records and sorted the projects high-to-low.

If you want to be able to return to this view in the future, you can either click the Keep icon or simply type 
a new name such as Andy Descending.

Notice that the Row and Column labels are now black. This is to alert you that you are seeing a Sheet View.

When Betty opens the workbook, she can filter to Betty and sort ascending. She might name her view as 
BettyAscending.
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This next part is absolutely wild. Say that Andy edits cell C2 in his view and changes the value to $100,000. 

When anyone goes back to the Default view of the workbook, the original sort order is retained. But - the 
new value for Andy's project A008 is still $100,000! 

I've asked the Excel team how they manage to do this behind the scenes, and I still don't know how they 
manage to keep it all tied together. But it works.

Tip: You might be happy having two different views of the workbook for your own use. But this 
feature is really designed for when you are collaborating with the whole department. See "#12 
Simultaneously Edit a Workbook in Microsoft 365" on page 30.
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#14 New Threaded Comments allow Conversations

Threaded comments debuted in 2018. When you 
insert a comment, Excel stores the comment, the 
author, the date, and time. When a co-worker sees 
your comment, they can click Reply and add a new 
comment to the same cell. Each set of comments 
lists the author, date, and time. Use the ... menu 
to mark a comment as resolved. If you @Mention 
someone, they will be notified by Outlook.

These new threaded comments are indicated by a 
five-sided purple shape instead of the red triangle 
used for the old style comments (now known as 
Notes).

Note: If you are using Excel Online, you 
have a choice for Comments or Chat. While 
comments are stored in the workbook, any-
thing typed in Chat will be deleted when 
you close the workbook.

Bonus Tip: Old Style Comments are available as Notes
While the new threaded comments are cool, there are some great tricks that the old legacy comments of-
fered that are lost with the threaded comments. Luckily, if you have a situation requiring one of the special 
tricks, the old comments are still available as Notes.

Here are some of my favorite Note techniques:

 ● Individual notes could be set to always show. This is useful for creating helpful instructions for a 
spreadsheet.  Select a cell containing a red-triangle indicator and select Review, Notes, Show/Hide 
Note.

 ● Notes can be resized and located in a specific position. Right-click a cell with a note and choose Edit 
Note. Use the resize handle to change the size or drag an edge to move the comment.

 ● You can change the shape of a note.  To start, Right-click the Ribbon and choose Customize Quick 
Access Toolbar. In the dialog box, change the top-left drop-down menu to All Commands. Find the 
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Change Shape icon in the left list and click the Add>> button to add it to the Quick Access Toolbar.  
Right-click the cell containing the note and choose Show Note. Ctrl+Click on the edge of the note to 
select the note without entering text edit mode. Use the Change Shape icon in the Quick Access tool-
bar to choose a new shape. Note that you will often have to resize the note after choosing a shape. You 
also might try the Center and Align Middle icons to center the text in the shape. After changing the 
shape, you can return to Hide Note to make the note only visible when you hover over the red triangle 
indicator.

 ● You can change the color of a note. This one is tricky because there are two versions of the Format 
Comment dialog box. While in edit mode, click the border of the comment and then press Ctrl+1 to 
open the Format Comment dialog box. You should see nine tabs in the dialog. If you only see the Font 
tab, close the dialog and try clicking the comment border again or Ctrl+Click the comment to leave 
text edit mode.  When you have the dialog with all 9 tabs, use the Colors and Lines tab, Fill Color to 
change the color of a comment. Use Fill Effects… to add a gradient or a picture.

 ● To create pop-up pictures: edit a note and backspace to remove your name from the note. With a 
completely blank note, Ctrl+Click the edge and press Ctrl+1. Use Colors and Lines, Fill Color, Fill Effects, 
Picture and choose a picture from your computer. Hide the note and the picture will pop up when you 
hover over the triangle.

The following screenshot shows examples of notes with colors, shapes, and a pop-up picture.
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Bonus Tip: add a Tooltip to a Cell with validation
In the previous Bonus Tip, I suggested using Notes for a help system. The problem with notes: it is possible 
to arrow in to a cell without ever hovering over the red triangle and the note might be missed. You can use 
the Data Validation dialog to set up a tooltip for a cell. The tooltip is only visible when the cell is the active 
cell.

Data Validation is found towards the right side of the 
Data tab in the Ribbon. I end up using Alt+D L because 
I always have a difficult time finding the Validation icon. 
Normally, most people use the Settings tab in Data 
Validation to control what can be entered in a cell. You 
will skip the Settings tab and go to the Input Message 
tab.

On the Input Message tab, type a title and a message. Click OK.

The result: a tooltip that will appear any time the cell is active:

Bonus Tip: Data validation partial Matching added in 2022
For many years, people were frustrated that a data validation drop-down list did not use partial matching. 
There were a few hacks, such as Alfred F Vachris Jr's trick of using look-ahead typing as described at  
http://mrx.cl/lookahead.
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Starting in March 2022, Microsoft 365 customers will be able to use partial matching for their Data 
Validation lists. In this figure, the valid list for cell C2 is shown in E2:E9. Type "Ap" and Excel shortens the 
list to include entries where any word in the entry starts with "Ap". This means you get Apple, Fuji Apple, 
Crab Apple. But they don't see Pineapple as a match. Also note that the list is presented with Apple Butter 
higher in the list than Fuji Apple because Apple Butter starts with "Ap".

#15 Create perfect One-Click Charts
One-click charts are easy: Select the data and press Alt+F1.

What if you would rather create bar charts instead of the default clustered column chart? To make your 
life easier, you can change the default chart type. Store your favorite chart settings in a template and then 
teach Excel to produce your favorite chart in response to Alt+F1.

Say that you want to clean up the chart above. All 
of those zeros on the left axis take up a lot of space 
without adding value. Double-click those numbers 
and change Display Units from None to Millions.
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To move the legend to the top, click the + sign 
next to the chart, choose the arrow to the right of 
Legend, and choose Top.

Change the color scheme to something that works 
with your company colors.

Right-click the chart and choose Save As Template. 
Then, give the template a name. (I called mine 
ClusteredColumn.)

Select a chart. In the Design tab of the Ribbon, 
choose Change Chart Type. Click on the Templates 
folder to see the template that you just created.

Right-click your template and choose Set As 
Default Chart.
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The next time you need to create a chart, select 
the data and press Alt+F1. All your favorite settings 
appear in the chart.

Thanks to Areef Ali, Olga Kryuchkova, and Wendy Sprakes for suggesting this feature.

#16 paste New Data on a Chart
You might be responsible for updating charts every month, week, or day. For example, in my last job, a 
collection of charts were updated during the month-end close process. The charts would track progress 
throughout the year. 

There is an easy way to add new data to an existing chart. Here, the chart shows data for January through 
May, and there is new data for June that is not on the chart.

Rather than re-create the chart, you can paste new data on it. Select the new data in the worksheet, in-
cluding the heading. Press Ctrl+C to copy.
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Click on the chart and press Ctrl+V to paste the data on the chart. As shown below, the new data is added 
to the existing chart.

As you keep adding months to the right side, what if you want to remove data from the left side? Is there 
any way to Ctrl+X that data off the chart?

No, but there is another way. Select the chart. Outlines appear around the charted data in the worksheet. 
A blue box surrounds the data points for the charts, and in each corner of the blue box is a square dot as 
shown below. The square dot is a resizing handle.

Click on the lower-left resizing handle and drag to the right.
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The data is removed from the left side of the chart.

You can use resizing handles to resize or drag the blue box to change the data that appears on the chart. 
Of course, you could have dragged the bottom-right resizing handle to add June to the chart in the first 
place, but it is good to know this copy-and-paste trick in case the chart and data are on different sheets in 
the workbook.

Tip: If you want to remove East from the chart, you can click on any East column in the chart and 
press Delete on your keyboard to remove that series. To temporarily hide a series, you can hide the 
row or column where the underlying data is stored. In Excel 2013 or newer, you can use the Filter 
funnel icon located to the right of the chart to hide any series or category from the chart.

#17 Create Interactive Charts
It is easy to create interactive charts without using VBA. By default, if you hide rows in Excel, those rows will 
be hidden in the chart. The technique is to build a chart with every possible customer and then use a slicer 
or a filter to hide all except one of the customers.

Say that you have the following list of customers. Make the data into a table by using Ctrl+T.
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Select the table and insert a chart. In most cases, Excel will create the wrong chart, with customers along 
the X-axis.

Click the Switch Row/Column icon in the Chart Tools Design tab of the Ribbon.

Select one cell in the table. In Excel 2013 or newer, go to the Insert tab of the Ribbon and choose Slicer. In 
Excel 2010 or earlier, you have to use the Company dropdown in A17 to choose a single company.

By default, every slicer starts as a single column in the middle of the screen. Plan on dragging the slicer to 
a new location and size. While the slicer is selected, you can use the Columns spin button near the right 
side of the Slicer Tools Options tab of the Ribbon to change the number of columns in the slicer.

In the following figure, choose one customer from the slicer and the chart updates to show just that one 
customer.
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Choose a different customer, and the chart updates for that customer.

#18 Show Two Different Orders of Magnitude on a Chart
It is nearly impossible to read a chart where one series is dramatically larger than other series. In the fol-
lowing chart, the series for Year to Date Sales is 10 times larger than most of the monthly sales. The blue 
columns are shortened, and it will be difficult to see subtle changes in monthly sales.

Combo charts were always possible in Excel, but they have a new interface starting in Excel 2013. Choose 
the chart above and select Change Chart Type. Choose Combo from the category list on the left. You then 
have the choices shown below. Move the larger number (YTD Sales) to a new scale on the right axis by 
choosing Secondary Axis. Change the chart style for one series to Line from Clustered Column.

The result: Columns for the monthly revenue are taller, so you will be able to make out subtle changes like 
a decrease from July to August.
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To get the additional formatting to the chart above, select the numbers on the left axis. Use the Font Color 
dropdown on the Home tab to choose a blue to match the blue columns. Select the green line. Select 
Format, Shape Outline to change to a darker green. Select the numbers on the right axis and change the 
font color to the same green. Double-click each axis and change Display Units to Thousands. Double-click 
a blue column and drag the Gap Width setting to be narrower. Double-click the legend and choose to 
show the legend at the top.

#19 Create waterfall Charts
For 12 years, I worked at a company doing data analysis. One of my regular tasks was to analyze the profit 
on sales proposals before they went out the door. I did this with a waterfall chart. For me, the waterfall 
chart never would have to dip below the zero axis. I used a few tricks to make the columns float and drew 
the connector lines in by hand, using a ruler and a black pen. 

Excel 2016 introduced a built-in Waterfall chart type. Select your range of data and create the chart. In the 
chart below, three columns are marked as total: Net Price, Gross Profit, and Net Profit. Excel won't auto-
matically know which columns should be totals. Click any column to select all columns in the chart. Then 
single-click one total column. Right-click and select as Total. Repeat for the other columns that should 
touch the X-axis.

The waterfall charts even work for cash flow charts that might go below zero.
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Tip: To change the color for Increase/Decrease or Total: Click on the legend and then click on one 
item in the legend. Press Ctrl+1 to open the Format panel for that series and choose a new Fill 
Color.

#20 Create Funnel Charts
In 2016, Microsoft 365 introduced Funnel charts, as well as Treemap, Sunburst, Box & Whisker, Pareto, and 
Histogram charts. A Funnel chart is great for showing a sales funnel.

#21 Create Filled Map Charts in Microsoft 365
Early in 2017, Map Charts appeared on the Insert tab in Microsoft 365. A Map chart shades closed regions 
on a map such as countries, states, counties, even zip code boundaries.

When you format a series in a Map, you can choose if it should show all 50 states or only the regions with 
data. Choose what makes the most sense for your data. In the chart on the left, the series color is a two-
color gradient. You can choose three-color gradients or a category map, as shown on the right.
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#22 Create a Bell Curve
I have 2300 Excel videos on YouTube. I can never predict which ones will be popular. Many videos hover 
around 2,000 views. But for some reason, the Bell Curve video collected half a million views. I am not sure 
why people need to create bell curves, but here are the steps.

A bell curve is defined by an average and a standard deviation. In statistics, 68% of the population will fall 
within one standard deviation of the mean. 95% falls within two standard deviations of the mean. 99.73% 
will fall within three standard deviations of the mean.

Say that you want to plot a bell curve that goes from 100 to 200 with the peak at 150. Use 150 as the mean. 
Since most of the results will fall within 3 standard deviations of the mean, you would use a standard de-
viation of 50/3 or 16.667.

1. Type 150 in cell B1.

2. Type =50/3 in cell B2.

3. Type headings of Point, X, Y in cells A4:C4.

4. Fill the numbers 1 to 61 in A5:A65. This is enough points to create a smooth curve.
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5. Go to the midpoint of the data, point 31 in B35. Type a formula there of =B1 to have the mean there.

6. The formula for B36 is =B35+($B$2/10). Copy that formula from row 36 down to row 65.

7. The formula for B34 is =B34-($B$2/10). Copy that formula up to row 5. Note that the notes in columns 
C:E of this figure do not get entered in your workbook - they are here to add meaning to the figure.

The magic function is called NORM.DIST which stands for Normal Distribution. When statisticians talk 
about a bell curve, they are talking about a normal distribution. To continue the current example, you want 
a bell curve from 100 to 200. The numbers 100 to 200 go along the X-axis (the horizontal axis) of the chart. 
For each point, you need to calculate the height of the curve along the y-axis. NORM.DIST will do this for 
you. There are four required arguments: =NORM.DIST(This x point, Mean, Standard Deviation, False). The 
last False says that you want a bell curve and not a S-curve. (The S-Curve shows accumulated probability 
instead of point probability.)

8. Type =NORM.DIST(B5,$B$1,$B$2,False) in C5 and copy down to row 65.
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9. Select B4:C65. On the Insert tab, open the XY-Scatter drop-
down menu and choose the thumbnail with a smooth line. 
Alternatively, choose Recommened Charts and the first option 
for a bell curve.

The result: a bell curve, as shown here.

#23 plotting Employees on a Bell Curve
Rather than creating a generic bell curve, how about plotting a list of employees or customers on a bell 
curve? Start with a list of people and scores. Use the AVERAGE and STDEV.P functions to find the mean and 
standard deviation.

Once you know the mean and standard deviation, add a Y column with the formula shown below.
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After adding the Y column, sort the data by 
Score ascending. 

Select Score & Y columns and add a Scatter with 
Smooth Lines as shown in the previous technique. 
Labelling the chart with names is tricky. Use the + icon 
to the right of the chart to add data labels. From the 
Data Labels flyout, choose More Options. In the panel 
shown below, click the icon with a column chart and 
then choose Value from Cells and specify the names in 
column A.

Tip: You will often have two labels in the chart 
that appear on top of each other. You can rear-
range single labels so they appear with a small 
leader line as shown for Gary and Ed at the 
right side of the chart. Click on any label and all 
chart labels are selected. Next, click on either 
of the labels that appear together. After the 
second click, you are in "single label selection 
mode". You can drag that label so it is not on 
top of the other label.

The result:
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#24 add Meaning to reports using Data visualizations
Three easy visualization tools were added to the Conditional Formatting dropdown in Excel 2007: Color 
Scales, Data Bars, and Icon Sets. 

Consider this report, which has way too many decimal places to be useful.

Select the numbers in the report and choose Home, Conditional Formatting, Color Scales. Then click on 
the second icon, which has red at the top and green at the bottom.

With just four clicks, you can now spot trends in the data. Line 2 started out the day with high reject rates 
but improved. Line 3 was bad the whole day. Line 1 was the best, but even those reject rates began to rise 
toward the end of the shift.
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The next tool, Data Bar, is like a tiny bar chart that fills a 
cell. In the following figure, select all of the Revenue cells 
except for the grand total.

Choose Conditional Formatting, Data Bar, 
Green. Each number now gets a swath of 
color, as shown below. Large numbers get 
more color, and small numbers get hardly 
any color.

Caution: Be careful not to include the grand total before selecting Data Bars. In the following 
example, you can see that the Grand Total gets all of the color, and the other cells get hardly any 
color.
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With the third tool, Icon Sets, you can choose from sets that have three, four, or five different icons.

Most people keep their numbers aligned with the right edge of the cell. Icons always appear on the left 
edge of the cell. To move the number closer to the icon, use the Increase Indent icon, shown below.

All three of these data visualization tools work by looking at the largest and smallest numbers in the range. 
Excel breaks that range into three equal-sized parts if you are using an icon set with three icons. That works 
fine in the example below.

But in the following figure, Eddy scored horribly in Q1, getting a 30. Because Eddy did poorly, everyone 
else is awarded a gold star. That doesn‘t seem fair because their scores did not improve. 
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You can take control of where the range for an icon begins and ends. Go to Home, Conditional Formatting,  
Manage Rules and choose Edit Rule. In the following figure, the Type dropdown offers Percent, Percentile, 
Formula, and Number. To set the gold star so it requires 90 or above, use the settings shown below. Note 
that the two other icons have been replaced with No Cell Icon.

#25 use  people to add Interest to your worksheet
Microsoft 365 subscribers now have access to 925  People in Excel. In a study conducted by YouTube, 90% 
of the most-watched videos have an emotive human face prominently on the title card. Photos of people 
attract attention. Try adding a  person to your next report to get someone to look at the report.
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To insert a  person, go to Insert, Icons. Across the top of the dialog, you can choose from Images, Icons,  
People, Stickers, Illustrations, and Cartoon People. Click on  People. 

There are 925 poses of 41 people. Each person has from 15 to 30 multiple poses, exhibiting different emo-
tions. There are people holding their thumb up, or down. Seven of the people offer a series with 1, 2, 3, 4, 
or 5 fingers extended up. 

To find all poses of one person, you might have to know their name to search. Small tiles identify 32 of the 
41 people (chosen at random). If you want someone without a name tile, you can type their name in the 
search box.

The names of people in the photo below are: (Row 1) Addison, Alexander, Alfredo, Angela, Anthony, Babs, 
Basia, Carrie, Chantel, Charles, Christania, Deepika, Dennis, Elena, Fu, Herlinda, Jian, Jonathan, Kairy, Karun, 
and Kesha. Row 2: Kevin, Klein, Lance, Mara, Marci, Melanie, Melissa, Nicole, Noah, Pavan, Rachel, Randy, 
Shao, Sherri, Shreya, Soham, Stanley, Tanvi, Tiyna, and Ursula.

While you can search for people by name, you can also search by emotion or action. You can find people 
who are happy, excited, frustrated, pointing, or holding a sign. They’re also grouped by angle. Searching 
for “Profile” will find people facing to the side, for example, while searching for “Back” will find people 
facing away from you.

Below, a series of photos of Karun could be used to illustrate five sequential steps.
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Bonus Tip: add Text to the Sign Held by a  person
There are also poses where the  person is holding a blank sign. You can add text to the sign, like in this 
image of Angela on the left or the tableau created from Cartoon People:

Here are the steps for adding text to a sign and making it look natural:

1. Use Insert, Icons,  People, and search for “Sign.”

2. Select a person and click Insert.

3. Resize the person as needed to fit the situation.

4. Click any cell outside of the picture to unselect the picture.

5. Use Insert, Shapes, Textbox. Draw a text box that aligns closely with the sign.

6. The color of the sign and the color of the white text box in Excel don’t match exactly. With the text box 
selected, go to Shape Format, Shape Fill, & choose No Fill. This will make the background of the text box 
transparent and match the color of the sign. On the same tab, choose Shape Outline, No Outline.

7. Type your text to appear on the sign. On the Home tab, use Increase Font, Center, Middle Align, Font 
Color, and Font to make the text on the sign stand out.

Note: I keep picturing the photo shoot where these people were put through the paces of being 
photographed with up to 270 different emotions. It had to be a tiring day. At the point where 
they asked people to hold a large blank sign, I doubt that anyone bothered to have a carpenter’s 
level handy to make sure the sign was completely level. In most cases, the sign is tilted by a few 
degrees.

8. Align the top of the text box with the top of the sign. Make sure the text box is selected. Go to the Shape 
Format tab in the ribbon and look for the Arrange group toward the right side. The last drop-down in that 
group is called Rotate. Open the drop-down menu and choose More Rotation Options. This opens the 
Format Shape task pane. The Rotation spin button allows you to rotate in 1-degree increments. Rotate 
using the spin button until the text box lines up with the sign.
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Bonus Tip: use a Formula to Toggle pictures
With the new  people, it would be cool if you could toggle in a happy or sad version of a person depending 
on a formula. Here are the steps:

1. Arrange the various images so they are in a single row or column. Make the cell height and width large 
enough so each cell completely holds the picture.

2. Copy the cell containing the first photo. Make sure you are copying the cell and not the photo itself. This 
is often harder than it sounds since the image takes up most of the cell. In the image below, I had to click 
into B2 and then use the right arrow to select C2.

3. Select the spot where you want the photo to appear. Open the Paste drop-down on the Home tab and 
select the final icon: Paste Linked Picture.
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The linked picture appears. When the linked picture is selected, look in the Formula Bar. You will see that 
the linked picture has a source, currently =$C$2.

The trick is to change the linked picture formula from =$C$2 to something using OFFSET or INDEX. Notice 
that B8 is a formula that is currently returning 0 for Did Not Meet or 1 for Met Goal. This lends itself to the 
OFFSET function:  =OFFSET($C$2,0,$B$8). If the formula was returning 1 for Did Not Meet and 2 for Met 
Goal, then you could use =INDEX($C$2:$C$3,1,$B$8). In this case, INDEX is preferable because OFFSET is 
volatile.

Caution: You can not type this formula in the Formula Bar. Instead, you have to create a Defined 
Name. The formula in the Defined Name needs to have the sheet name for each range. If your 
worksheet name is Dashboard, then the formulas above would become: =OFFSET(Dashboard!$C$
2,0,Dashboard!$B$8) or =INDEX(Dashboard!$C$2:$C$3,1,Dashboard!$B$8).

Caution: If you use spaces in your worksheet name, then wrap the sheet name in apos-
trophes. For example, with a sheet name of My Dashboard, you would need =INDEX('My 
Dashboard'!$C$2:$C$3,1,'My Dashboard'!$B$8).

4. Go to Formulas, Define Name. Type a name such as WhichRandy. Use a formula like the ones listed 
above. Click OK.
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5. Click on the image in your dashboard that you want to have change. With that linked picture selected, 
click in the formula bar and change the formula to =WhichRandy.

6. If desired, hide the "1" in B8 by putting it behind Randy's head. Now, as the formula in B8 changes, the 
image of Randy would change.

  

#26 Make an Image Semi-Transparent
Semi-transparent images became easier in Microsoft 365 starting in the fall of 2019. If you use Insert, 
Image, the image always covers the data in the cells. Starting in 2019, you can use the Transparency drop-
down on the Picture Format tab of the Ribbon to change the picture transparency.

Tip: Picture Transparency is better than the old Page Layout, Background. When you choose a 
background image, it displays behind the numbers, but it will not print. With Picture transparency, 
you can control the size and shape of the image.

Caution: In the screenshot above, you will see the Remove Background tool. There is also a 
Set Transparent Color option under the Color drop-down menu. Both tools are finicky. The Set 
Transparent Color might work for a sign being held by a  Person, but it won't work for a sky 
with many shades of blue. The Remove Background tool asks you to mark areas to keep and 
areas to remove. It seems that when you click a new area, the logic recalculates the old areas. As 
you remove a new section, the old sections come back. To painlessly remove backgrounds, try 
PhotoShop or Topaz Mask AI. 
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#27 Save any Object as an Image
Starting in 2020 for Microsoft 365, you can right-click any object in Excel and choose Save As Picture. If you 
want to save a Chart plus a  Person, you can select them both and then choose Group from the Format 
Picture tab of the Ribbon.

Tip: What if you want to save a picture of values in cells? You could use Paste Linked Picture, or 
simply use the Office Snipping Tool with Win+Shift+S.

#28 Set up your Data for Data analysis
Make sure to follow these rules when you set up your data for sorting, subtotals, filtering and pivot tables. 

 ● Rule 1: Use only a single row of headings above your data. If you need to have a two-row heading, set 
it up as a single cell with two lines in the row. 

 ● Rule 2: Never leave one heading cell blank. This often happens to me when I set up a temporary 
column.

 ● Rule 3: There should be no entirely blank rows or blank columns in the middle of your data. It is okay to 
have an occasional blank cell, but you should have no entirely blank columns.

 ● Rule 4: If your heading row is not in row 1, be sure to have a blank row between the report title and the 
headings. It is fine to make this blank row have a row height of 1 so it is barely visible.

 ● Rule 5: If you have a total row below your data, leave one blank row above the totals.

 ● Rule 6: Formatting the heading cells in bold will help the Excel’s IntelliSense module understand that 
these are headings. 

Caution: Following these rules may not help if your data is only two columns wide.

Tip: To test, select one cell in your data and press Ctrl+* to select the current region. It should in-
clude your data and your headings, but not any Title rows or total row or footnotes.

Bonus Tip: use accounting underline to avoid Tiny Blank Columns
I once worked for a manager who was very particular about the heading underlines in a report.

The manager hated the regular underlines shown in row 1 below. In cell E1, the underline is only as wide 
as the characters in the cell. If I tried using a bottom border instead of the underline, you would get a 
single, long, "uniborder" as shown in row 6.
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This manager would format his worksheets with tiny little columns between each column. That way, when 
he used a bottom border, it would go all the way across the cell, but they were still individual borders. This 
is a data disaster waiting to happen. Someone is going to sort part of the data but not all of the data.

There is an awesome solution, but it is hidden. If you open the Underline drop-down menu on the Home 
tab of the Ribbon, your only choices are Single or Double. But if you click the dialog launcher in the Font 
group, the Format Cells dialog offers a drop-down with extra choices for Accounting Underlines. Choose 
one of those and your underlines will stretch almost all the way across the cell but they will be individual 
lines instead of a single long line.
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Bonus Tip: use alt+Enter to Control word wrap

The Gross Profit heading in C1 and C2 violates the rule that 
each heading should be in a single cell.

In cell C2, type Gross. Then press Alt+Enter. Type Profit. Press 
Enter. Delete the word Gross from row 1. Excel will see C2 as a 
single cell. All of the intellisense will continue to work.

Why use Alt+Enter instead of turning on Word Wrap? When 
you have long text that you want to wrap to several lines, the 
Word Wrap icon frequently wraps at the wrong place.

Alt+Enter prevents this nightmare: in the image below, you type the long heading in D1 and turn on Word 
Wrap. The results are shown in D3. You don't like where the words are wrapping, so you start typing many 
spaces at the end of each line as shown in F5. With just the right number of spaces, it will look like D7.

Stop typing all of those spaces. Type the text for line 1, then Alt+Enter. 

Bonus Tip: Someone went crazy and used alt+Enter Too Much

Alt-Enter is a great trick until someone uses it in hundreds of cells. I've 
seen people treat a single cell as if it were Microsoft Word. Pressing 
Alt+Enter inserts a Character Code 10 in the cell. You might be tempted to 
fix this by using =SUBSTITUTE(A1,CHAR(10),",").

However, the simple solution is to use Data, Text to Columns. In Step 1, 
choose Delimited. In Step 2, choose Other. Click into the Other box and 
press Ctrl+J. You won't see anything in the box, but typing Ctrl+J in this 
dialog or in the Find & Replace dialog will insert a character 10.
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#29 Sort East, Central, and west using a Custom List
At my last day job, we had three sales regions: East, Central, and West. The company headquarters was in 
the East, and so the rule was that all reports were sorted with the East region first, then Central, then West. 
Well, there is no way to do this with a normal sort.

Sort AZ, and you will have Central at the top. Sort the data ZA, and you will have West at the top.

I actually went to my manager to ask if he would rename the Central region. “To what?” he asked incredu-
lously. I replied that I didn’t care, as long as it started with F through V. Perhaps “Middle”? John shook his 
head no and went on with his day.

So, over and over, I would sort the report, then Ctrl+X to cut the East region records and paste them before 
the Central region. If only I had known this trick. 

The first thing to do is to set up a custom list with the regions in the correct order: East, Central, West. (See 
"Teach the Fill Handle a New List" on page 12 for instructions on setting up a custom list.)

Once the custom list is defined, open the Sort dialog by using the Sort icon on the Data tab. Choose to sort 
by Region. Open the Order dropdown. Choose Custom List….

Choose the East, Central, West custom list. One you’ve chosen that custom list, you can either sort it 
East, Central, West or West, Central, East.

The result: an easy way to sort a list into a nonstandard sequence.
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Product lines often won't sort correctly: PTC-610, PTC-710, PTC-860, PTC-960, PTC-1100 is the desired 
order. But PTC-1100 always sorts first in a text sort. A custom list would solve this problem as well.
Thanks to @NeedForExcel for suggesting this tip.

#30 Sort Left to right
Every day, your IT department sends you a file with the columns in the wrong sequence. It would take 
them two minutes to change the query, but they have a six-month backlog, so you are stuck rearranging 
the columns every day.

You can reorder the columns with a left-to-right sort.

Add a new row above the data. Type numbers to represent the correct sequence for the columns.

Select Data, Sort. In the Sort dialog, click the Options… button and choose Sort Left to Right. Click OK.
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Specify Row 1 in the Sort By dropdown. Click OK.

The problem: The column widths do not travel with the columns.

But it is easy to select the data and Press Alt+O, C, A or select Home, Format, Column, AutoFit.

#31 Sort Subtotals
This tip is from my friend Derek Fraley in Springfield, Missouri. I was doing a seminar in Springfield, and I 
was showing my favorite subtotal tricks.

For those of you who have never used subtotals, here is how to set them up.

Start by making sure your data is sorted. The data below is sorted by customers in column C.

From the Data tab, choose Subtotals. The Subtotal dialog box always wants to subtotal by the leftmost 
column. Open the At Each Change In dropdown and choose Customer. Make sure the Use Function box is 
set to Sum. Choose all of the numeric fields, as shown here. 

When you click OK, Excel inserts a subtotal below each group of customers. But, more importantly, it adds 
Group and Outline buttons to the left of column A.
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When you click the #2 Group and Outline button, the detail rows are hidden, and you are left with only 
the subtotal rows and the grand total. This is a beautiful summary of a detailed data set. Of course, at this 
point, the customers appear in alphabetic sequence. Derek from Springfield showed me that when the 
data is collapsed in the #2 view, you can sort by any column. In the figure below, a Revenue column cell is 
selected, and you are about to click the ZA sort button.

The top customer, Mike's Dog Store, comes to the top of the data set. But it does not come to row 2. 
Behind the hidden rows, Excel actually sorted a chunk of records. All of the Mike's detail rows moved along 
with the subtotal row.

If you go back to the #3 view, you will see the detail records that came along with the subtotal row. Excel 
did not rearrange the detail records; they remain in their original sequence.
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To me, this is astounding on two fronts. First, I am amazed that Excel handles this correctly. Second, it is 
amazing that anyone would ever try this. Who would have thought that Excel would handle this correctly? 
Clearly, Derek from Springfield.

Bonus Tip: Fill in a Text Field on the Subtotal rows
Say that each customer in a data set is assigned to a single sales rep. It would be great if you could bring 
the sales rep name down to the subtotal row. Here are the steps:

1. Collapse the data to the #2 view.

2. Select all of the sales rep cells, from the first subtotal 
row to the last customer subtotal row. Don’t include the 
Grand Total row. At this point, you have both the visible 
and hidden rows selected. You need just the blank rows 
or just the visible rows.

3. At the right side of the Home tab, open the Find & 
Select dropdown. Choose Go To Special. In the Go To 
Special dialog, choose Blanks. Click OK.

4. At this point, you’ve selected only the blank sales rep 
cells on the Subtotal rows. In my case, the active cell is 
A49. You need a formula here to point one cell up. Type 
=A48. Instead of pressing Enter, press Ctrl+Enter to enter 
a similar formula in all of the subtotal rows. In each case, 
it brings the sales rep from the previous row down.

The results: The subtotal rows show the sales rep name in addition to the numeric totals.

Bonus Tip: an Easier way to Fill in a Text Field on Subtotal rows
Kimberly in Oklahoma City and Sarah in Omaha combined to provide a faster solution to getting the sales 
rep to appear on the Subtotal rows. Provided you only need the data in the #2 Summary View, this works 
amazingly well:

1. Click the #3 group and outline button to see all rows.
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2. Select the first sales rep in A2.

3. Press Ctrl++ and press Enter. In other words, while holding down Ctrl, press the plus sign. This opens the 
Insert Cells dialog with "Shift Cells Down" selected. Pressing Enter is like pressing OK. This moves all of the 
sales reps down one row and leaves an ugly gap in A2 and the first row of every other customer.

But when you go back to the #2 view, the gaps disappear and the report is correct.

Bonus Tip: Format the Subtotal rows
It is a little odd that Subtotals only bolds the customer column and not anything else in the subtotal row. 
Follow these steps to format the subtotal rows:

1. Collapse the data to the #2 view.

2. Select all data from the first subtotal to the grand totals.

3. Press Alt+; or select Home, Find & Select, Go To Special, Visible Cells Only).

4. Click OK. Format the subtotal rows by applying bold and a fill color.

Now, when you go back to the #3 view, the subtotal rows will be easy to spot.
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Bonus Tip: Copy the Subtotal rows
Once you’ve collapsed the data down to the #2 view, you might want to copy the subtotals to a new work-
sheet. If so, select all the data. Press Alt+; to select only the visible cells. Press Ctrl+C to copy. Switch to a 
new workbook and press Ctrl+V to paste. The pasted subtotal formulas are converted to values.
Thanks to Patricia McCarthy for suggesting to select visible cells. Thanks to Derek Fraley for his suggestion from row 6.

#32 Sort and Filter by Color or Icon
Conditional formatting got a lot of new features in Excel 2007, including icon sets and more than three 
levels of rules. This allows for some pretty interesting formatting over a large range. But once you format 
the cells, you might want to quickly see all the ones that are formatted a particular way. In Excel 2007, sort-
ing and filtering were also updated to help you do just that!

This book analysis table has some highlighted rows to flag interesting books and an icon next to the price 
if the book is in the top 25% of prices in the list.

If you want to quickly view all the highlighted rows or cells that have icons, just drop down the filter for the 
column and choose Filter by Color (or Sort by Color to bubble them to the top).

Then you can pick the formatting you want to sort or filter by! This doesn’t just work for conditional for-
matting; it also works for manually coloring cells. It is also available on the right-click menu of a cell under 
the Filter or Sort flyout, and in the Sort dialog.
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This tip is from Sam Radakovitz, a project manager on the Excel team. He is more fond of cats than dogs

#33 Consolidate Quarterly worksheets
There are two ancient consolidation tools in Excel. 

To understand them, say that you have three data sets. Each has names down the left side and months 
across the top. Notice that the names are different, and each data set has a different number of months.

Illustration: Cartoon Bob D'Amico

You want to combine these into a single data set.
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The first tool is the Consolidate command on the Data tab. Choose a blank section of the workbook before 
starting the command. Use the RefEdit button to point to each of your data sets and then click Add. In the 
lower left, choose Top Row and Left Column. 

When you click OK, a superset of all three data sets is produced. The first column con-
tains any name in any of the three data sets. Row 1 contains any month in any data set.

In the above figure, notice three annoyances: Cell A1 is always left blank, the data in A is not sorted, and if 
a person was missing from a data set, then cells are left empty instead of being filled with 0.

Filling in cell A1 is easy enough. Sorting by name involves using Flash Fill to get the last name in column N. 
Here is how to fill blank cells with 0:

1. Select all of the cells that should have numbers: B2:M11.

2. Press Ctrl+H to display Find & Replace.

3. Leave the Find What box empty, and type a zero in the Replace With: box.

4. Click Replace All.

The result: a nicely formatted summary report, as shown below.

The other ancient tool is the Multiple Consolidation Range pivot table. Follow these steps to use it:
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1. Press Alt+D, P to invoke the Excel 2003 Pivot Table and Pivot Chart Wizard.

2. Choose Multiple Consolidation Ranges in step 1 of the wizard. Click Next.

3. Choose I Will Create the Page Fields in step 2a of the wizard. Click Next.

4. In Step 2b of the wizard, use the RefEdit button to point to each table. Click Add after each.

5. Click Finish to create the pivot table, as shown below.

Thanks to CTroy for suggesting this feature.
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#34 Create your First pivot Table
Pivot tables let you summarize tabular data to a one-page summary in a few clicks. Start with a data set 
that has headings in row 1. It should have no blank rows, blank columns, blank headings or merged cells.

Select a single cell in your data and choose Insert, Pivot Table.

Excel will detect the edges of your data and offer to create the pivot table on a new worksheet. Click OK to 
accept the defaults.

Excel inserts a new blank worksheet to the left of the current worksheet. On the right side of the screen is 
the Pivot Table Fields pane. At the top, a list of your fields with checkboxes.
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At the bottom are four drop zones with horrible names and confusing icons. Any fields that you drag to 
the Columns area will appear as headings across the top of your report. Any fields that you drag to the 
Rows area appear as headings along the left side of your report. Drag numeric fields to the Values area.

You can build some reports without dragging the fields. If you checkmark a text field, it will automatically 
appear in the Rows area. Checkmark a numeric field and it will appear in the Values area. By choosing 
Region and Revenue, you will create this pivot table:
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To get products across the top of the report, drag the Product field and drop it in the Columns area:

Note: your first pivot table might have the words "Column Labels" and "Row Labels" instead of 
headings like Product and Region. If so, choose Design, Report Layout, Show in Tabular Form. 
Later, in "#38 Specify Defaults for All Future Pivot Tables" on page 86, you will learn how to make 
Tabular Form the default for your pivot tables.

Bonus Tip: rearrange fields in a pivot table
The power of pivot tables is the ability to rearrange the fields. If your manager decides you should put 
Regions across the top and products down the side, it is two drags to create the new report. Drag product 
to Rows. Drag Region to Columns.

You will have this report:

To remove a field from the pivot table, drag the field tile outside of the Fields pane, or simply uncheck the 
field in the top of the Fields pane.

Bonus Tip: Format a pivot Table
The Design tab has a gallery with 84 built-in formats for pivot tables. Choose a design from the gallery and 
the colors change.
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One frustrating feature with a pivot table is that the numbers always start out as General format. Right-
click any number and choose Number Format…. Any changes you make to the number formatting using 
this command will be remembered as long as Revenue stays in the pivot table. (Before Excel 2010, pivot 
tables would frequently forget the number formatting. This was fixed in Excel 2010.)

Bonus Tip: Format One Cell in a pivot Table
This is new in Microsoft 365 starting in 2018.  You can right-click any cell in a pivot table and choose 
Format Cell. Any formatting that you apply is tied to that data in the pivot table. In the figure below, 
Florida Figs have a yellow fill color.

If you change the pivot table, the yellow formatting follows the Florida Fig.

If you add a new inner field, then multiple cells for Florida Fig will have the fill color.
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The formatting will persist if you remove Florida or Fig due to a filter. If you filter to vegetables, Fig is 
hidden. Filter to fruit and Fig will still be formatted. However, if you completely remove either Product or 
Region from the pivot table, the formatting will be lost.

Bonus Tip: Fill in the Blanks in the annoying Outline view

If your pivot table is in Tabular or Outline Form and 
you have more than one row field, the pivot table 
defaults to leaving a lot of blank cells in the outer 
row fields:

Starting in Excel 2010, use Design, Report Layout, 
Repeat all Item Labels to fill in the blanks in column 
A:

Bonus Tip: replace Blank values Cells with zero

There is another way to have blanks in the Values 
area of a pivot table. Say that you have a product 
which is only sold in a few regions. If there are no 
Doodad sales in Atlanta, Excel will leave that cell 
empty instead of putting a zero there. Right-click 
the pivot table and choose Pivot Table Options. On 
the Layout & Format tab, find the box For Empty 
Cells, Show: and type a zero.

Or, as Hunstville Excel Consultant Andrew Spain 
discovered, you can simply clear the checkbox to 
the left of For Empty Cells, Show:
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Bonus Tip: rearrange Fields pane
Howie Dickerman was the Project Manager in charge of 
pivot tables at Microsoft. He inherited the product and 
suggests some of the defaults could have been different. 
For one, he suggests using the gear at the top right of the 
PivotTable Fields pane and changing the view to Fields 
Section and Areas Section side-by-side.

#35 Create a year-over-year report in a pivot Table
Let’s say you have two years’ worth of detail records. Each record has a daily date. When you build a pivot 
table from this report, you will have hundreds of rows of daily dates in the pivot table. This is not much of a 
summary.

Choose one of those date cells in the pivot table. From the Analyze tab in the Ribbon, choose Group Field.

Because you are on a date field, you get this version of the 
Grouping dialog. In it, deselect Months and select Years.

The daily dates are rolled up to years. Move 
the Date field from Rows to Columns.
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Instead of a grand total in column D, you probably want a percentage variance. To get rid of the Grand 
Total column, right-click on the Grand Total heading and choose Remove Grand Total.)

To build the variance column as shown below, you need to write a formula outside the pivot table that 
points inside the pivot table. Do not touch the mouse or arrow keys while building the formula, or the 
often-annoying GETPIVOTDATA function will appear. Instead, simply type =C5/B5-1 and press Enter.

Bonus Tip: another way to Calculate year-Over-year
Instead of creating a formula outside of the pivot table, you can do this inside the pivot table.

Start from the image above and clear column D. Drag Revenue a second time to the Values area.

Look in the Columns section of the Pivot Table Fields panel. You will see a tile called Values that appears 
below Date. Drag that tile so it is below the Date field. Your pivot table should look like this:

Double-click the Sum of Revenue2 heading in D4 to display the Value Field Settings dialog. Click on the 
tab for Show Values As. Change the drop-down menu to % Difference From. Change the Base Field to 
Date. Change the Base Item to (Previous Item). Type a better name than Sum of Revenue2 - perhaps % 
Change. Click OK.

You will have a mostly blank column D (because the pivot table can't calculate a percentage change for 
the first year. Right-click the D and choose Hide.
Thanks to Tobias Ljung for this method.
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#36 Change the Calculation in a pivot Table
Pivot tables offer a myriad of calculations in the Field Settings dialog box. Here is a faster way to change a 
calculation:

1. Drag Revenue to the Values area twice.

2. Double-click on the heading Sum of Revenue2. Excel opens the Value Field Settings dialog.

3. Click on Show Values As and select % of Column Total from the dropdown.

4. Type a new name in the Custom Name field, such as % of Total.

Thanks to Александр Воробьев for suggesting this tip.

Bonus Tip: why Do pivot Tables Count Instead of Sum?
In almost every seminar, someone asks why pivot tables default to count instead of sum. This long-stand-
ing problem was fixed in May 2018 for Microsoft 365 subscribers. The Count was triggered if you had one 
revenue cell that contained text or an empty cell. 

Someone wrote a letter to the Excel team complaining that a single empty cell should not be treated like 
text. If a cell is blank and you refer to that cell in a formula, Excel treats the cell as a zero. The letter-writer 
pointed out that a columns with mostly numbers and a few empty cells should not trigger a Count. The 
person on the Excel team agreed, and quietly pushed out a change.

If you are not using Microsoft 365, then you can avoid the Count issue by making sure that there are no 
blank cells in your revenue column. If you don't think that you have any blank cells, make sure you are 
selecting one cell  in your data set and not the entire columns A:J. If your data is in A2:J999 and you select 
A:J, you are selecting 998 numbers and over a million empty cells. 

#37 Find the True Top Five in a pivot Table
Pivot tables offer a Top 10 filter. It is cool. It is flexible. But I hate it, and I will tell you why.

Here is a pivot table that shows revenue by customer. The revenue total is $6.7 million. Notice that the larg-
est customer, Roto-Rooter, is 9% of the total revenue.
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What if my manager has the attention span of a goldfish and wants to see only the top five customers? To 
start, open the dropdown in A3 and select Value Filters, Top 10.

The super-flexible Top 10 Filter dialog allows Top/Bottom. It can do 10, 5, or any other number. You can ask 
for the top five items, top 80%, or enough customers to get to $5 million.
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But here is the problem: The resulting report shows five customers and the total from those customers in-
stead of the totals from everyone. Roto-Rooter, who was previously 9% of the total is 23% of the new total.  

But First, a Few Important words about autoFilter

I realize this seems like an off-the-wall question. If you want to turn on the Filter dropdowns on a regular 
data set, how do you do it? Here are three really common ways:

 ● Select one cell in your data and click the Filter icon on the Data tab or press Ctrl+Shift+L.

 ● Select all of your data with Ctrl+* and click the Filter icon on the Data tab.

 ● Press Ctrl+T to format the data as a table.

These are three really good ways. As long as you know any of them, there is absolutely no need to know 
another way. But here‘s an incredibly obscure but magical way to turn on the filter:

 ● Go to your row of headers and then go to the rightmost heading cell. Move one cell to the right. For 
some unknown reason, when you are in this cell and click the Filter icon, Excel filters the data set to 
your left. I have no idea why this works. It really isn’t worth talking about because there are already 
three really good ways to turn on the Filter dropdowns. I call this cell the magic cell.

and Now, Back to pivot Tables

There is a rule that says you cannot use AutoFilter when you are in a pivot table. See below? The Filter icon 
is grayed out because I’ve selected a cell in the pivot table.

I don't know why Microsoft grays this out. It must be something internal that says AutoFilter and a pivot 
table can’t coexist. So, there is someone on the Excel team who is in charge of graying out the Filter icon. 
That person has never heard of the magic cell. Select a cell in the pivot table, and the Filter gets grayed 
out. Click outside the pivot table, and Filter is enabled again.
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But wait. What about the magic cell I just told you about? If you click in the cell to the right of the last 
heading, Excel forgets to gray out the Filter icon!

Sure enough, Excel adds AutoFilter dropdowns to the top row of your pivot table. And AutoFilter operates 
differently than a pivot table filter. Go to the Revenue dropdown and choose Number Filters, Top 10…. 

In the Top 10 AutoFilter dialog, choose Top 6 Items. That’s not a typo…if you want five customers, choose 
6. If you want 10 customers, choose 11.

To AutoFilter, the grand total row is the largest item in the data. The top five customers are occupying posi-
tions 2 through 6 in the data.
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Caution: Clearly, you are tearing a hole in the fabric of Excel with this trick. If you later change 
the underlying data and refresh your pivot table, Excel will not refresh the filter because, as far as 
Microsoft knows, there is no way to apply a filter to a pivot table!

Note: Our goal is to keep this a secret from Microsoft because it is a pretty cool feature. It has been 
“broken” for quite some time, so there are a lot of people who might be relying on it by now.

a Completely Legal Solution in Excel 2013+

If you want a pivot table showing you the top five customers but the total from all customers, you have to 
move your data outside Excel. If you have Excel 
2013 or newer running in Windows, there is a very 
convenient way to do this. To show you this, I’ve 
deleted the original pivot table. Choose Insert, 
Pivot Table. Before clicking OK, select the check-
box Add This Data To The Data Model.

Build your pivot table as normal. Use the drop-
down in A3 to select Value Filters, Top 10, and ask 
for the top five customers. With one cell in the 
pivot table selected, go to the Design tab in the 
Ribbon and open the Subtotals dropdown. The 
final choice in the dropdown is Include Filtered 
Items in Totals. Normally, this choice is grayed out. 
But because the data is stored in the Data Model 
instead of a normal pivot cache, this option is now 
available.
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Choose the Include Filtered Items in Totals option, and your Grand Total now includes an asterisk and the 
total of all of the data, as shown below.

This magic cell trick originally came to me from Dan in my seminar in Philadelphia and was repeated 15 years later by a different 
Dan from my seminar in Cincinnati. Thanks to Miguel Caballero for suggesting this feature.

#38 Specify Defaults for all Future pivot Tables
It took me six years, but I finally convinced the Excel team that a lot of people prefer Tabular layout for 
pivot tables to the Compact layout that became the default layout in Excel 2007. If you have Microsoft 365, 
you now have the ability to specify pivot table defaults.

Go to File, Options, Data. Click Edit Default Layout….

Change the Report Layout to Show in Tabular Form and choose the checkbox Repeat All Item Labels.

Tip: There are other settings that you can specify as the default. You can either click Pivot Table 
Options… and specify them or find a pivot table where you‘ve already set up your favorite set-
tings. Select one cell in that pivot table and click Import.

If you don‘t have Microsoft 365 and don‘t have access to pivot table defaults, you can get similar function-
ality by buying  Pivot Power Premium from Debra Dalgleish at Contextures.com: mrx.cl/pppdebra.
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Bonus Tip: Change what Drives you Crazy about Excel
I‘ve managed to lobby the Excel team to get a few changes into Excel. It isn‘t always easy. It took me eight 
years of lobbying to get the Repeat All Item Labels feature added to Excel 2010. It took seven years to get 
the Pivot Table Defaults feature added.

The old Excel.UserVoice.com site has been migrated to feedbackportal.microsoft.com. Search for Excel 
and then filter the Platform to Windows or Mac. If you have a great idea of what would make Excel easier, 
write up a short post here.  And then get your friends and co-workers to vote for your idea. The great news 
is that the Excel team is listening to ideas. They key to getting the Excel team to respond is 20 votes. But I 
managed 200–300 votes for my Pivot Table Defaults before they started working on the feature.

#39 Make pivot Tables Expandable using Ctrl+T
If you choose all of columns A:J and you later want to add more records below the data, it takes only a 
simple Refresh to add the new data instead of having to find the Change Data Source icon. In the past, this 
made sense. But today, Change Data Source is right next to the Refresh button and not hard to find. Plus, 
there is a workaround in the Ctrl+T table.

When you choose your data set and select Format as Table by using Ctrl+T, the pivot table source will grow 
as the table grows. You can even do this retroactively, after the pivot table exists.

This figure below shows a data set and a pivot table. The pivot table source is A1:C16.

Say that you want to be able to easily add new data below the pivot table, as shown below. Select one cell 
in the data and press Ctrl+T. Make sure that My Table Has Headers is checked in the Create Table dialog 
and click OK.

https://feedbackportal.microsoft.com/feedback/forum/c23f3b77-f01b-ec11-b6e7-0022481f8472
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Some nice formatting is applied to the data set. But the formatting is not the important part.

You have some new records to add to the table. Copy the records.

Go to the blank row below the table and paste. The new records pick up the formatting from the table. The 
angle-bracket-shaped End-of-Table marker moves to C19. But notice that the pivot table has not updated 
yet.

Click the Refresh button in the Pivot Table Tools Analyze tab. Excel adds the new rows to your pivot table.
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Bonus Tip: use Ctrl+T with vLOOkup and Charts
In this figure, the VLOOKUP table is in E5:F9. Item A106 is missing from the table, and the VLOOKUP is re-
turning #N/A. Conventional wisdom says to add A106 to the middle of your VLOOKUP table so you don’t 
have to rewrite the formula.

Instead, use Ctrl+T to format the lookup table. Note that the formula is still pointing to E5:F9; nothing 
changes in the formula.

But when you type a new row below the table, it becomes part of the table, and the VLOOKUP formula au-
tomatically updates to reflect the new range.

The same thing happens with charts. The chart on the left is based on A1:B5, which is not a table. Format 
A1:B5 as a table by pressing Ctrl+T. Add a new row. The row is automatically added to the chart, as shown 
on the right.
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It is fairly cool that you can use Ctrl+T after setting up the pivot table, VLOOKUP, or chart, and Excel still 
makes the range expand.
When I asked readers to vote for their favorite tips, tables were popular. Thanks to Peter Albert, Snorre Eikeland, Nancy Federice, 
Colin Michael, James E. Moede, Keyur Patel, and Paul Peton for suggesting this feature. Four readers suggested using OFFSET to 
create expanding ranges for dynamic charts: Charley Baak, Don Knowles, Francis Logan, and Cecelia Rieb. Tables now do the same 
thing in most cases.

#40 replicate a pivot Table for Each rep
Here is a great trick I learned from southern California–based Excel consultant Szilvia Juhasz. 

The pivot table below shows products across the top and customers down the side. The pivot table is 
sorted so the largest customers are at the top. The Sales Rep field is in the report filter.

If you open the Rep dropdown, you can filter the data to any one sales rep.

This is a great way to create a report for each sales rep. Each report summarizes the revenue from a partic-
ular salesperson‘s customers, with the biggest customers at the top. And you get to see the split between 
the various products.



rEpLICaTE a pIvOT TaBLE FOr EaCH rEp 91 

3 

The Excel team has hidden a feature called Show Report Filter Pages. Select any pivot table that has a field 
in the report filter. Go to the Analyze tab (or the Options tab in Excel 2007/2010). On the far left side is the 
large Options button. Next to the large Options button is a tiny dropdown arrow. Click this dropdown and 
choose Show Report Filter Pages….

Excel asks which field you want to use. Select the one you want (in this case the only one available) and 
click OK.

Over the next few seconds, Excel starts inserting new worksheets, one for each sales rep. Each sheet tab is 
named after the sales rep. Inside each worksheet, Excel replicates the pivot table but changes the name in 
the report filter to this sales rep.

You end up with a report for each sales rep.

This would work with any field. If you want a report for each customer, product, vendor, or something else, 
add it to the report filter and use Show Report Filter Pages.
Thanks to Szilvia Juhasz for showing me this feature during a seminar I was teaching at the University of Akron many years ago. 
For the record, Szilvia was in row 1.
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#41 use a pivot Table to Compare Lists
When you think of comparing lists, you probably think of VLOOKUP. If you have two lists to compare, you 
need to add two columns of VLOOKUP. In the figure below, you are trying to compare Tuesday to Monday 
and Wednesday to Tuesday and maybe even Wednesday to Monday. It is going to take a lot of VLOOKUP 
columns to figure out who was added to and dropped from each list.

You can use pivot tables to make this job far easier. Combine all of your lists into a single list with a new 
column called Source. In the Source column, identify which list the data came from. Build a pivot table 
from the combined list, with Name in rows, RSVP in values, and Source in columns. Turn off the Grand Total 
row, and you have a neat list showing a superset from day to day, as shown below.
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Bonus Tip: Show up/Down Markers
There is a super-obscure way to add up/down markers to a pivot table to indicate an increase or a 
decrease.

Somewhere outside the pivot table, add columns to show increases or decreases. In the figure below, the 
difference between I6 and H6 is 3, but you just want to record this as a positive change. Use SIGN(I6-H6) to 
get either +1, 0, or -1.

Select the two-column range showing the sign of the change and then select Home, Conditional 
Formatting, Icon Sets, 3 Triangles. (I have no idea why Microsoft called this option 3 Triangles, when it is 
clearly 2 Triangles and a Dash, as shown below.)

With the same range selected, now select Home, Conditional Formatting, Manage Rules, Edit Rule. Check 
the Show Icon Only checkbox.

With the same range selected, press Ctrl+C to copy. Select the first Tuesday cell in the pivot table. From the 
Home tab, open the Paste dropdown and choose Linked Picture. Excel pastes a live picture of the icons 
above the table. 
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At this point, adjust the column widths of the extra two columns showing the icons so that the icons line 
up next to the numbers in your pivot table, as shown below.

After seeing this result, I don‘t really like the thick yellow dash to indicate no change. If you don‘t like it 
either, select Home, Conditional Formatting, Manage Rules, Edit. Open the dropdown for the thick yellow 
dash and choose No Cell Icon, and you get the result shown below.

Bonus Tip: Compare Two Lists by using Go To Special
This tip is not as robust as using a Pivot Table to Compare Two Lists, but it comes in handy when you have 
to compare one column to another column.

In the figure below, say that you want to find any changes between column A and column D.

Select the data in A2:A9 and then hold down the Ctrl key while you select the data in D2:D9. 
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Select, Home, Find & Select, Go To Special. Then, in the Go To Special dialog, choose Row Differences. Click 
OK. 

Only the items in column A that do not match the items in column D are selected. Use a red font to mark 
these items, as shown below.

Caution: This technique works only for lists that are mostly identical. If you insert one new row 
near the top of the second list, causing all future rows to be offset by one row, each of those rows 
is marked as a row difference.

Thanks to Colleen Young for this tip.

#42 Build Dashboards with Sparklines and Slicers
New tools debuted in Excel 2010 that let you create interactive dashboards that do not look like Excel. This 
figure shows an Excel workbook with two slicers, Region and Line, used to filter the data. Also in this figure, 
pivot charts plus a collection of sparkline charts illustrate sales trends.
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You can use a setup like this and give your manager’s manager a touch screen. All you have to do is teach 
people how to use the slicers, and they will be able to use this interactive tool for running reports. Touch 
the East region and the Books line. All of the charts update to reflect sales of books in the East region.

Switch to eBooks, and the data updates.

pivot Tables Galore

Arrange your charts so they fit the size of your display monitor. Each pivot chart has an associated pivot 
table that does not need to be seen. Those pivot tables can be moved to another sheet or to columns out-
side of the area seen on the display.
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Note: This technique requires all pivot tables share a pivot table cache. I have a video showing 
how to use VBA to synchronize slicers from two data sets at http://mrx.cl/syncslicer.

Filter Multiple pivot Tables with Slicers

Slicers provide a visual way to filter. Choose the first pivot table on your dashboard and select Analyze, 
Slicers. Add slicers for region and line. Use the Slicer Tools tab in the Ribbon to change the color and the 
number of columns in each slicer. Resize the slicers to fit and then arrange them on your dashboard.

Initially, the slicers are tied to only the first pivot table. Select a cell in the second pivot table and choose 
Filter Connections (aka Slicer Connections in Excel 2010). Indicate which slicers should be tied to this pivot 
table. In many cases, you will tie each pivot table to all slicers. But not always. For example, in the chart 
showing how Books and eBooks add up to 100%, you need to keep all lines. The Filter Connections dialog 
box choices for that pivot table connect to the Region slicer but not the Line slicer. 

Thanks to John Michaloudis from MyExcelOnline.com for the connecting multiple pivot tables to one slicer idea.

http://mrxl.cl/syncslicer
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Sparklines: word-Sized Charts

Professor Edward Tufte introduced sparklines in his 2007 book Beautiful Evidence. Excel 2010 implemented 
sparklines as either line, column, or win/loss charts, where each series fills a single cell.

Personally, I like my sparklines to be larger. In this example, I changed the row height to 30 and <gasp> 
merged B14:D14 into a single cell to make the charts wider. The labels in A14:A18 are formulas that point 
to the first column of the pivot table.

To change the color of the low and high points, choose 
these boxes in the Sparkline Tools tab:

Then change the color for the high and low points:

By default, sparklines are scaled independently 
of each other. I almost always go to the Axis 
settings and choose Same for All Sparklines 
for Minimum and Maximum. Below, I set 
Minimum to 0 for all sparklines.
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Make Excel Not Look Like Excel

Did you notice that many of the dashboards shown in the previous topics don't look like Excel? With sev-
eral easy settings, you can make a dashboard look less like Excel:

 ● Select all cells and apply a light fill color to get rid of the gridlines.

 ● On the View tab, uncheck Formula Bar, Headings, and Gridlines.

 ● Collapse the Ribbon: at the right edge of the Ribbon, use the ^ to collapse. (You can use Ctrl+F1 or 
double-click the active tab in the Ribbon to toggle from collapsed to pinned.)

 ● Use the arrow keys to move the active cell so it is hidden behind a chart or slicer.

 ● Hide all sheets except for the dashboard sheet.

 ● In File, Options, Advanced, hide the scroll bars and sheet tabs.

Bonus Tip: Line up Dashboard Sections with Different Column widths
If you are anything like me, you often need to fit a lot of data into a small area in a dashboard. What if col-
umns in one dashboard tile don‘t line up with columns in another tile? Using a linked picture will solve the 
problem. In the figure below, the report in A1:M9 requires 13 columns. But the report in Rows 11:13 needs 
that same space to be two columns. I am never one to recommend merged cells, so let‘s not broach that 
evil topic.

Instead, go to another section of the workbook and build the report tile. Copy the cells that encompass 
the tile.
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Select where you want the tile to appear. On the Home tab, click on the lower half of the Paste dropdown 
to open the paste options. The last icon is Paste Picture Link. Click that icon. A live picture of the other cells 
appears.

Bonus Tip: use picture Lookup
I love this technique, which essentially does a VLOOKUP that returns a picture selected in response to a for-
mula answer. In the image below, make sure that your lookup table starts in row 2 or below. It cannot start 
in row 1. 

In cell C6, someone enters how many passengers 
need to be accommodated.

A cool new function called IFS in C7 figures out 
which row in the table contains the picture that 
you want to show. In this case, there are 7 passen-
gers, which means you need a 12-passenger van. 

Those icons are an Microsoft 365 feature found 
under Insert, Icons. But you could use any clipart or 
photos.

The table below appears on a worksheet called 
Icons. The OFFSET function in A10 tells Excel to 
start in Icons!$B$1, move down 3 rows, move 
over 0 columns, and select a range 1 row tall by 1 
column wide.
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I always build the OFFSET function in a cell to ensure that I don‘t get any syntax errors. But when you use 
the technique described here, you cannot use OFFSET in a cell. You have to copy the formula and use 
Formulas, Define Name and create a name that refers to the OFFSET formula.

Copy the cell containing the first picture in your table. Go to the dashboard and use Paste Picture Link, 
as discussed in the previous topic. Look in the formula bar, and you see that this linked picture is coming 
from =$B$2, or =Icons$B$2 if you are on a different worksheet.

With the linked picture still selected, click in the formula bar. Change the formula for the linked picture to 
point to the name that you gave to the OFFSET formula. Amazingly, the picture will now update any time 
that the calculation in C7 points to a new vehicle.

Thanks to Ghaleb Bakri for suggesting a similar technique using dropdown boxes. Ryan Wilson suggested making Excel not look 
like Excel. Jon Wittwer of Vertex42 suggested the sparklines and slicers trick. Mynda Treacy taught me the picture lookup in her 
amazing dashboard course at mrx.cl/dashcourse.
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Bonus Tip: report Slicer Selections in a Title
Slicers are great, but they can take up a lot of space in your report.

Here is an awesome way to get the selected slicers in a single cell. First, select your entire pivot table and 
copy with Ctrl+C.

Then, paste a new pivot table somewhere outside of your print 
range.  Copying and pasting makes sure that both pivot tables react 
to the slicer. Change the pivot table so you have the slicer field in 
the Row area. Right-click the Grand Total and choose Remove Grand 
Total. You should end up with a pivot table that looks like this:

The list of products starts in I4 and might potentially extend to I26. Use the new TEXTJOIN function to join 
all of the selected products in a single cell. The first argument of TEXTJOIN is the delimiter. I use a comma 
followed by a space. The second argument tells Excel to ignore empty cells. This makes sure that Excel 
does not add a bunch of commas to the end of your formula result.
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#43 See why GETpIvOTDaTa Might Not Be Entirely Evil
Most people first encounter GETPIVOTDATA when they try to build a formula outside a pivot table that 
uses numbers in the pivot table. For example, this variance percentage won’t copy down to the other 
months due to Excel inserting GETPIVOTDATA functions.

Excel inserts GETPIVOTDATA any time you use the mouse or arrow keys to point to a cell inside the pivot 
table while building a formula outside the pivot table.

By the way, if you don’t want the GETPIVOTDATA function to appear, simply type a formula such as  
=D5/C5-1 without using the mouse or arrow keys to point to cells. That formula copies without any 
problems.

Here is a data set that contains one plan number per month per store. There are also actual sales per 
month per store for the months that are complete. Your goal is to build a report that shows actuals for the 
completed months and plan for the future months.
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Build a pivot table with Store in Rows. Put Month and Type in Columns. You get the report shown below, 
with January Actual, January Plan, and the completely nonsensical January Actual+Plan.

If you select a month cell and go to Field Settings, you can change Subtotals to None.

This removes the useless Actual+Plan. But you still have to get rid of the plan columns for January through 
April. There is no good way to do this inside the pivot table.

So, your monthly workflow becomes:

1. Add the actuals for the new month to the data set.

2. Build a new pivot table from scratch.

3. Copy the pivot table and paste as values so it is not a pivot table anymore.

4. Delete the columns that you don’t need.

There is a better way to go. The following very compressed figure shows a new Excel worksheet added to 
the workbook. This is all just straight Excel, no pivot tables. The only bit of magic is an IF function in row 4 
that toggles from Actual to Plan, based on the date in cell P1.
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The very first cell that needs to be filled in is January Actual for Baybrook. Click in that cell and type an 
equal sign. 

Using the mouse, navigate back to the pivot table. Find the cell for January Actual for Baybrook. Click 
on that cell and press Enter. As usual, Excel builds one of those annoying GETPIVOTDATA functions that 
cannot be copied.

But today, let’s study the syntax of GETPIVOTDATA.

The first argument below is the numeric field "Sales". The second argument is the cell where the pivot table 
resides. The remaining pairs of arguments are field name and value. Do you see what the auto-generated 
formula did? It hard-coded "Baybrook" as the name of the store. That is why you cannot copy these auto-
generated GETPIVOTDATA formulas. They actually hard-code names into formulas. Even though you can‘t 
copy these formulas, you can edit them. In this case, it would be better if you edited the formula to point 
to cell $D6.
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The figure below shows the formula after you edit it. Gone are "Baybrook", "Jan", and "Actual". Instead, you 
are pointing to $D6, E$3, and E$4.

Copy this formula and then choose Paste Special, Formulas in all of the other numeric cells.

Now here‘s your monthly workflow:

1. Build an ugly pivot table that no one will ever see.

2. Set up the report worksheet.

Each month, you have to:

1. Paste new actuals below the data.

2. Refresh the ugly pivot table.

3. Change cell P1 on the report sheet to reflect the new month. All the numbers update.

You have to admit that using a report that pulls numbers from a pivot table gives you the best of both 
worlds. You are free to format the report in ways that you cannot format a pivot table. Blank rows are fine. 
You can have currency symbols on the first and last rows but not in between. You get double-underlines 
under the grand totals, too.
Thanks to @iTrainerMX for suggesting this feature.

#44 ask Excel's a.I. a Question about your Data
A Natural Language Query feature started rolling out to Microsoft 365 in late 2019. The feature uses artifi-
cial intelligence to answer questions about your data. 

The feature can be found near the right side of the Home tab. Microsoft changed the name from Insights 
to Ideas and seems to have settled on Analyze Data. It is to the right of Find & Select. The icon has varied 
between a blue lightning bolt and a magnifier over a chart.

The feature has the potential to help millions of people, but it is hard to discover.
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Anyone can perform advanced data analysis by simply asking questions by typing a sentence. Your data 
set can be up to 250,000 cells. Select one cell in your data. Use the Analyze Data icon on the right side of 
the Home tab.

A box says to Ask A Question About Your Data and it gives you a few sample questions.

Type a question such as "Top 3 Products by 'Sales' where Category is "Bikes"". Excel restates your question 
and shows you a thumbnail of the report.

If this is the correct analysis, you can use the +Insert Pivot Table icon to insert the results into a new work-
sheet in your workbook.

Sometimes the feature will give you a chart when you want a table. Try adding "as table" to the end of your 
sentence.

The "Is this helpful?" link in the lower right is not being used. The original idea was to use Machine 
Learning to suggest better reports in the future. But the reality is that Microsoft is taking privacy very seri-
ously and they can't learn without retaining your data. 
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New for 2021 is the "Which Fields Interest You the Most?". This can be used to tell Excel that they should 
never offer to sum fields such as Year, Part Number, or Cost Center. You can choose to Sum or Average nu-
meric fields. Or you can uncheck the field to make sure it is not in any of the suggestions.

Even before you type a question, Excel will offer you 5-10 suggested reports and a link to load up to 30 
more reports. If you aren't sure what you are looking for, it is sometimes interesting to read through these 
suggested reports.

My one complaint about the feature is shown in the following chart. Ideas was able to find some outliers in 
this data and offers to create a chart with those points called out in orange. For this chart to work correctly, 
Excel would have to support conditional formatting in charts and it does not. That means that the pivot 
chart will always call out these three points, even if the underlying data changes and new outliers emerge. 
You would have to re-run Ideas and hope that a similar result is offered.
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#45 Eliminate vLOOkup or XLOOkup with the Data Model
Say that you have a data set with product, date, customer, and sales information.

The IT department forgot to put sector in there. Here is a lookup table that maps customer to sector. Time 
for a VLOOKUP, right?

There is no need to do VLOOKUPs to join these data sets if you have Excel 2013 or newer. These versions of 
Excel have incorporated the Power Pivot engine into the core Excel.

In both the original data set and the lookup table, use Home, Format as Table. On the Table Tools tab, 
rename the table from Table1 to something meaningful. I’ve used Data and Sectors.

Select one cell in the data table. Choose Insert, Pivot Table. Starting in Excel 2013, there is an extra box,  
Add This Data to the Data Model, that you should select before clicking OK.
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The Pivot Table Fields list appears, with the fields from the Data table. 
Choose Revenue. Because you are using the Data Model, a new line ap-
pears at the top of the list, offering Active or All. Click All.

Surprisingly, the PivotTable Fields list offers all the other tables in the 
workbook. This is ground-breaking. You haven’t done a VLOOKUP yet. 
Expand the Sectors table and choose Sector. Two things happen to warn 
you that there is a problem.

First, the pivot table appears with the same 
number in all the cells.

Perhaps the more subtle warning is a yellow box that ap-
pears at the top of the PivotTable Fields list, indicating 
that you need to create a relationship. Choose Create. (If 
you are in Excel 2010 or 2016, try your luck with Auto-
Detect - it often succeeds.)

In the Create Relationship dialog, you have four dropdown menus. Choose Data under Table, Customer 
under Column (Foreign), and Sectors under Related Table. Power Pivot will automatically fill in the match-
ing column under Related Column (Primary). Click OK. 

The resulting pivot table is a mash up of the original data and the data in the lookup table. No VLOOKUPs 
required.
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Bonus Tip: Count Distinct

To see an annoyance with pivot tables, drag the 
Customer column from the Data table to the 
VALUES area. The field says Count of Customer, 
but it is really a count of the invoices belong to 
each sector. What if you really want to see how 
many unique customers belong to each sector?

Double-click the Count of Customer heading. At first, the Summarize Values By offers choices such as Sum, 
Average, and Count. Scroll down to the bottom. Because the pivot table is based on the Data Model, you 
now have Distinct Count. 

After you select Distinct Count, the pivot table shows a distinct count of customers for each sector. This 
was very hard to do in regular pivot tables.

Thanks to Colin Michael and Alejandro Quiceno for suggesting Power Pivot.
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#46 Compare Budget versus actual via power pivot
Budgets are done at the top level – revenue by product line by region by month. Actuals accumulate 
slowly over time – invoice by invoice, line item by line item. Comparing the small Budget file to the volumi-
nous Actual data has been a pain forever. I love this trick from Rob Collie, aka PowerPivotPro.com.

To set up the example, you have a 54-row budget 
table: 1 row per month per region per product. 

The invoice file is at the detail level: 422 rows so far 
this year.

There is no VLOOKUP in the world that will ever let you match these two data sets. But, thanks to Power 
Pivot (aka the Data Model in Excel 2013+), this becomes easy.

You need to create tiny little tables that I call “joiners” to link the two larger data sets. In my case, Product, 
Region, and Date are in common between the two tables. The Product table is a tiny four-cell table. Ditto 
for Region. Create each of those by copying data from one table and using Remove Duplicates.

Illustration: George Berlin

The calendar table on the right was actually tougher to create. The budget data has one row per month, 
always falling on the end of the month. The invoice data shows daily dates, usually weekdays. So, I had to 
copy the Date field from both data sets into a single column and then remove duplicates to make sure that 
all dates are represented. I then used =TEXT(J4,"YYYY-MM") to create a Month column from the daily dates.
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If you don’t have the full Power Pivot add-in, you need to create a pivot table from the Budget table and 
select the checkbox for Add This Data to the Data Model.

As discussed in the previous tip, as you add fields to the pivot table, you will have to define six relation-
ships. While you could do this with six visits to the Create Relationship dialog, I fired up my Power Pivot 
add-in and used the diagram view to define the six relationships.

Here is the key to making all of this work: You are free to use the numeric fields from Budget and from 
Actual. But if you want to show Region, Product, or Month in the pivot table, they must come from the 
joiner tables!

Here is a pivot table with data coming from five tables. Column A is coming from the Region joiner. Row 
2 is coming from the Calendar joiner. The Product slicer is from the Product joiner. The Budget numbers 
come from the Budget table, and the Actual numbers come from the Invoice table. 

This works because the joiner tables apply filters to the Budget and Actual table. It is a beautiful technique 
and shows that Power Pivot is not just for big data.
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Bonus Tip: portable Formulas
If you have the full version of Power Pivot, you can use the DAX formula language to create new calculated 
fields. From the Power Pivot tab in the Ribbon, choose Measures, New Measure.

Give the field a name, such as Variance. When 
you go to type the formula, type =[. As soon as 
you type the square bracket, Excel gives you a 
list of fields to choose from.

Note that you can also assign a numeric format 
to these calculated fields. Wouldn’t it be great 
if regular pivot tables brought the numeric for-
matting from the underlying data?

In the next calculation, VariancePercent is reusing the Variance field that you just defined.

So far, you've added several calculated fields to the pivot table, as shown below.

But you don’t have to leave any of those fields in the pivot table. If your manager only cares about the vari-
ance percentage, you can remove all of the other numeric fields.

Note that the DAX in this bonus tip is barely scratching the surface of what is possible. If you want to ex-
plore Power Pivot, you need to get a copy of Power Pivot and Power BI by Rob Collie.
Thanks to Rob Collie for teaching me this feature. Find Rob at www.PowerPivotPro.com.
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Bonus Tip: Text in the values of a pivot Table
Another amazing use for a measure in a Data Model pivot table is to use the CONCATENATEX function to 
move text into the values area of a pivot table.

In this data set, there is an original and revised value for each sales rep.

'

Insert a pivot table and check the box for Add This Data To The Data Model. Drag Rep to the Rows and Version to 
Columns. 

'

The Grand Totals get really ugly, so you should remove them now. On the Design tab, use Grand Totals, Off For Rows 
and Columns. 

'

In the Pivot Table Fields panel, right-click the Table name and choose Add Measure.

'

The formula for the measure is =CONCATENATEX(Values(Table1[Code]),Table1[Code],", "). The VALUES function makes 
sure that you don't get duplicate values in the answer.

'
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After defining the measure, drag the measure to the Values area. In this case, each cell only has one value.

'

However, if you rearrange the pivot table, you might have multiple values joined in a cell.

'
Caution: A cell may not contain more than 32,768 characters. If you have a large data set, it is pos-
sible that this Grand Total of this measure will be more than 32,768 characters. The Excel team 
never anticipated that a pivot table cell would contain more than this many characters, but thanks 
to DAX and CONCATENATEX, it can happen. When it does happen, Excel can not draw the pivot 
table. But - there is no error message - the pivot table simply stops updating until you get rid of the 
Grand Total or somehow make the largest cell be less than 32,768 characters.

#47 Slicers for pivot Tables From Two Data Sets
Say that you have two different data sets. You want a pivot table from each data set and you want those 
two pivot tables to react to one slicer.

This really is the holy grail of Excel questions. Lots of Excel forums have many complicated ways to attempt 
to make this work. But the easiest way is loading all of the data into the workbook data model.

Both of the tables have to have one field in common. Make a third table with the unique list of values 
found in either column.

If the two tables are shown above, the third table has to have Store Names that are found in either table:  
Brea, Chino Hills, Corona Del Mar, Dos Lagos, Fashion Valley, Irvine, and so on.

Format all three of your tables using Ctrl+T.



SLICErS FOr pIvOT TaBLES FrOM TwO DaTa SETS 117 

3 

Use the Relationships icon on the Data tab to set up a relationship from each of the two original tables to 
the third table.

If you have access to the Power Pivot grid, the diagram view would look like this:

If not, the Relationships diagram should show two relationships, although certainly not as pretty as above.

From either pivot table, choose Insert Slicer. Initially, that slicer will only show one table. Click on the All 
tab and choose Mall Developer from your third table.

Try and choose a few items from the slicer. Watch your hopes get dashed as only one pivot table 
reacts. Once you recover, click on the Slicer. In the Slicer Tools Design tab of the Ribbon, choose Report 
Connections. Add the other pivot table to this slicer:
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Finally, both pivot tables will react to the slicer.

#48 use F4 for absolute reference or repeating Commands
The mighty F4 key should be in your Excel arsenal for two completely different reasons:

 ● Use F4 to add dollar signs in formula references to make them absolute, mixed, or relative.

 ● When you are not editing a formula, use F4 to repeat the last command.

Illustration: Cartoon Bob D‘Amico
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Make a reference absolute

In the following figure, the tax in C2 is B2 times F1. 

But when you copy this formula down, none of the sales tax calculations are working. As you copy the 
formula down the column, the B2 reference automatically changes to B3, B4, and so on. That is what you 
want. But unfortunately, the reference to the sales tax in F1 is changing as well. That is not what you want.

The solution? Edit the original formula and press F4. Two dollar signs are added to the final element of the 
formula. The $F$1 says that no matter where you copy this formula, that part of the formula always needs 
to point to F1. This is called an absolute reference. Pressing F4 while the insertion point is touching the F1 
reference is a fast way to add both dollar signs.

There are other times when you need only part of the reference to be locked. In the following example, 
you need to multiply H2 by A3 by C1. The H1 will always point to H1, so you need both dollar signs in 
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$H$1. The A3 will always point back to column A, so you need $A3. The C1 will always point to row 1, so 
you need C$1.

To enter the above formula, you would press F4 once after clicking on H1, three times after clicking on A3, 
and twice after clicking on C1. What if you screw up and press F4 too many times? Keep pressing F4: It will 
toggle back to relative then absolute, then row absolute, then column absolute.

The result? A single formula that can be copied to C3:F12.

Tip: If you forget to put dollar signs in the formula, you can edit the formula, click inside any 
cell reference and press F4 the appropriate number of times. If you have a cell reference such as 
C3:C12, select the colon with the mouse and press F4 to change both C3 and C12 to $C$3:$C$12.

Caution: There is a special type of reference called an Expanding Range. In this instance, you 
might lock down the start of the range using F$3 but let the end of the range be relative. The refer-
ence starts out as F$3:F3 but will expand as you copy it down, such as F$3:F12. Using F4 will never 
toggle through an expandable reference. You have to click inside the first F3 in the formula bar and 
press F4 to change just that part of the reference. See an Expanding Range in use in "#60 Preview 
What Remove Duplicates Will Remove" on page 149.
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repeat the Last Command

Keyboard shortcuts are great. For example, Alt+E, D, C Enter deletes a column. But even if you are really 
fast at doing Alt+E, D, C Enter, it can be a pain to do this many times in a row.

After deleting column B, press the Right Arrow key to move to the next column that needs to be deleted. 
Instead of doing Alt+E, D, C Enter again, simply press F4. This beautiful command repeats the last com-
mand that you invoked.

To delete the remaining columns, keep pressing Right Arrow and then F4.

Next, you need to delete a row, so use Alt+E, D, R Enter to delete the row.
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To keep deleting rows, press the Down Arrow key followed by F4 until all the blank rows are gone.

The F4 trick works for a surprising number of commands. Perhaps you just built a custom format to display 
numbers in thousands: #,##0,K. If you see a few more cells that need the same format, select the cells and 
press F4.

Annoyingly, a few commands do not work with F4. For example, going into Field Settings in a pivot table 
and changing the number format and calculation is one that would be nice to repeat. But it does not work.

Bonus Tip: use a Named range Instead of absolute references
If you want to avoid using $ in references to make them absolute, you can use named ranges instead. 
Select the tax rate cell in F1 and click in the name box to the left of the formula bar.

Type a name for this cell or range of cells. You cannot use spaces in the name, but TaxRate (or Tax_Rate) will 
work.

When you type the formula, use =B2*TaxRate.

Tip: To see all of the named ranges in a worksheet, reduce the zoom to 39% or lower.
Thanks to Myles Arnott, Glen Feechan, Shelley Fishel, Colin Legg, and Nathan Zelany for suggesting this feature. Bob Umlas sent in 
the tip about seeing names below 39% zoom.
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#49 Quickly Convert Formulas to values
I always say there are five ways to do anything in Excel. Converting live formulas to values is a task that has 
far more than five ways. But I will bet that I can teach you two ways that are faster than what you are using 
now.

The goal is to convert the formulas in column D to 
values.

You are probably using one of the ways shown 
below.

For Those who prefer using the Mouse

If you prefer to use the mouse, nothing is faster than this trick I learned from Dave in Columbus, Indiana. 
You don’t even have to copy the cells using this technique:

1. Select the data.

2. Go to the right edge of the selection box.

3. Hold down the right mouse button while you drag 
the box to the right.
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4. Keep holding down the right mouse button while 
you drag the box back to the original location.

5. When you release the right mouse button, in the 
menu that pops up, select Copy Here As Values Only.

How does anyone ever randomly discover right-click, 
drag right, drag left, let go? It is not something that 
you would ever accidentally do.

It turns out the menu is called the Alternate Drag-
and-Drop menu. You get this menu any time you 
right-drag a selection somewhere.

In this case, you want the values to cover the original formulas, so you have to drag right and then back to 
the left.

For Those who prefer using keyboard Shortcuts

I love keyboard shortcuts. I can Ctrl+C, Alt+E, S, V, Enter faster than you can blink. But starting in Excel 
2010, there is a faster way. Look at the bottom row of your keyboard. To the left of the Spacebar, you usu-
ally have Ctrl, Windows, Alt. To the right of the Spacebar is Alt, Something, and Ctrl.

What is that key between the right Alt and the right Ctrl? It has a picture of a mouse 
pointer and a pop-up menu. Its official name is the Application key. I’ve heard it called 
the Program key, the Menu key, the Context Menu key, and the Right-Click key. I don’t 
care what you call it, but here is a picture of it:

Here is the fastest keyboard shortcut for copying and pasting values. Press Ctrl+C. Press and release the 
Program/Application/Right-Click key. Press V. And, if you have a Lenovo laptop, it is likely that you don’t 
even have this key. On a keyboard without this key, you can press Shift+F10 instead.

Bonus Tip: Skip Blanks while pasting
A mysterious part of the Paste Special dialog is the Skip Blanks feature. What does it do? Say that you have 
a list of existing values. In another column, you have updates for some of those values but not all of them. 
In the next figure, select D2:D10 and Copy.

Select the original values in B2:B10. Do a Paste Special and select Skip Blanks.
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The 87 in D2 overwrites the 92 in B2, but Excel does not clear out the 51 in B3.

Thanks to Ed Bott, Ken McLean, Melih Met, and Bryony Stewart-Seume for suggesting this feature. Laura Lewis suggested the Skip 
Blanks trick.

#50 See all Formulas at Once
You inherit a spreadsheet from a former co-worker and you need to figure out how the calculations work. 
You could visit each cell, one at a time, and look at the formula in the formula bar. Or you could quickly 
toggle between pressing F2 and Esc to see the formula right in the cell.

But there is a faster way. On most U.S. keyboards, just below the Esc key is a key with two accent charac-
ters: the tilde from Spanish and the grave accent from French. It is an odd key. I don’t 
know how I would ever use this key to actually type piñata or frère . 

If you hold down Ctrl and the grave accent, you toggle into something called Show 
Formulas mode. Each column gets wider, and you see all of the formulas.
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This gives you a view of all the formulas at once. It is great for spotting “plug” numbers (D9) or when some-
one added the totals with a calculator and typed the number instead of using =SUM(). You can see that the 
co-worker left RANDBETWEEN functions in this model.

Note: Here is another use for the Tilde key. Say you need to use the Find dialog to search for a 
wildcard character (such as the * in "Wal*Mart" or the ? in "Hey!?" Precede the wildcard with a tilde. 
Search for Wal~*Mart or Hey!~?.

Tip: To type a lowercase n with a tilde above, hold down Alt while pressing 164 on the number 
keypad. Then release Alt.

Bonus Tip: Highlight all Formula Cells
If you are going to be auditing the worksheet, it would help to mark all of the formula cells. Here are the 
steps:

1. Select any blank cell in the worksheet.

2. Choose Home, Find & Select, Formulas.

3. All of the formula cells will be selected. Mark them in a different font color, or, heck, use Home, Cell 
Styles, Calculation.

To mark all of the input cells, use Home, Find & Select, Go To Special, Constants. I prefer to then uncheck 
Text, Logical, and Errors, leaving only the numeric constants. Click OK in the Go To Special dialog.

why Is the F1 key Missing from your keyboard?

Twice I have served as a judge for the ModelOff Financial Modeling Championships in New York. On my 
first visit, I was watching contestant Martijn Reekers work in Excel. He was constantly pressing F2 and Esc 
with his left hand. His right hand was on the arrow keys, swiftly moving from cell to cell. F2 puts a cell in 
Edit mode so you can see the formula in the cell. Esc exits Edit mode and shows you the number. Martijn 
would press F2 and Esc at least three times every second. 

But here is the funny part: What dangerous key is between F2 and Esc? F1. If you accidentally press F1, 
you will have a 10-second delay while Excel loads online Help. If you are analyzing three cells a second, a 
10-second delay is a disaster. You might as well go to lunch. So, Martijn had pried the F1 key from his key-
board so he would never accidentally press it.
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Photo Credit: Mary Ellen Jelen

Bonus Tip: Trace precedents to See what Cells Flow into a Formula

If you need to see which cells flow into a formula, you can use the 
Trace Precedents command in the Formula Auditing group on 
the Formulas tab. In the following figure, select D6. Choose Trace 
Precedents. Blue lines will draw to each cell referenced by the 
formula in D6.

The dotted line leading to a symbol in B4 means there is at least 
one precedent on another worksheet. If you double-click the 
dotted line, Excel shows you a list of the off-sheet precedents.

If you stay in cell D6 and choose Trace Precedents a few more 
times, you will see the second-level precedents, then the third-
level precedents, and so on.  When you are done, click Remove 
Arrows.

Bonus Tip: See which Cells Depend on the Current Cell
Sometimes you have the opposite problem: You want to see which cells rely on the value in the current 
cell. Choose any cell and click Trace Dependents to see which cells directly refer to the active cell.

#51 audit a worksheet with Spreadsheet Inquire
There is about a 20% chance that you have some amazing tools in your Excel that you‘ve never seen. Well, 
wait…there is a 100% chance that you've never seen everything in Excel; there are things in Excel that I 
have never seen, I consider knowing everything Excel to be my job. The 20% that I mentioned before refers 
to one particular set of tools, called Spreadsheet Inquire.
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Inquire was developed by a company called Prodiance that offered the slick Spreadsheet Compare tool for 
$145 per person per year. The Excel team liked it so much that Microsoft bought out Prodiance and gave 
the tool for free to anyone who is on Pro Plus, Professional Plus, or Enterprise Level E3 or above. 

In classic Microsoft fashion, they kept the tool hidden so even if you have it, you don‘t know that it is there. 
If you‘ve ever seen a Power Pivot tab in your Ribbon, you likely have Inquire. It is at least worth the minute 
to figure out if you have it.

If you have the Developer tab in the Ribbon, click the COM Add-Ins button and continue to step 3 below. 
Otherwise, follow these steps:

1. Go to File, Options. In the left bar of Excel Options, choose Add-ins (near the bottom of the list).

2. Go all the way to the bottom of the dialog, next to Manage. Open the dropdown and change from Excel 
Add-Ins to COM Add-ins. After choosing COM Add-ins, click Go….

3. If you have Inquire in the list, check the box next to it, click OK, and keep reading. If you don‘t have 
Inquire in your list,  jump ahead to "#52 Discover New Functions by Using fx" on page 129.

Once you enable Inquire, you have a new tab in the Ribbon called Inquire that provides the following 
options. 

 ● The Workbook Analysis takes from a few seconds to a few minutes to build a report about your work-
sheet. It tells you the number of  formulas, hidden sheets, linked workbooks, external data connec-
tions, and array formulas, as well as how many formulas result in errors. Click any category for a list of 
the various items.

 ● The next three icons allow you to draw diagrams showing relationships between workbooks, work-
sheets, or cells. The diagram below shows all inbound and outbound dependencies for cell D6. You can 
see the second-level precedents. Each node can be collapsed or expanded.
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 ● Compare Files helps you find all changes between two open files. It does a really good job. You can foil 
most comparison tools by deleting a row in the second file. But Inquire detects that row 8 was deleted 
and keeps comparing row 9 in one file to row 8 in the other file. 

 ● Clean Excess Cell Formatting locates the last non blank cell in a worksheet and deletes all conditional 
formatting beyond that cell. You might want to do this, for example, if someone selects an entire row 
or column and applies conditional formatting.

Thanks to Ron Armstrong, Olga Kryuchkova, and Sven Simon for suggesting this feature.

#52 Discover New Functions by using fx 

There are 500+ functions in Excel. I have room for only 130 tips 
this book, so there is no way I can cover them all. But instead of 
taking 450 pages to describe every function, I am going to teach 
you how to find the function that you need.

The Excel 2007 formulas tab introduced a huge fx Insert Function 
icon. But you don’t need to use the one on the Formulas tab; the 
same icon has been to the left of the formula bar ever since I can 
remember.

If you are trying to figure out how to calculate a loan payment, the Insert Function dialog will help. Click 
the icon next to the formula bar. In the Search for a Function box, type what you are trying to do. Click Go. 
The Select a Function box shows functions related to your search term. Click on a function in that box to 
see the description at the bottom of the dialog.

Caution: A change in Excel Help caused the search to return less results starting in 2019.

When you find the correct function and click OK, Excel takes you into the Function Arguments dialog. This 
is an amazing tool when you are new to a function. As you click in each argument box, help appears at the 
bottom of the window, with specifics on that argument.
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Personally, I could never get the PMT function to work correctly because I always forgot that the rate had 
to be the interest rate per period. Instead of pointing to the 5.25% in B3, you have to point to B3/12. Below, 
the help for Nper explains that it is the total number of payments for the loan, also known as the term, 
from B2.

PV is the loan amount. Since I never write a check for negative $493, I want the answer from PMT to be 
positive instead of negative. That is why I always use –B1 for the PV argument. If you use B1 instead, you 
will get the correct $493.54065 answer, but it will appear as negative in your worksheet. Think of the origi-
nal $25,995 as money leaving the bank; that is why the PV is negative.

Notice in the above figure that three argument names are bold. These are the required arguments.  
Once you finish the required arguments, the Function Arguments dialog shows you the answer in two 
places. I always use this as a sanity check. Does this answer sound like a typical car payment?

This one topic really covered three things: how to calculate a loan payment, how to use the fx icon to dis-
cover new functions, and how to use the Function Arguments dialog to get help on any function. 
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If you are in a situation where you remember the function name but still want to use the Function 
Arguments dialog, type =PMT( with the opening parenthesis and then press Ctrl+A. If you press 
Ctrl+Shift+A, Excel will insert the names of the arguments into the formula. 

Thanks to Excel MVP Nabil Mourad from OfficeInstructor.com for the Ctrl+Shift+A technique.

#53 use Function arguments for Nested Functions
The Function Arguments dialog shown above is cool, but in real life, when you have to nest functions, how 
would you use this dialog?

Say that you want to build a formula to do a two-way lookup: 

=INDEX(B2:E16,MATCH(G2,A2:A16,0),MATCH(H2,B1:E1,0))

You would start out using the Function Arguments dialog box for INDEX. In the Row_num argument box, 
type MATCH(. Using the mouse, go up to the formula bar and click anywhere inside the word MATCH.

Caution: Don‘t click the formula in the cell. You have to click the formula in the formula bar.
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The Function Arguments dialog switches over to MATCH. When you are finished building the MATCH func-
tion, go up to the formula bar and click anywhere in the word INDEX. 

Repeat these steps to build the MATCH in the third argument of INDEX. Make sure to click back in the word 
INDEX in the formula bar when you are done with the second MATCH.

It turns out that the Function Arguments dialog can be fooled into building an invalid function. Type a 
well-formed but nonsensical function in the formula bar. Using the mouse, click inside the fake function 
name in the formula bar and click the fx icon.

Thanks to Tony DeJonker, Cat Parkinson, & Geoff in Huntsville for suggesting the Function Arguments dialog trick.
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#54 Calculate Nonstandard work weeks
In my live Power Excel seminars, it is pretty early in the day when I show how to right-click the Fill Handle, 
drag a date, and then choose Fill Weekdays. This fills Monday through Friday dates. I ask the audience, 
“How many of you work Monday through Friday?” A lot of hands go up. I say, “That’s great. For everyone 
else, Microsoft clearly doesn’t care about you.” Laughter.

It certainly seems that if you work anything other than Monday through Friday or have a year ending any 
day other than December 31, a lot of things in Excel don’t work very well.

However, two functions in Excel show that the Excel team does care about people who work odd work 
weeks: NETWORKDAYS.INTL and WORKDAY.INTL.

But let’s start with their original Monday–Friday antecedents. The following figure shows a start date in 
column B and an end date in column C. If you subtract =C5-B5, you will get the number of days between 
the two dates. To figure out the number of weekdays, you use =NETWORKDAYS(B2,C2).

Note: If you subtract Monday August 14 from Friday August 18, Excel will tell you that there are 4 
days between the two dates. Excel does not count the end date. But, NETWORKDAYS counts both 
the first and last date in the range.

It gets even better. NETWORKDAYS allows for an optional third argument where you specify work holidays. 
In the next figure, the list of holidays in H2:H13 allows the Work Days Less Holidays calculation in column F.
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In Excel 2007, Microsoft added INTL versions of both functions with a new Weekend argument. This argu-
ment allowed for any two consecutive days as the weekend and also allowed for a one-day weekend.

However, there are still cases where the weekend does not meet any of the 14 weekend definitions added 
in Excel 2007. 

For example, in northeast Ohio, the Hartville Marketplace is open Monday, Thursday, Friday, and Saturday. 
That means their weekend is Tuesday, Wednesday, and Sunday.

Starting in Excel 2010, in addition to using 1-7 or 11-17 as the weekend argument, you can pass 7-digit 
binary text to indicate whether a company is open or closed on a particular day. It seems a bit unusual, but 
you use a 1 to indicate that the store is closed for the weekend and a 0 to indicate that the store is open. 
After all, 1 normally means On and 0 normally means Off. But the name of the argument is Weekend, so 1 
means it is a day off, and 0 means you don’t have the day off.

Thus, for the Monday, Thursday, Friday, Saturday schedule at the Hartville Marketplace, you would use 
"0110001". Every time I type one of these text strings, I have to silently say in my head, “Monday, Tuesday, 
Wednesday…” as I type each digit.

Marion Coblentz at the Hartville Marketplace could use the following formula to figure out how many 
Marketplace days there are between two dates.

By the way, I did not use the optional Holidays argument above because Memorial Day, July 4, and Labor 
Day are the biggest customer days in Hartville.
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If you are ever in northeastern Ohio, you need to stop by Hartville to see the 100% American-Made house 
inside of the Hartville Hardware and to try the great food at the Hartville Kitchen.

Bonus Tip: use wOrkDay.INTL for a work Calendar
While NETWORKDAYS calculates the work days between two dates, the WORKDAY function takes a start-
ing date and a number of days, and it calculates the date that is a certain number of work days away.

One common use is to calculate the next work day. In the following figure, the start date is the date on 
the previous row. The number of days is always 1. To generate a class schedule that meets on Monday, 
Wednesday, and Friday, specify a weekend of "0101011". 

#55 Turn Data Sideways with a Formula
Someone built this lookup table sideways, stretching across C1:N2. I realize that I could use HLOOKUP in-
stead of VLOOKUP, but I prefer to turn the data back to a vertical orientation.

Copy C1:N2. Right-click in A4 and choose the Transpose option under the Paste Options. Transpose is the 
fancy Excel word for “turn the data sideways.”

I transpose a lot. But I use Alt+E,S,E,Enter to transpose instead of the right-click.

There is a problem, though. Transpose is a one-time snapshot of the data. What if you have formulas in the 
horizontal data? Is there a way to transpose with a formula? Yes, using the TRANSPOSE function. In the fol-
lowing image, use  =TRANSPOSE(C2:N2). The new =WRAPCOLS(C2:N2,1) will also produce the same result.
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If you don't have Microsoft 365 and you don't have access to the dynamic array formulas, you can use a 
combination of INDEX and ROW, as shown in the figure below. =ROW(1:1) is a clever way of writing the 
number 1. As you copy this formula down, the row reference changes to 2:2 and returns a 2. 

The INDEX function says you are getting the answers from C2:N2, and you want the nth item from the 
range.

In the figure below, =FORMULATEXT in column C shows how the formula changes when you copy down.

Bonus Tip: protect rows with an Old-Style array Formula
Here is an odd use for an array formula: Say that you don‘t want anyone to delete or insert any rows in one 
section of a worksheet. Scroll far to the right, off the screen, and build an array in those rows. Select Z1:Z9. 
Type =2 and press Ctrl+Shift+Enter. You can use any number, =0, =1, =2, and so on.
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If someone tries to delete a row, Excel prevents it and shows a cryptic message about arrays, shown below.

Thanks to Excel Ace and Tracia Williams for suggesting this feature.

#56 Handle Multiple Conditions in IF
When you need to do a conditional calculation, the IF function is the answer. It works like this: If <some-
thing is true>, then <this formula>; otherwise <that formula>. In the following figure, a simple IF calcu-
lates a bonus for your sales of more than $20,000.

But what happens when two conditions need to be met? Most people will nest one IF statement inside 
another, as shown below:
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But this nesting gets out of hand if you have many conditions that have to be met. Use the AND function 
to shorten and simplify the formula. =AND(Test,Test,Test,Test) is True only if all of the logical tests evaluate 
to True. The following example shows a shorter formula with the same results.

If you like AND, you might find a use for OR and NOT. =OR(Test,Test,Test,Test) is True if any one of the logi-
cal tests are True. NOT reverses an answer, so =NOT(True) is False, and =NOT(False) is True. If you ever have 
to do something fancy like a NAND, you can use NOT(AND(Test,Test,Test,Test)).

Caution: Although Excel 2013 introduced XOR as an Exclusive Or, it does not work the way that ac-
countants would expect. =XOR(True,False,True,True) is True for reasons that are too complicated to 
explain here. XOR counts whether you have an odd number of True values. Odd. Really odd.

Bonus Tip: use Boolean Logic
I always cover IF in my seminars. And I always ask how people would solve the two-conditions problem. 
The results are often the same: 70–80% of people use nested IF, and 20–30% use AND. Just one time, in 
Virginia, a woman from Price Waterhouse offered the formula shown below:

It works. It gives the same answer as the other formulas. Calculate the bonus .02*B4. But then multiply that 
bonus by logical tests in parentheses. When you force Excel to multiply a number by True or False, the True 
becomes 1, and the False becomes 0. Any number times 1 is itself. Any number times 0 is 0. Multiplying the 
bonus by the conditions ensures that only rows that meet both conditions are paid.

It is cool. It works. But it seems confusing when you first see it. My joke in my seminar is, “If you are leaving 
your job next month and you hate your co-workers, start using this formula.”
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#57 Troubleshoot vLOOkup
Until XLOOKUP replaced it, VLOOKUP was my favorite function in Excel. If you can use VLOOKUP, you can 
solve many problems in Excel. But there are things that can trip up a VLOOKUP. This topic talks about a few 
of them. 

But first, the basics of VLOOKUP in plain English.

The data in A:C came from the IT department. You asked for sales by item and date. They gave you item 
number. You need the item description. Rather than wait for the IT department to rerun the data, you find 
the table shown in column F:G.

You want VLOOKUP to find the item in A2 while it searches through the first column of the table in 
$F$3:$G$30. When VLOOKUP finds the match in F7, you want VLOOKUP to return the description found in 
the second column of the table. Every VLOOKUP that is looking for an exact match has to end in False (or 
zero, which is equivalent to False). The formula below is set up properly.

Notice that you use F4 to add four dollar signs to the address for the lookup table. As you copy the formula 
down column D, you need the address for the lookup table to remain constant. There are two common 
alternatives: You could specify the entire columns F:G as the lookup table. Or, you could name F3:G30 with 
a name such as ItemTable. If you use =VLOOKUP(A2,ItemTable,2,False), the named range acts like an abso-
lute reference.

Any time you do a bunch of VLOOKUPs, you need to sort the column of VLOOKUPs. Sort ZA, and any #N/A 
errors come to the top. In this case, there is one. Item BG33-9 is missing from the lookup table. Maybe it is 
a typo. Maybe it is a brand-new item. If it is new, insert a new row anywhere in the middle of your lookup 
table and add the new item.
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It is fairly normal to have a few #N/A errors. But in the figure below, exactly the same formula is return-
ing nothing but #N/A. When this happens, see if you can solve the first VLOOKUP. You are looking up the 
BG33-8 found in A2. Start cruising down through the first column of the lookup table. As you can see, the 
matching value clearly is in F10. Why can you see this, but Excel cannot see it?

Go to each cell and press the F2 key. This figure shows F10. Note that the inser-
tion cursor appears right after the 8.

This figure shows cell A2 in Edit mode. The insertion cursor is a couple of spaces 
away from the 8. This is a sign that at some point, this data was stored in an old 
COBOL data set. Back in COBOL, if the Item field was defined as 10 characters and 
you typed only 6 characters, COBOL would pad it with 4 extra spaces.

The solution? Instead of looking up A2, look up TRIM(A2).

The TRIM() function removes leading and trailing spaces. If you have multiple spaces between words, TRIM  
converts them to a single space. In the figure below there are spaces before and after both names in A1. 
=TRIM(A1) removes all but one space in A3.
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By the way, what if the problem had been trailing spaces in column F instead of column A? Add a column 
of TRIM() functions to E, pointing to column F. Copy those and paste as values in F to make the lookups 
start working again.

The other very common reason that VLOOKUP won’t work is shown here. Column F contains real numbers. 
Column A holds text that looks like numbers.

Select all of column A. Press Alt+D, E, F. This does a default Text to Columns operation and converts all text 
numbers to real numbers. The lookup starts working again.

If you want the VLOOKUP to work without changing the data, you can use =VLOOKUP(1*A2,...) to handle 
numbers stored as text or =VLOOKUP(A2&"",...) when your lookup table has text numbers.

#58 use a wildcard in vLOOkup or XLOOkup
You can use a wildcard in VLOOKUP or XLOOKUP. If you aren‘t sure if your lookup table will contain Apple, 
Apple Computer, or Apple Computer Inc, you can use =VLOOKUP("Apple*",Table,2,False), and Excel will 
find the first item in the lookup table that starts with Apple. For XLOOKUP, you have to explicitly ask for a 
wildcard  searching using a 2 as the 5th argument =XLOOKUP("Apple*",A,B,,2) (Thanks to -Khalif John Clark)

Bonus Tip: vLOOkup to Two Tables
You want to try to find a match in Table1. If a match is not found, then do a lookup to Table2. You can 
use =IFNA(Formula,Value if NA). =IFNA(VLOOKUP(A2,Table1,3,False),VLOOKUP(A2,Table2,3,False)). With 
XLOOKUP, the IF_NA is the 4th argument so =XLOOKUP(A2,A,B,XLOOKUP(A2,C,D)).
VLOOKUP was suggested by Rod Apfelbeck, Patty Hahn, John Henning, @ExcelKOS, and @tomatecaolho. Thanks to all of you.
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#59 Twelve Benefits of XLOOkup
The new XLOOKUP function is rolling out to Microsoft 365 starting in November 2019. Joe McDaid of the 
Excel team designed XLOOKUP to unify the people who use VLOOKUP and the people who use INDEX/
MATCH. This section will discuss the 12 benefits of XLOOKUP:

1. Exact match is the default.

2. Integer-based third argument of VLOOKUP is now a proper reference.

3. IFNA is built-in to handle missing values.

4. XLOOKUP has no problem going to the left.

5. Find next-smaller or next-larger match without sorting the table.

6. XLOOKUP can do HLOOKUP.

7. Find the last match by searching from the bottom.

8. Wildcards are "off" by default, but you can turn them back on.

9. Return all 12 months in a single formula.

10. Can return a cell reference if the XLOOKUP is next to a colon such as XLOOKUP();XLOOKUP()

11. Can do a two-way match like INDEX(,MATCH,MATCH) can do.

12. Can sum all lookups in a single formula like LOOKUP could do.

Here is the syntax: 

=XLOOKUP(Lookup_Value, Lookup_Array, Results_Array, [if_not_found], {match_mode], [search_mode]).

XLOOkup Benefit 1: Exact Match by Default

99% of my VLOOKUP formulas end in ,FALSE or ,0 to indicate an exact match. If you always use the exact 
match version of VLOOKUP, you can start leaving the match_mode off of your XLOOKUP function.

In the following figure, you are looking up W25-6 from cell A4. You want to look for that item in L8:L35. 
When it is found, you want the corresponding price from column N. There is no need to specify False as the 
match_mode because XLOOKUP defaults to an exact match.
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XLOOkup Benefit 2: the results_array is a reference instead of an integer

Think about the VLOOKUP formula that you would use before XLOOKUP. The third argument would've 
been a 3 to indicate that you wanted to return the 3rd column. There was always a danger that a clueless 
co-worker would've inserted (or deleted) a column in your table. With an extra column in the table, the 
VLOOKUP that had been returning a price would start returning a description. Because XLOOKUP was 
pointing to a cell reference, the formula rewrites itself to keep pointing to the price that is now in column 
O.

XLOOkup Benefit 3: IFNa is built in as an optional argument

The dreaded #N/A error is returned when your lookup value is not found in the table. In the past, to re-
place #N/A with something else, you would have to use IFERROR or IFNA wrapped around the VLOOKUP. 

Thanks to a suggestion from Rico S. on my YouTube channel, the Excel team incorporated an optional 
fourth argument for if_not_found. If you want to replace those #N/A errors with zero, simply add ,0 as the 
fourth argument. Or, you could use some text, such as "Value not found".
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XLOOkup Benefit 4: No problem looking to the left of the key field

VLOOKUP can not look to the left of the key field without resorting to VLOOKUP(A4, CHOOSE({1,2}, 
G7:G34,F7:F34),2,False). With XLOOKUP, there is no problem having the Results_array to the left of the 
Lookup_array.

XLOOkup Benefit 5: Next-smaller or next-larger match without sorting

By default, XLOOKUP looks for an exact match. Using the 5th argument for match_mode allows you to 
look for the exact value or just smaller or the exact value or just larger.

Before XLOOKUP, VLOOKUP was able to do the just smaller. For just larger, you had to use MATCH. But both 
of those obsolete functions required the lookup table to be sorted. With XLOOKUP, the table does not have 
to be sorted.

XLOOKUP's optional fifth argument match_mode uses these values:

 ● -1 finds the value equal to or just smaller
 ● 0 find an exact match
 ● 1 finds the value equal to or just larger.

Caution: The 1 and -1 here are opposite of MATCH. These make more sense than MATCH.

Below, a match_mode of -1 find the next-smaller item.

Here, a match_mode of 1, finds what vehicle is needed depending on the number of people in the party. 
Note that the lookup table is not sorted by passengers and the vehicle name is to the left of the key.
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XLOOkup Benefit 6: Sideways XLOOkup replaces HLOOkup

The lookup_array and results_array can be horizontal with XLOOKUP, making it simple to replace 
HLOOKUP.

XLOOkup Benefit 7: Search from the bottom for latest match

I have an old video on YouTube answering a question from a British horse farm. They had a fleet of ve-
hicles. Every time a vehicle came in for fuel or service, they logged vehicle, date, and mileage in a spread-
sheet. They wanted to find the latest known mileage for each vehicle. While the Excel-2017 era MAXIFS 
might solve this today, the solution many years ago was an arcane formula using LOOKUP and involved 
division by zero.

Today, XLOOKUP's optional sixth argument lets you specify that the search should start from the bottom 
of the data set.

Note: While this is a great improvement, it only lets you find the first or last match. Some people 
hoped this would let you find the second or third match, but that is not the intention of the 
search_mode argument.

Caution: The figure above shows that there are search modes using the old binary search. Joe 
McDaid advises against using these. First, the improved lookup algorithm from 2018 is fast enough 
that there is no significant speed benefit. Second, you run the risk of a clueless co-worker sorting 
the lookup table and introducing wrong answers.
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XLOOkup Benefit 8: wildcards are "turned off" by default

Most people did not realize that VLOOKUP is treating asterisk, question mark, and tilde as wildcard char-
acters as described in "#58 Use a Wildcard in VLOOKUP or XLOOKUP" on page 141. With XLOOKUP, wild-
cards are turned off by default. If you want XLOOKUP to treat these characters as a wildcard, use 2 as the 
Match_Mode.

XLOOkup Benefit 9: return all 12 Months in a Single Formula!

This is really a benefit of Dynamic Arrays, but it is my favorite reason to love XLOOKUP. When you have to 
return all 12 months in a lookup, a single formula entered in B6 with a rectangular return_array will return 
multiple results. Those results will spill into adjacent cells.

In the figure below, a single formula entered in B7 returns all 12 answers shown in B7:M7.

XLOOkup Benefit 10: One Formula performs all XLOOkup

A single formula can perform an entire column of XLOOKUP. In the figure below, one formula in C4 replac-
es 11 XLOOKUP formulas. You can not combine benefit #9 and #10 to return many rows of many columns.
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Benefit 11: XLOOkup Can return a Cell reference If adjacent to Colon

This one is complex but beautiful. In the past, there were seven functions that would change from return-
ing a cell value to returning a cell reference if the function was touching a colon. For an example, see "#86 
Use A2:INDEX() as a Non-Volatile OFFSET" on page 183. XLOOKUP is the eights function to offer this be-
havior, joining CHOOSE, IF, IFS, INDEX, INDIRECT, OFFSET, and SWITCH.

Consider the following figure. Someone select Cherry in E4 and Fig in E5. You want a formula that will sum everything 
from B6 to B9.

In the figure above, you can see that an XLOOKUP of E4 will return the 15 from cell B6. An XLOOKUP of E5 
will return the 30 from B9. However, if you take the two XLOOKUP functions from cells D9 and D10 and put 
them together with a colon in-between, the behavior of XLOOKUP changes. Instead of returning 15, the 
first XLOOKUP returns the cell address B6!

To prove this, I've selected D7 and use Formulas, Evaluate Formula. After pressing Evaluate two times, the 
next part to be calculated is XLOOKUP("Cherry",A4:A29,B4:B29), as shown here.

Press Evaluate again and amazingly, the XLOOKUP formula returns $B$6 instead of the 15 stored in B6. This 
happens because there is a colon immediately following this XLOOKUP formula.

Press Evaluate two more times, and the interim formula will be =SUM(B6:B9). 

This is amazing behavior that most people don't know about. Excel MVP Charles Williams tells me that it 
can be triggered with any of these three operators next to XLOOKUP: Colon, Space (Intersection operator), 
or a Comma (Union operator).
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XLOOkup Benefit 12: Two-way match like INDEX(,MaTCH,MaTCH)

For all of my VLOOKUP friends, the INDEX/MATCH people have been waiting to see if XLOOKUP can handle 
a two-way match. The great news: it can do it. The bad news: the methodology is a little different than the 
INDEX/MATCH fans would expect. It might be a little over their heads. But I am sure they can come around 
to this method.

For a two-way match, you want to find which row contains the account number A621 shown in J3. So, the 
XLOOKUP starts out easy enough: =XLOOKUP(J3,A5:A15. But then you have to provide a results_array. You 
can use the same trick as in "XLOOKUP Benefit 9: Return All 12 Months in a Single Formula!" on page 146, 
but use it to return a vertical vector. An inner XLOOKUP looks for the J4 month in the month headings in 
B4:G4. The return_array is specified as B5:G15. The result is that the inner XLOOKUP returns an array like 
the one shown in I10:I20 below. Since A621 is found in the fifth cell of the lookup_array and 104 is found in 
the fifth cell of the results_array, you get the correct answer from the formula. Below, J6 shows the old way. 
J7 returns the new way. 

Bonus Tip: what about a Twisted LOOkup?

Excel MVP Mike Girvin often shows a trick of the LOOKUP function where the Lookup_Vector is vertical and 
the Result_Vector is horizontal. XLOOKUP will not natively support this trick. But, if you cheat a little bit 
and wrap the results_array in the TRANSPOSE function, you can manage a twisted lookup.
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#60 preview what remove Duplicates will remove
The Remove Duplicates tool added in Excel 2010 was a nice addition.

However, the tool does remove the duplicates. Sometimes, you might want to see the duplicates before 
you remove them. And the Home, Conditional Formatting, Highlight Cells, Duplicate Values marks both 
instances of Andy instead of just the one that will be removed. The solution is to create a conditional for-
matting rule using a formula. Select A2:B14. Home, Conditional Formatting, New Rule, Use a Formula. The 
formula should be: =COUNTIF($A$1:$A1,$A2)>0.

It is hard to visualize why this will work. Notice that there is a dollar sign missing from $A$1:$A1. This cre-
ates an expanding range. In English the formula says "Look at all of the values from A1 to A just above the 
current cell and see if they are equal to the current cell". Only cells that return >0 will be formatted.

I've added the formula to column C below so you can see how the range expands. In Row 5, the COUNTIF 
checks how many times Andy appears in A1:A4. Since there is one match, the cell is formatted.
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#61 replace Nested IFs with a Lookup Table
A long time ago, I worked for the vice president of sales at a company. I was always modeling some new 
bonus program or commission plan. I became pretty used to commission plans with all sorts of conditions. 
The one shown in this tip is pretty tame.

The normal approach is to start building a nested IF formula. You always start at either the high end or the 
low end of the range. “If sales are over $500K, then the discount is 20%; otherwise,….” The third argument 
of the IF function is a whole new IF function that tests for the second level: "If sales are over $250K, then 
the discount is 15%;  otherwise,….”

These formulas get longer and longer as there are more levels. Once you get past a few levels, it is easier to 
move the logic to a lookup table.

Rather than use the nested IF function, try using the XLOOKUP function. In the formula below, all of the 
discount rules are shown in the table in E12:G18.

The Match_Mode argument with -1 will find the value just less than the search value.  In the past with 
VLOOKUP and MATCH, your lookup table would have to be sorted. The following example shows that the 
XLOOKUP can perform an approximate match even if the table is not sorted.

Consider the table below. In cell C10, Excel will be looking for a match for $550,000 in the table. When it 
can’t find 550,000, Excel will return the discount associated with the value that is just less—in this case, the 
20% discount for the $500K level.
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What if your manager wants a completely self-contained formula and does not want to see the bonus 
table off to the right? Select the C10 cell. Click in the formula bar and select the characters F13:F18. Press 
F9 and Excel will replace the cell reference with an array constant. Repeat for the characters G13:G18. Press 
Enter. You can now delete the lookup table.

Bonus Tip: Match the parentheses
Excel cycles through a variety of colors for each new level of parentheses. While Excel reuses the colors, it 

uses black only for the open-
ing parenthesis and for the 
matching closing parenthesis. 
As you are finishing the for-
mula below, just keep typing 
closing parentheses until you 
type a black parenthesis.

Tip: In Microsoft 365, you could use the following formula to solve the discount presented above: 
 =IFS(B10>500000,20%,B10>250000,15%,B10>100000,10%,B10>50000,5%,B10>10000,1%,TRUE,0)

Thanks to Mike Girvin for teaching me about the matching parentheses. The lookup table technique was suggested by Danny 
Mac, Boriana Petrova, Andreas Thehos, and @mvmcos.

#62 Suppress Errors with IFErrOr
Formula errors are common. If you have a data set with hundreds of records, a divide-by-zero and an #N/A 
errors are bound to pop up now and then.

In the past, preventing errors required Herculean efforts. Nod your head knowingly if you’ve ever knocked 
out =IF(ISNA(VLOOKUP(A2,Table,2,0),"Not Found",VLOOKUP(A2,Table,2,0)). Besides being really long to 
type, that solution requires twice as many VLOOKUPs. First, you do a VLOOKUP to see if the VLOOKUP is 
going to produce an error. Then you do the same VLOOKUP again to get the non-error result.

Excel 2010 introduced the greatly improved =IFERROR(Formula,Value If Error). I know that IFERROR sounds 
like the old ISERROR, ISERR, and ISNA functions, but it is completely different.
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This is a brilliant function: =IFERROR(VLOOKUP(A2,Table,2,0),"Not Found"). If you have 1,000 VLOOKUPs 
and only 5 return #N/A, then the 995 that worked require only a single VLOOKUP. Only the 5 VLOOKUPs re-
turned #N/A that need to move on to the second argument of IFERROR.

Oddly, Excel 2013 added the IFNA() function. It is just like IFERROR but only looks for #N/A errors. One 
might imagine a strange situation where the value in the lookup table is found, but the resulting answer is 
a division by 0. If you want to preserve the divide-by-zero error for some reason, you can use IFNA() to do 
this.

Of course, the person who built the lookup table should have used IFERROR to prevent the division by 
zero in the first place. In the figure below, the "n.m." is a former manager’s code for “not meaningful.”

Thanks to Justin Fishman, Stephen Gilmer, and Excel by Joe.

#63 Handle plural Conditions with SuMIFS
Did you notice the “S” that got added to the end of SUMIF starting in Excel 2007? While SUMIF and SUMIFS 
sound the same, the new SUMIFS can run circles around its elder sibling.

The old SUMIF and COUNTIF have been around since Excel 97. In the figure below, the formula tells Excel 
to look through the names in B2:B22. If a name is equal to the name in F4, then sum the corresponding cell 
from the range starting in D2:D22. (While the third argument could be the first cell of the sum range D2, it 
will make the function volatile, causing the worksheet to calculate more slowly.)
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SUMIF and COUNTIF were great with only one condition. But with two or more things to check, you had 
to switch over to SUMPRODUCT, as shown below. (I realize most people would replace my multiplication 
signs with commas and add a double-minus before the first two terms, but my version works, too.)

SUMIFS allows for up to 127 conditions. Because you might have an indeterminate number of conditions 
in the function, the numbers that you are adding up move from the third argument to the first argument. 
In the following formula, you are summing D2:D22, but only the rows where column B is Allen Matz and 
column C is Widget. The logic of "Sum this if these conditions are true" is logical in SUMIFS.

Excel 2007 also added plural versions of COUNTIFS and AVERAGEIFS. In February 2017, Microsoft 365 
added MAXIFS and MINIFS. All these “S” functions are very efficient and fast. 
Thanks to Nathi Njoko, Abshir Osman, Scott Russell, and Ryan Sitoy.
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#64 Geography, Exchange rate & Stock Data Types in Excel
In the past, Excel did not really handle data types. Yes, you could format some cells as Date or Text, but the 
new data types provide a whole new entry point for new data types now and in the future.

Start with a column of City names. For large cities 
like Madison Wisconsin, you can just put Madison. 
For smaller towns, you might enter Madison, FL.

From the Data tab, select Geography.

Excel searches the Internet and finds a city for each 
cell. A folded map appears next to each cell. Notice 
that you lose the state that was in the original cell.

Click on the Map icon and a data card appears with information about the city.

The best part: for any data in the card, you can use a formula to pull that data into a cell. Enter 
=A2.Population in cell B2 and Excel returns the population of El Paso.  Double click the Fill Handle in B2 
and Excel returns the population for each city.
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Caution: These new formulas might return 
a #FIELD! error. This means, Excel (or more 
correctly Bing), does not know the answer 
to this yet, but it may do so at some time 
in the future. It is not an error with the for-
mula or the table, just a lack of knowledge 
currently.

Here is a great tip: Excel uses the context of other cells around the value to try to figure out ambiguous 
entries. In the following image, because Madison is in the middle of other Wisconsin cities, Excel will auto-
matically choose Madison Wisconsin.

If you type Madison in a column that has Florida cities, Excel will correctly figure out that you want 
Madison Florida, even though it is smaller than the capital city of Wisconsin.

If you simply type Madison in a cell without any other values above or below it, Excel won't choose any of 
the towns named Madison. Instead of a map icon, you will have a circled question mark. The Data Selector 
pane will appear to allow you to choose which Madison you want.
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The Geography and Stock data types have extra features if you format as a table using Ctrl+T.

A new Add Data icon appears to the right of the heading. Use this drop-down menu to add fields without 
having to type the formulas. Clicking the icon will enter the formula for you.

You can also sort the data by any field, even if it is not in the Excel grid. Open the drop-down menu for the 
City column. Use the new Display Field drop-down to choose Longitude. 

With Longitude selected, choose sort Smallest to Largest.
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The result: data is sorted west to east.

Support for exchange rates appeared in early 2019. While it initially was accessed by using the Stocks icon, 
it now has it's own Currency icon in the gallery. Enter currency pairs such as USD-CAD for U.S. Dollar to 
Canadian Dollar. Use the Price field for the current exchange rate.

Bonus Tip: use Data, refresh all to update Stock Data
Another data type available is Stock data. Enter some publicly held companies:
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Choose, Data, Stocks. An icon of a building with Roman columns should appear next to each company You 
can add fields such as CEO, Price, Volume, High, Low, Previous Close.

In contrast to Geography, where population might only be updated once a year, the stock price will be 
constantly changing throughout the trading day. Rather than go out to the Internet with every recalc, 
Excel will only updated the data from these Linked Data Types when you choose Refresh.

One easy way to update the stock prices is to use the Refresh All icon on the Data tab. 

As the name implies, Refresh All will update everything in your workbook, including any Power Query data 
connections which might take a long time to update. If you want to only refresh the current block of linked 
data, right-click on A2, choose Data Types, Refresh.

At some point in 2021, a new setting will allow Stock Data Types to update every five minutes.

Right-click any cell with a Stock Data Type. Choose Data Type, Refresh Settings.
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In the Data Types Refresh Settings, click the Stocks 
chevron to open the options. Select Automatically 
Update Every 5 Minutes. 

Note: Yes, the choices here are limited. 
What if you want to refresh every one 
minute or every 10 minutes? Too bad. 
Getting the choice to refresh every five 
minutes is better than the two years when 
you had to manually refresh.

The Stock data type only delivers the current day's stock price. For stock history, see the STOCKHISTORY 
function, discussed next.

#65 Get Historical Stock History from STOCkHISTOry
In June 2020, Microsoft 365 added the new STOCKHISTORY function. It will pull historical stock data after 
the market has closed. The syntax is as follows:

=STOCKHISTORY(stock,start_date,end_date,interval,headers,properties1,...)

For the stock, use any ticker symbol. The start date can be a cell containing a date or text such as "1-1-
2021". The end date is assumed to be today, or you can enter another date. For the interval, use 0 for daily, 
1 for weekly, 2 for monthly. The headers argument can be 0 for no headers, 1 for a single row of headers or 
2 for the stock name and then headers. Properties1 through Properties6 specify which fields and the order 
they should appear: 0 is Date, 1 is Close, 2 is Open, 3 is High, 4 is Low, 5 is Volume. You can specify from 1 to 
6 properties in any order.    …

Note that the stock data is updated once a day, a few hours after the market closes.
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#66 More Data Types from wolfram alpha
During 2020, Microsoft licensed more data from the Wolfram Alpha database. There are now data types 
for Activity, Anatomy, Animal, Chemistry, City, Food, Location, Medical, Movie, Music, Nature, People, Plant, 
Space, University, and Yoga. 

Data types now support arrays. The card view becomes an important way to browse the data available. 

In the figure below, convert banana to a food data type. Click the icon to the left of Banana to open the 
data card. As you browse through the card, if you find something that you want to add to the grid, click the 
Extract to Grid icon.

Bonus Tip: The Data Card is now Expandable and Supports arrays
When data types first debuted, I was not a fan of the tiny Data Card that would appear. In 2020, the Excel 
team improved the data card. First, you can use a handle in the lower right to make the card wider. Second, 
you can use the card to explore and jump to other data types. Third, the data card now supports arrays.

Let's start in Springfield Missouri. Type Springfield MO in a cell and declare it as a Location. (Location is the 
new Wolfram Alpha data type and has more information than the old Geography field.)

Scroll down to Notable People. Initially, you can see Kathleen Turner, Lucas Grabeel, and someone who's 
name starts with Payn.... To the left of that list, there is an Array icon.
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Click the Array icon and the card changes to show you all the notable people born in Springfield MO.

Each of those people have an icon. Click the icon to the left of Kathleen Turner. Go to her Notable Works. 
Click on the Movie icon for the War of the Roses. Click on Cast. Click on Danny DeVito. Click on Notable 
Works. Choose One Flew Over the Cuckoo's Nest. Choose Cast. Choose Scatman Carruthers. Choose Place 
of Death. Choose Los Angeles. Choose Notable People Born. Choose Marilyn Monroe. Choose Notable 
Works. Choose There's No Business Like Show Business. Choose Cast. Finally, choose to add this to the grid.

Excel MVP David Benaim calls the card the "Excel Encyclopedia".  After adding it to the grid, Excel remem-
bers the entire chain that got you from Springfield MO to Ethel Merman. The formula for the results is 
=INDEX(INDEX(INDEX(INDEX(INDEX(INDEX(INDEX(A1.[notable people born in city],1,1).[notable film ap-
pearances],7,1).[cast and roles],3,1).cast.[notable film appearances],1,1).[cast and roles],4,1).cast.[place of 
death].[notable people born in city],4,1).[notable film appearances],13,1).[cast and roles].

#67 Getting Historical weather For a City
The new Wolfram Alpha data type for Location includes Weather History. It takes several clicks to drill 
down to the weather data and even more manipulation to change from metric to Fahrenheit.

1. Start with a city name in A1. In my example, I am using Columbus, Indiana.

2. Convert that to a Location data type by using the Data Types gallery on the Data tab.

3. Click the icon to the left of the city. Scroll down to the Weather section. Click the icon for "Weather for 
Columbus".

4. In the next panel, the only option is another weather icon called "Weather History for Columbus". Click 
the icon.

5. You now have three tables offering daily, weekly, or monthly weather history. Choose a table and click 
the Extract icon to the right of the table.
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6. Say that you had chosen monthly weather history. You now have 12 cells that say "January weather 
(monthly)." Each cell has an icon to the left of the word.

7. Click the icon for January and you will have choices for average temperature, average high, average low, 
record high, record low, and average precipitation.

8. Choose to add Mean Maximimum Temperature to the grid. You will get one cell with the average high 
temperature for January in Celsius.

9. Edit the formula in C1. Wrap it in =CONVERT(<formula>,"C","F") to convert from Celsius to Fahrenheit.

10. While editing the formula in C1, type a Hash (#) character after B1. This tells Excel to return the answers 
for the entire array starting in B1.

In the download files for this book, I have an example returning daily precipitation in inches for a city. The 
data type returns the dates as text, so a formula of =DATEVALUE(B2#.day&", 2020") is needed to create a 
date that can be charted. The data type is returning rainfall in centimeters, so a formula of =CONVERT(B2#.
[mean precipitation],"cm","in").
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The following chart shows average daily rainfall for Quibdo, Colombia, often cited as the rainiest city on 
Earth.

If you type Las Vegas, NV in cell A2 and wait for 30 seconds, the data and chart will update and show rain-
fail for the driest city in the United States.

Caution: The formulas will briefly show as #FIELD! as Excel tries to resolve Las Vegas as a location 
and then everything will show as #BUSY! while the new data is downloaded from the Internet.
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#68 Create your Own Data Types using power Query
Data types sound great, but wouldn't you like to have your own company data as a data type? Imagine if 
you had your company product list in a data type. You could store the SKU in a column and then extract 
item information using XLOOKUP or dot formulas such as =A2.Country.

There have been three solutions from Microsoft that allow you to do this. Power Query was first. Then 
Power BI. Then a Javascript API. I've tried them all. I want these to work just like real data types do. Here is 
my wish list and how PQ (Power Query), PBI (Power BI), and API (JavaScript API).

So far, the best experience is JavaScript API. Here are three videos, one for each method.

Power Query Power BI JavaScript API
https://youtu.be/z-WDstDUzyA  https://youtu.be/B5Kg-5XCWZA https://youtu.be/iAajH_Nkr_s
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#69 IF Based on Installed Language in a Bilingual worksheet
If you have a workbook that is used in a bilingual company, how will you know if the person using the 
workbook has English or Portuguese installed? =LEFT(TRUE) will return T for English or V for Portuguese. 
You can use =IF(LEFT(True)="T","Welcome to the Budget","Bem-vindo ao Orçamento").
Thanks to Cristiano Galvão from the Excel Turbo channel on YouTube for this technique.

#70 Dynamic arrays Can Spill
Introduced in 2019, the new Dynamic Arrays represent a major change to the Excel calculation engine. 
While the old Ctrl+Shift+Enter array formulas could return several results into a pre-selected range, these 
new formulas do not require Ctrl+Shift+Enter and you don't have to pre-select the range.

For example, let's say you type =B2:B8*C1 into cell C2. In the past, this formula would have required dollar 
signs around $C$1. You would copy the formula to all 7 cells and something called implicit intersection 
would make sure the numbers were correct.

But now, with Dynamic Arrays, one formula in cell C2 will spill over and return results into many cells.
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When you select any cell from C2:C8, a blue outline appears 
around the cells to let you know that the values are the result of a 
single formula. That single formula only exists in C2. If you select 
any other cell in the range, the formula appears in the formula 
bar, but it is greyed out.

If the range B2:B8 grows (by someone inserting rows in the 
middle), the spilled results will grow as well. However, simply 
typing new values in A9:B9 will not cause the formula to extend, 
unless you format the whole range with Ctrl+T before adding 
values. 

What if a formula can not spill? What if there are 
non-empty cells in the way? Rather than return 
partial results, the formula will return the new 
#SPILL! error.

Open the yellow dropdown to the left of the error 
and you can select the obstructing cells.

Once you clear the obstructing cells, the answers will appear again.

#71 Sorting with a Formula
Sorting data in Excel is easy. Unless, you are building a dashboard for your manager's manager. You can't 
ask that person to select C3, go to the Data tab and click the AZ button every time they want an updated 
report. The new SORT and SORTBY functions allow you to easily sort with a formula.

You can pass three arguments to the SORT function. The first is the range to be sorted. Leave the headings 
out of this argument. Next, which column do you want to sort by. If your data is in B:D and you want to 
sort by column D, you would specify column 3 as the sort column. The third argument is a 1 for ascending 
or -1 for descending.
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In this figure, the data is sorted by Amount descending:

What if you want to do a two-level sort? You can specify an array constant for both the second and third 
argument. In this case, the data is sorted by Team ascending and Amount descending. For the sort column, 
specify {2;3}. For the sort order, specify {1;-1}.

The Excel Calc team also gave you the SORTBY function. Say you want to return a list of products but not 
the associated amounts. You want the products to be sorted by the amount.  The formula below says to 
return the products from B3:B9 sorted descending by the amounts in D3:D9.
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#72 Filter with a Formula
The FILTER function is new as part of the dynamic arrays feature. There are three arguments: array, include, 
and an optional [if empty].

Say you want to be able to enter a team name in G1 and extract all of the records for that team. Use a for-
mula of =FILTER(B3:E9,C3:C9=G1).

If cell G1 changes from Red to Blue, the results change to show you the blue team records.
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In the above examples, the optional [If Empty] argument is missing. If someone is allowed to enter the 
wrong team name in G1, then you will get a #CALC! error.

To avoid the #CALC! error, add a third argument.

You can specify an array constant for the third argument if you want to fill each column of the answer 
array.
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To filter to records where multiple conditions are met, multiply the conditions together.

Bonus Tip: understanding array Constants
You've just seen a few examples that included an array constant.  Here is a simple way to understand them. 
A comma inside an array constant means to move to the next column. A semi-colon means to move to 
the next row. How do you remember which is which? The semi-colon on your keyboard is located near the 
Enter or Return key which also goes to the next row.

When you see an array constant with a mix of commas and semi-colons, remember that each semi-colon 
moves to a new row.
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#73 Formula for unique or Distinct
The UNIQUE function will provide either a list of unique or distinct values.

If you ask me for the list of unique values from this list: Apple, Apple, Banana, Cherry, Cherry, I would tell 
you that the list of unique values is Apple, Banana, Cherry. If you ask 100 accountants, about 92 of them 
would agree with me. But there is a segment of the population who disagrees and says that the only 
unique thing in the list is Banana because it is the only item that appears once. 

This unusual definition of "unique" comes from the SQL Server world, where database pros would say that 
"Apple, Banana, Cherry" is a list of distinct values and Banana is the only unique value.

The new UNIQUE function will return either list. If you simply ask for =UNIQUE(R5:R9), you get my defini-
tion of all values that occur one or more times. But, if you are a database pro or Casey Kasem, then you can 
put a True as the third argument.

Here is a list of all the Billboard Top 10 Hits from 1979 - 1993.

To get a list of genres, use =UNIQUE()
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Bonus Tip: use # "The Spiller" to refer to all array results
In the previous screenshot, the UNIQUE function is in cell F5. You never really know how many results that 
formula will return. To refer to "the entire array returned by the formula in F5", you would write F5#.  There 
is no official name for this notation, so I am using an idiom coined by Excel MVP Ingeborg Hawighorst: The 
Spiller.

#74 Other Functions Can Now accept arrays as arguments

Once you see the list of genres, you might want to know how frequently 
each genre appears. That would normally require a series of COUNTIF or 
COUNTIFS formulas. For example, =COUNTIF(D$4:D$6132,"Rock") would 
count how many songs were in the Rock genre. But rather than entering 
a bunch of COUNTIF functions, you could enter a single COUNTIF func-
tion and pass an array as the second argument. The formula below uses 
The Spiller syntax to ask Excel to repeat the COUNTIF for each answer in 
the UNIQUE function in F5.

#75 One Hit wonders with uNIQuE
For me, I can't imagine why I would ever need a list of items that have been sold exactly once. My only ex-
ample is the One-Hit Wonders segment on Casey Kasem's American Top 40 radio show.

To get a list of artists who had exactly one hit, use =UNIQUE(B4:B6132..True). In the figure below, the 
UNIQUE function is wrapped in a SORT function so the resulting list is alphabetical.

To get the titles in column J, a VLOOKUP uses an array as the first argument. This is pretty wild - one 
VLOOKUP formula is actually doing over 1000 lookups and returning all 1000 results.

Another approach is to use a FILTER function combined with IFERROR and MATCH.
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#76 SEQuENCE inside of other Functions such as IpMT
After SORT, SORTBY, FILTER, and UNIQUE, the SEQUENCE and RANDARRAY functions seem pretty tame. 
SEQUENCE will generate a sequence of numbers.

It does not seem like this is very interesting. Who needs to generate a list of numbers?

Try putting SEQUENCE inside other functions. Here, IPMT calculates the interest in the 7th month of a loan:

Thanks to SEQUENCE, this formula calculates the interest paid during 12 months starting in month 7:

Two formulas create a forward-looking calendar:

=SEQUENCE(52,1,TODAY(),-7) would produce a list of the past 52 weeks.
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#77 Generating random Numbers in Excel
The RAND function generates a random decimal between 0 and 1, not including 1. The RANDBETWEEN 
function generates a random integer between 2 numbers. The new RANDARRAY function products an 
array of random numbers. Specify the numbers of rows, columns, minimum, maximum, and if you only 
want integers.

If you ask for =RANDARRAY(14,1,50,150,True), you will get a scatttershot of numbers from 50 to 150. In 
some models, it might make more sense to have the numbers in a bell curve with a mean of 100 and a 
standard deviation of 25. Use =SORT(NORM.INV(RANDARRAY(14),100,25)) to generate random numbers 
that tend to be closer to 100.

#78 replace a pivot Table with 3 Dynamic arrays
As the co-author of Pivot Table Data Crunching, I love a good pivot table. But Excel Project Manager Joe 
McDaid and Excel MVP Roger Govier both pointed out that the three formulas shown here simulate a pivot 
table and do not have to be refreshed.

To build the report, =SORT(UNIQUE(C2:C392)) provides a vertical list of customers starting in F6. Then, 
=TRANSPOSE(SORT(UNIQUE(A2:A392))) provides a horizontal list of products starting in G5.

When you specify F6# and G5# in arguments of SUMIFS, Excel returns a two-dimensional result: 
=SUMIFS(D2:D392,C2:C392,F6#,A2:A392,G5#).
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Bonus Tip: replace Ctrl+Shift+Enter with Dynamic arrays.
Before dynamic arrays, people would use these crazy Ctrl+Shift+Enter formulas. 

Say that you have a friend who is superstitious about Friday the 13th. You want to illustrate how many 
Friday the 13ths your friend has lived through. Before Dynamic Arrays, you would have to use the formula 
below. 

The same formula after dynamic arrays is still complicated, but less intimidating:

Another example from Mike Girvin's Ctrl+Shift+Enter book is to get a unique list. 

Here is the formula. I won’t try to explain it to you.

The replacement formula with dynamic arrays is =UNIQUE(B2:B146).
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#79 Dependent validation using Dynamic arrays
The Data Validation feature lets you choose from a dropdown list in Excel. It works great until someone 
wants to have two lists. The items in the second list are dependent on what is chosen in the first list. This is 
called dependent validation.

In the figure below, the items for the first dropdown list appear in D4#, thanks to  
=SORT(UNIQUE(B4:B23)). The validation in H3 points to =D4#. The list for the second validation appears in 
E4# because of the formula =SORT(FILTER(A4:A23,B4:B23=H3,"Choose Class First")). The validation in H5 
uses =E4#.

#80 Complex validation using a Formula
The method above is fine if you have Dynamic Arrays. But a lot of people running perpetual versions of 
Excel won't have Dynamic Arrays for years. Other published methods for Dependent Validation require a 
new named range for every possible choice in the first and second drop-down.

I was doing a seminar in Mobile, Alabama and several people there wanted to set up a three-level valida-
tion, but they did not care about having drop-downs to choose from. "I just want to validate that people 
are typing the correct values."

Rather than use the option to allow a list, you can set up custom validation using a formula. Say that you 
have a table with hundreds of valid selections.

If you think that your list will grow over time, format it as a Table using Ctrl+T.

Set up a named range for each of the three columns. This step is necessary so you can refer to each column 
and the names will grow as the table grows.

Select A2:A551. In the Name Box, type cCountry and press enter.
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Name B2:B551 as cState. Name C2:C551 as cCity.

Here is the area where you want people to type a Country, State, and City.

It is always easier to build and test your formulas for conditional formatting and validation in a cell first. 
Take a look at the formulas shown below to test each of the entries.

Once those formulas are working, edit cell H3. Using the mouse, select the characters in the formula bar 
and press Ctrl+C to copy. Select F3 and press Alt+D L to open the Data Validation drop-down. In the Allow 
box, choose Custom. This will reveal a Formula box. Paste your formula in that box.

Optionally, fill out an Input Message and Error Alert. Repeat to put the H4 formula as the validation for F4 
and the H5 formula for validation for F5. The result: it will prevent a wrong entry.
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#81 Stack Multiple arrays
If you need to combine multiple arrays into a single array, you can stack multiple arrays vertically using 
VSTACK. Stack multiple arrays horizontally using HSTACK.

In the figure below, one array formula is returning the headings in A2:D2. A second array formula is return-
ing the numbers in A3:D3. These are two separate arrays. If you needed to stack them into a single array, 
you could use =VSTACK(A2#,A3#).

Caution: If the arrays being stacked have different number of columns, Excel will fill the shorter 
arrays with #N/A. To prevent this, use the EXPAND function. =EXPAND(array, rows, columns, pad 
with). In the figure below, there are only 3 numbers in A3# and this causes the #N/A in D6. By using 
=VSTACK(A2#,EXPAND(A3#,1,4,"")) you can prevent the #N/A.

Tip: These examples are only stacking two arrays. You can stack up to 254 arrays.

#82 Dropping, Taking, or Choosing from an array
Say that you have an array in A1# that includes 1 row of headings, 10 rows of numbers and 1 row of totals. 
If you want to remove the headers, you could =DROP(A1#,1) to drop the top row.

=DROP(A1#, 2) will drop the top two rows.

The function syntax is DROP(array, rows, [columns]).

Any time that you use a negative number for Rows or Columns, Excel will drop from the bottom or right 
edge of the array.

=DROP(A1#,-1) will remove the bottom row.

=DROP(A1#,,-1) will remove the right-most column.

=DROP(A1#,-1,-1) will remove the bottom row and right-most column.



DrOppING, TakING, Or CHOOSING FrOM aN array 179 

4 

If you wanted to remove the top row and bottom row, you can not specify both 1 and -1 in the same DROP 
function. But you could use two DROP functions, like this: =DROP(DROP(A1#,1),-1).

While DROP is designed to remove rows or columns from the start or end of an array, the TAKE function 
will keep only the beginning or ending rows or columns from an array. =TAKE(Array, Rows, [Columns]). If 
you =TAKE(A1#,1), you will get the top row of the array. Negative numbers will take from the end of the 
array. To get the Total column, you could use =TAKE(A1#,,-1).

DROP and TAKE are oddly specific, in that they only point to the first or last rows/columns of an array. In 
contrast, CHOOSEROWS and CHOOSECOLS will let you specify any number of rows or columns. If you 
wanted to get the first and last rows of the array in A1#, you could use =CHOOSEROWS(A1#,1,-1).

If you wanted to get all of the odd numbered columns in an array, you could use =CHOOSECOLS(A1#, 
SEQUENCE(5,1,1,2)).
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My question: when would you use DROP or TAKE versus CHOOSEROWS or CHOOSECOLS? Here is my early 
thoughts on this. DROP or TAKE only work on the rows or columns at the edge of the array. The one benefit 
of DROP or TAKE is that you can simultaneously remove a total row and total column.

You can DROP or TAKE multiple rows or columns, but only from one side of the array at a time. For exam-
ple, you can remove the top 3 rows: =DROP(A1#,3) or the bottom 4 rows: =DROP(A1#,-4). But you can not 
remove the top row and bottom row without nesting two DROP functions. 

The downside to CHOOSEROWS and CHOOSECOLS is that you can select only rows or only columns. But 
you can select any number of either: =CHOOSEROWS(A1#,1,2,5,6,9,10,11).

#83 reshaping an array to a vector and Back
You can unwind a rectangular range or array into a single column using TOCOL or a single row using 
TOROW.  Each function can take an array or a range as the first argument. The optional Ignore argument 
can have Excel skip empty cells. The optional Scan_By_Column argument will control if values are read 
row-by-row (the default) or column-by-column.

Here is a comparison of three different ways to run TOCOL. The original array is in A2:B6 with an empty cell 
in B6.

If you simply ask for =TOCOL(A2:B6) as shown in D2 below, you will see that the empty cell shows up as a 
zero in D11. To prevent empty cells from showing up in the results, add a second argument of 1.  Notice 
how the results in E2 do not include the zero for the empty cell. 

Both of the results in D & E use the default of reading the data by rows. You start with History of A2, then 
Math from B2, then Comp. from A3, and so on. You can change the order of the results by including TRUE 
as the optional third argument as shown in F2. In this version of TOCOL, the results are History, Comp, 
Lunch, Physics, Shop from column A and Math, Econ, Lunch, Tech from column B.

What if you did not want Lunch in the results? Since Lunch is in the 3rd row of both columns, you could 
use =TOCOL(CHOOSEROWS(A2:B6,1,2,4,5)).

Once you have your results in a single column or row, you might like to rearrange it to a rectangular range. 
This can be done with WRAPCOLS or WRAPROWS. For a detailed walk-through, see the topic about shuf-
fling a deck of cards on the next page.
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#84 Getting the uNIQuE of a rectangular range
Getting all of the unique values from a rectangular range was previously very complicated. Today, using a 
combination of UNIQUE and TOCOL, it is easy. The figure below adds in a SORT function to make sure the 
results are sorted alphabetically.

#85 Shuffling and Dealing a Deck of Cards
Take a look at the figure below. The 13 playing card values are in A5:A17. The four playing card suits are in 
B4:E4. A simple =A5:A17&B4:E4 in cell B5 generates a 13-row by 4-column array of all 52 playing cards.

To rearrange those into a single column, use =TOCOL(B5#) in cell G5.

To sort the 52 cards randomly, =SORTBY(G5#,RANDARRAY(52)). Every time that the worksheet recalculates, 
you will get a new shuffle of the deck of cards.

Tip: Arrays are still bad at copying formatting. The red for diamonds and hearts is achieved 
through conditional formatting rules applied to the entire worksheet.



182 MrExcel 2022: BOOSTING EXCEL

Now that you have the 52 cards arranged in a random sequence, you can deal them using WRAPCOLS or 
WRAPROWS. In the figure below, cards are dealt to 6 players. Avoid an #N/A error for the last two cards by 
using "" for Pad_With argument.

Typically, in a card game, you would be dealing one card to each player and then a second card to each 
player. If you would want to deal the first 8 cards into a single pile, use WRAPROWS as shown above.

The next figure shows some interesting alternatives. The formula shown in L22 uses TOCOL, SORTBY, 
RANDARRAY and WRAPCOLS to perform the shuffle and deal in a single formula.

The formula shown in L24 and the results in L25:P28 use TAKE to make sure that each player only receives 
5 cards.
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#86 use a2:INDEX() as a Non-volatile OFFSET
There is a flexible function called OFFSET. It can point to a different-sized range that is calculated on-the-
fly. In the image below, if someone changes the # Qtrs dropdown in H1 from 3 to 4, the fourth argument of 
OFFSET will make sure that the range expands to include four columns.

Spreadsheet gurus hate OFFSET because it is a volatile function. If you go to a completely unrelated cell 
and enter a number, all of the OFFSET functions will calculate—even if that cell has nothing to do with H1 
or B2. Most of the time, Excel is very careful to only spend time calculating the cells that need to calculate. 
But once you introduce OFFSET, all of the OFFSET cells, plus everything downline from the OFFSET, starts 
calculating after every change in the worksheet.

In the formula below, there is a colon before the INDEX function. Normally, the INDEX function shown 
below would return the 1403 from cell D2. But when you put a colon on either side of the INDEX function, 
it starts returning the cell address D2 instead of the contents of D2. It is wild that this works. 

Why does this matter? INDEX is not volatile. You get all of the flexible goodness of OFFSET without the 
time-sucking recalculations over and over.
I first learned this tip from Dan Mayoh at Fintega. Thanks to Access Analytic for suggesting this feature.

#87 Subscribe to Microsoft 365 for Monthly Features
From 1997 to 2013, there was a predictable release cycle for Microsoft Office. A new version would come 
out every three years. Your IT department would wait one year for the Service Pack to come out and then 
would consider upgrading.

All of the Office apps had to ship on the same day. This created pressure on each individual team to have 
their features ready in time. No one wanted to be the person who caused the Office release date to slip. 
Some great Excel features got ripped out of the product because the team wasn‘t sure they could com-
plete those features in time. If a feature did not make it into an Excel version, there would not be another 
opportunity for three years for that feature to make it into the product.

Today, the paradigm has changed. The Excel team has an opportunity to release a new feature to Microsoft 
365 on any given Tuesday. If a feature is not quite done this Tuesday, it only slips seven days, until the next 
Tuesday. There is no pressure to have 15 new features all ready on a certain day.
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The net result is that Microsoft 365 subscribers are getting access to many more features. While it can be 
annoying that this book is obsolete the Tuesday after it prints, I appreciate getting great new features 
every month instead of every three years.

Your IT department still has a measure of control over when you get the features. There are several chan-
nels for distributing features:

 ● People who are not doing mission-critical work and want to test the latest bits can sign up for the 
Insider  (Beta) channel. You run the risk of having bugs arrive on any given Tuesday.

 ● People who like to see new features but who don‘t want less bugs can sign up for the Monthly 
Channel (Targeted) channel. 

 ● Your IT department is likely going to have you on the semi-annual channel. These people get features 
every 26 weeks. The features have been tested by millions of other customers and are safe to use.

So a feature can be used by all Microsoft 365 customers about 6 months after it is released. This beats 
the 3-year wait for a new version of Office and then the 12-month wait for your IT department to see the 
Service Pack and know it is safe to install.

Caution: Microsoft still sells a perpetual version of Office 2021. You pay once and never pay 
a monthly fee. But you will not get the new features. I feel bad for the people who paid $400 
for Office 2021 but are not getting all of the new features such as Dynamic Arrays, Data Types, 
Collaboration or Ask a Question About Your Data.

Note: Microsoft 365 does not mean you are running Office in the cloud. When you subscribe to 
Microsoft 365, you agree to pay a monthly or annual fee, and you are using the real version of 
Office for Windows. As part of the bundle, you can also run Office on an iPad, a Mac, Android, or in 
a web browser. For most people, those are not where most work gets done.

Here are some of the features that debuted for Microsoft 365 subscribers:

 ● Co-authoring: Your whole team can now be editing the same Excel workbook at the same time.

 ● Excel will not nag you twice when you want to save as CSV. 

 ● XLOOKUP with 12 benefits over VLOOKUP or INDEX/MATCH.

 ● A new Superscript and Subscript icon have been added.

 ● Improved function autocomplete: If you start to type =LOOKUP, the tooltip will offer VLOOKUP, 
XLOOKUP,  HLOOKUP, and LOOKUP.

 ● Power Query has new features, including the ability for Split to Rows. This will split every delimiter to a 
new row. It also adds Column by Example, similar to Flash FIll. And a new Fuzzy Match merge feature.

 ● Dynamic Arrays and new functions like SORT, SORTBY, UNIQUE, and FILTER.

 ● You can now store formula logic in LAMBDA functions or re-use formula logic in LET.

 ● LAMBDA helper functions like REDUCE, SCAN, MAP.

 ● Picture transparency is now controlled with a slider on the Picture Tools tab.

 ● Artificial Intelligence with Data Ideas.

 ● Ask Me a Question About Your Data.

 ● Unhide Multiple Sheets

By the time you read this book, several more new features will have been added.
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#88 performance Improvements for Microsoft 365
Subscribers to Microsoft 365 should be noticing faster calculation times with updates from 2020-2022. 

SuMIFS improvements: 

Say you’re using SUMIFS to get department and region totals for 150 departments. Each of the 450 formu-
las are looking at data stored in cells A2:G90001. With the new update, as Excel is calculating the total for 
the first department, it’s efficiently building an index in memory of where each department is located. The 
first SUMIFS in cell J2 might take slightly longer as the indices are built, but the remaining 449 SUMIFS will 
calculate in a fraction of the time. With a large set of formulas, the calculation times should fall to about 
one-third the original calculation time.

Other improvements introduced during 2020-2022:

 ● Similar improvements are implemented for SUMIF, COUNTIF, AVERAGEIF, SUMIFS, COUNTIFS, 
AVERAGEIFS, MAXIFS, and MINIFS. Note that you’ll only notice the improvement if you have multiple 
formulas pointing to the same database of values.

 ● real-Time Data: Some people use Excel to connect to the RealTimeData (RTD) function for getting 
real-time data from the stock market. In the past, support for RTD was only able to use a single core 
of your computer’s processor. The Excel team improved the underlying memory structures, removed 
bottlenecks, and made the process able to run on multiple cores. In an example in their demo, speed 
increased from 2,000 cells retrieved per minute to 23,000 cells retrieved per minute.

 ● alt-key Shortcuts: If you press and release the Alt key, there was a slight delay while Excel displayed 
the tooltips. Expert Excel users aren’t looking at the ribbon—they already know the keys to press. Excel 
now evaluates the shortcut key presses even before the tooltips appear.

 ● Convert to Number: If you had a large range of text numbers and used the Convert to Number com-
mand, Excel would sometimes appear to hang as it recalculated all formulas after each number. This 
has been eliminated.

 ● Macro speed tip: If you have the VBA Editor open and run a macro, the title bar in VBA will update 
to show the word “Running.” Imagine that a function is operating on 1,000 cells. For each cell, Excel is 
changing the VBA title bar to display—and then not display—“Running.” Closing the VBA Editor when 
running UDFs ensures Excel doesn’t have the overhead of updating the VBA title bar.

 ● paste from Clipboard: If you’re pasting large sections of HTML or images from outside Excel, there 
were bottlenecks in getting that data into Excel. Microsoft made improvements to the underlying 
streaming data structure to make that happen faster.

 ● Inserting Columns in Filtered Data: This was a problem particularly when the hidden rows contained 
thick borders. Calculating border thickness is a time-consuming process, and there’s no need to do it 
for the hidden rows in the data.

 ● Deleting ranges that Contain Merged Cells: Excel was iterating through the rows multiple times 
before performing the delete. This has been improved.

 ● Check for Errors: In the past, using Check for Errors on 10,000 rows of data with some empty cells 
would take minutes or hours. Most people assumed that Excel had frozen and would kill the task. The 
command now builds an efficient data structure and should return the results in seconds instead of 
minutes.

 ● Faster International Text Comparisons: The code to perform comparisons of text that contain inter-
national characters has been improved.



186 MrExcel 2022: BOOSTING EXCEL

#89 unhide Multiple worksheets
This is a great improvement introduced near the end of 2020 for Microsoft 365 subscribers. In the past, you 
could hide multiple worksheets at once, but you had to unhide them one at a time. With the change, you 
right-click any sheet tab and choose Unhide….

Excel now lets you multi-select which worksheets to unhide. The first time you use the feature, a guide ap-
pears telling you how to multi-select.

#90 write your Data with the action pen
The new Action Pen on the Draw tab of the Ribbon lets you hand-write data in a cell. After a moment, 
Excel converts the drawing to text or numbers as if you had typed the characters.
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#91 Many Task panes Now Collapse into a Tab Strip

There are several features in Excel that open a task 
pane on the right side of Excel. Sometimes, you 
would end up with 2, 3, or even 4 task panes open 
and it would cover your entire screen.

In February 2020, Microsoft 365 started collapsing 
task panes when more than 1 is open. A tab strip on 
the right side holds all the open task panes.

In the figure here, five task panes are available. The 
fourth is highlighted in grey and is the currently open 
PivotTable Fields task pane. 

Click the icon to collapse the currently open task pane.

Note: It is possible to collapse and open the task panes using the 
right arrow key to collapse and the left arrow key to open. In this 
state, you can move up and down the task panes using the arrow 
keys. However, it is also possible for focus to get stuck in the task pane 
strip and you can't use your arrows to navigate around the grid. In 
this case, press the F6 key three times to return focus to the grid.

Tip: What if you like having two task panes open at the same time? Grab the title of a task pane and 
drop it on the grid. Or grab the title of a task pane and drag it off the left side of the worksheet. 
This will dock the task pane on the left. Anything docked on the left will never collapse. You could 
even dock four task panes on the left if you needed to.

#92 How to provide usable Feedback to the Excel Team
If you encounter a bug in Excel, here is the best way to get it fixed quickly. On the Help tab in the Ribbon, 
choose the Feedback icon. This opens a Feedback pane on the right side. Follow all of these steps:

1. Choose "I Don't Like Something". No one reads the "I Like Something" submissions.

2. Type a description of the problem.

3. Choose "Attach Logs to Help Troubleshoot"

4. Choose "Include Screenshot"

5. Choose "You can contact me about this feedback" and provide an e-mail address.
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If you don't do all five of these, no one reads your feedback. But if you complete all five steps, a live person 
from the Excel team reads it and often a fix is sent out in a week.

How can you report a crash? Re-open Excel. Immediately send Feedback. In step 2, type "Excel crashed on 
the last session". The logs from step 3 will help pinpoint the problem.

Caution: In 2021, Microsoft gave your I.T. department the ability to prevent you from includ-
ing your e-mail in feedback. This is an unfortunate decision, as it prevents Microsoft from acting 
on any feedback or bugs from your entire organization. Maybe you can show this topic to your 
Microsoft 365 Admin and they can alter the settings to allow you to report a bug so it can get 
fixed.

#93 Date Tricks in Excel
Column C in the figure below shows several cool date formulas. Given a date in B1, you can use EOMONTH 
to get to the end or start of the month. You can break out the YEAR, MONTH, DAY and then put it back to-
gether using the DATE function. 

You can use the TEXT function to isolate the weekday name or month name. The WORKDAY and 
NETWORKDAYS in row 9 and 13 are similar to "#54 Calculate Nonstandard Work Weeks" on page 133.

#94 use the LET Function to re-use variables in a Formula
The LET function debuted during 2020 for Microsoft 365 Subscribers. There are all sorts of calculations in 
Excel that can benefit from re-using an intermediate calculation.

Note: The actual problem presented in this topic is not important. This is just a problem that is rep-
resentative of the kind of problem that LET will make easier.

Someone e-mailed me and needed a formula to find the next-to-last word in a series of phrases stored in 
column A. Each cell might have anywhere from 5 to 10 words. I know that I can solve this type of problem, 
but I know the solution will have a lot of parts. So – my strategy is to insert a bunch of columns and work it 
out, piece by piece.

The solution requires me to count the words by taking the LEN of the phrase and then the LEN of the 
phrase with the spaces removed. Once you know the number of words, you can change the correct space 
to a ^ and then use FIND to isolate the location of the caret. Once you use MID to get the text after the 
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caret, you find the space between the last and next-to-last word and use LEFT. While each step is simple, 
knowing how to put all of those together is tricky.

In the figure below, I have built the solution using five formulas. It is working and I could likely explain it to 
anyone who uses Excel 10 hours a week.

However, I’ve also learned that some people just want the formula to solve this, and they don’t want to 
know how it works. Those people want the whole formula to be in a single cell. 

At this point, I often try to merge everything into a single formula. The formula in cell F4 refers to the for-
mula in E4 twice. Select E4. Using the mouse in the Formula Bar, carefully select everything after the equals 
sign and then copy it. Edit the original formula in F4. Select the characters “E4” in the formula and use 
CTRL+V to paste to replace “E4” with the actual formula from E4. Continue in this fashion until you have a 
single formula.

The formula keeps growing, and eventually the B4 formula of TRIM(A4) appears a total of 12 times in the 
final formula. Excel has to perform the TRIM operation 12 times for each cell. Explaining this formula to 
someone else will be difficult, if not impossible.

=LEFT(MID(SUBSTITUTE(TRIM(A4)," ","^",LEN(TRIM(A4))-LEN(SUBSTITUTE(TRIM(A4)," ",""))-1), 
FIND("^",SUBSTITUTE(TRIM(A4)," ","^",LEN(TRIM(A4))-LEN(SUBSTITUTE(TRIM(A4)," ",""))-
1))+1,30),FIND(" ",MID(SUBSTITUTE(TRIM(A4)," ","^",LEN(TRIM(A4))-LEN(SUBSTITUTE(TRIM(A4), 
" ",""))-1),FIND("^",SUBSTITUTE(TRIM(A4)," ","^",LEN(TRIM(A4))-LEN(SUBSTITUTE(TRIM(A4), 
" ",""))-1))+1,30))-1)

This is where the LET function helps. The LET function starts out with pairs of arguments where you give 
a variable name and the definition for that variable. The calculation for the second variable can re-use the 
logic assigned to the first variable. The final argument in the function is the calculation returned to the cell.

You can plan out your LET function as shown here:
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And then wrap that logic in the LET function:

The best practice for LET is to use Alt+Enter to go to a new line in the formula bar after each pair of argu-
ments. This makes the formula easier to read.

The LET function will simplify an entire class of problems where you need to repeatedly refer to an earlier 
component later in the formula.

#95 Store Complex Formula Logic in LaMBDa function
Excel has a great formula language with hundreds of built-in calculations, but it doesn’t have functions for 
every possible calculation. A new research project from Microsoft’s Calc Intelligence team in England will 
allow you to create your own functions.

The new function, LAMBDA, is available for any Microsoft 365 subscribers who opt into the Office Insiders 
program’s Beta Channel. It’s named after Princeton University mathematician Alonzo Church, who invent-
ed lambda calculus in 1936. Church was the doctoral advisor of Alan Turing, the famous mathematician 
who proposed the Turing machine to perform calculations long before modern computers were invented. 

Imagine performing a complex calculation and passing variables to it. The variable names and logic are 
stored in the LAMBDA function and – after testing in the worksheet – you create a Name and insert the 
logic into name manager.

In the beta versions of LAMBDA, you were required to add LAMBDA functions to the Name Manager in 
Excel. This tiny dialog box with a single-row text box for entering the formula was not a fun place to try to 
edit your formulas.

In early 2021, Microsoft Research released an Advanced Formula Environment add-in that makes LAMBDA 
easier to use. Here is how to install the Advanced Formula Editor.

1. From the Insert tab in Excel, go to Add-ins, Get Add-Ins. The Office Add-Ins dialog opens.

2. In the Search box, type Advanced Formula Environment and press Enter. The top result should be 
"Advanced formula environment, a Microsoft Garage project".

3. Click the Add button. Click the Continue button. The Advanced Formula Environment will appear on the 
right side of the Home tab.
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There are three main buttons in the add-in. Click the + icon to define a new LAMBDA. Click the Sync button 
to save your LAMBDAs to the Name Manager. Click the Import button to import from a GitHub Gist URL.

 Let’s start with a simple example. In a right triangle, the length of the hypotenuse is the square 
root of A squared plus B squared. To calculate the hypotenuse, you would use a formula such as 
=LAMBDA(A,B,SQRT(A^2+B^2)).

In this formula, the first two arguments are variables to hold values that will be passed to the function. 
The final argument is the logic to perform the calculation. You aren’t limited to just two input variables. 
Everything up to the last argument is considered to be a variable. The final argument always holds the cal-
culation logic.

In the Advanced Formula Editor, click the + icon and choose Function. A box will appear where you name 
your LAMBDA. A second box lets you edit your LAMBDA.

Give this a name of HYP. Type the formula  =LAMBDA(a, b, SQRT(a^2 + b^2)).  Click the Add button to add 
the formula definition. Caution: The formula is not yet available to use. You must first click the Sync button 
to Sync Names With The Excel Name Manager.

After you sync the new LAMBDA to the Name Manager, you can use the formula in the Excel grid. Excel 
offers intellisense, just like any other Excel function.

Here is the formula in the AFE panel:
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The AFE panel is really just a conduit for getting the formula into the Name Manager:

Here are the formulas working in the grid. Notice that the intellisense even shows that the function is ex-
pecting two arguments, named a & b.

Before the AFE was available, you would sometimes want to edit and test the formula in the grid before 
trying to add it to the Name Manager. You could type the formula in the grid, followed by the argument 
values in parentheses. This still works.  =LAMBDA(A,B,SQRT(A^2+B^2))(3,4) would return the answer of 5.
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If you need to change the logic in the future, edit the formula in the Name Manager or the Advanced 
Formula Environment.

Bonus: Importing LaMBDas from GitHub 
The AFE lets you import LAMBDA from a GitHub Gist (pronouced jist). Chris Gross, from the Excel team, 
made this Gist available on the day the AFE was released. Import it and you will instantly have several 
LAMBDAs available in the workbook.

1. In the Advanced Formula Environment, click the Import icon.

2. A box appears where you can type a URL. Enter the following: https://gist.github.com/chgrossMSFT/
d172fd552cf6893bcdc7942223cb0e55

3. Optionally, you can add these LAMBDAs to a Name Space. If you use a name space of MSFT, then all 
of the LAMBDAs imported will start with MSFT. This might help you to keep your LAMBDA formulas 
categorized.

4. After a successful import, you can browse the new LAMBDAs. They won't be available to use until you 
press the Sync button to add them to the Name Manager.
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By using a Name Space of MSFT, all of these functions will appear in the Formula AutoComplete when you 
type =MSFT.

Here is the MSFT.TEXTREVERSE function working in the grid.

Transferring LaMBDas Between workbooks

A LAMBDA is stored in the Name Manager in the workbook. There is a "bug" in Excel that actually comes 
in very handy here. Let's say that you have a workbook with many LAMBDAs defined. Insert a new blank 
worksheet in that workbook. Copy the worksheet to another Excel file. All of the Names defined in the first 
workbook will be copied to the new workbook. This is usually pretty annoying. But in this, case it is a per-
fect way to  transfer LAMBDAs from one workbook to another.

LaMBDas work in More Endpoints than vBa.

In the past, people might have used VBA to write their own user-defined functions. These were fine when 
everyone was using a PC or a Mac. But slowly, the small percentage of people using Excel on an iPad or 
Android or Excel Online is growing, and those versions of Excel can’t support VBA. LAMBDA functions, 
however, can be used with Excel online or a mobile device.

Charles williams and the LaMBDa Explorer

MVP Charles Williams is working on an amazing free add-in called the LAMBDA EXPLORER.  It allows you to 
watch your Lambda functions to calculate in slow motion. Download the beta from  
http://www.decisionmodels.com/FastExcelLambdaExplorer.htm. Recursive Lambdas are fully evaluated 
and can be expanded to the next recursion level: the arguments show at each level the progression of the 
recursion.
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using LaMBDa with Data Types

The team that developed LAMBDA is the same one that created data types and the LET function. That 
means LAMBDA was designed to work perfectly with Data Types. This enables more complex uses of 
LAMBDA.

Say that you have city pairs in column A and B. You convert these to Geography data types using the Data 
Type gallery on the Data tab of the ribbon. The Map icons mean that each cell contains many fields about 
the city. Two of those fields are Latitude and Longitude. 

There’s a complicated formula for calculating the distance between two cities using their respec-
tive latitude and longitude. You start out assuming the radius of the Earth is 3,959 miles. The formula 
uses functions for arcsine and cosine  and is generally one that most people would never remember: 
=(3959*2)*ASIN(SQRT(0.5-COS((B2.Latitude-A2.Latitude)*PI()/180)/2+COS(A2.
Latitude*PI()/180)*COS(B2.Latitude*PI()/180)*(1-COS((B2.Longitude-A2.
Longitude)*PI()/180))/2)).

If you wrap that formula in the LAMBDA function as =LAMBDA(From,To,(3959*2)*ASIN(SQRT(0.5-COS((To.
Latitude-From.Latitude)*PI()/180)/2+COS(From.Latitude*PI()/180)*COS(To.Latitude*PI()/180)*(1-COS((To.
Longitude-From.Longitude)*PI()/180))/2))) and then store it in the Name Manager with an easy name like 
MILES, then you can calculate the distance between two cities using a formula as simple as =MILES(A2,B2).

To move that formula from one workbook to another, you simply copy any worksheet from the original 
workbook to a new workbook, and the names will travel along. With this portability, it’s possible to envi-
sion a company’s accounting department that has a library of custom LAMBDA functions that move from 
workbook to workbook.

Note: Mathematicians are celebrating that the LAMBDA function makes Excel “Turing Complete” 
and can solve any mathematical problem.

Bonus Tip: perform a Loop with a recursive LaMBDa
A LAMBDA function can also call other LAMBDA functions, and it can recursively call itself. This lets you 
create a LAMBDA function that keeps calling itself until the task is complete.
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These are likely the most complicated topic in the whole book. Let me demonstrate how one LAMBDA can 
solve a problem that would be pretty difficult with regular Excel functions.

I frequently write articles for MrExcel.com. My full stack developer is Suat Ozgur. When Suat is converting 
my article to a web page, he puts the title in the URL to help with Search Engine Optimization. Converting 
a title from "Why I say 'Bazinga!' - my #1 Reason for Using =INDEX(MATCH())!!", to a URL requires certain 
rules. The only characters that are used in our URLs are the lower case letters a through z and the digits 0 
through 9 and a dash. As you scan through any article title, there are 37 characters that can be left alone. 
Another 26 upper case characters need to be converted to lower case. That leaves 192 other characters 
that have to be replaced with an dash. (Technically, Suat thinks he only has to check the 31 illegal charac-
ters that are on a U.S. keyboard. Because he thinks I am too lazy to type a =CHAR(149) to get a bullet point. 
But Suat doesn't realize that I can press the Alt key and 7 on the number keypad to get bullet points. •••••• 
So he better check all 192 potential bad characters because he never knows when I might surprise him.)

Getting rid of bad characters with SUBSTITUTE would take a long time. To be really safe, you would have 
to use one SUBSTITUTE function for each of the 192 characters. Since you can not nest more than 64 func-
tions, you would have to break the formula into four columns. Even if you tried to only handle the 31 ille-
gal characters that are on a U.S. keyboard, the problem would be overwhelming.

The process of converting the above phrase to "why-i-say-bazinga-my-1-reason-for-using-index-match-" is 
called turning the title into a slug. The people who deal with web pages have made word this into a verb, 
saying that you have to "slugify" next month's article titles.

If you were going to build this in regular Excel formulas, the logic might go like this:

1. Start with character position 1. Store this in a cell column that we will call Index.

2. Convert that character to lowercase using LOWER()

3. See what ASCII code that letter is.

4. If the code for that letter between 48-57 or between 97 to 122? If it is, then use that character. If it is not, 
then use a hyphen.

5. Take the characters to the left of index, the new character from step 4, and the characters to the right of 
index. This is the new phrase.

6. Add 1 to the Index.

7. Check to see if the new Index is greater than the number of characters in the title. If it is, then do a final 
SUBSTITUTE to replace any instances of a double -- with a single hypen. You are done. Stop calculating.

8. But if the Index is not greater than the LEN, go to step 2, this time processing the 2nd character.

It is a crazy worksheet. I managed to convert my article title using just 630 formulas in A3:J65. Here is a tiny 
fraction of the worksheet.

At the end of the worksheet, the index is finally greater than the LEN, and you finally get an answer in cell 
J65.



STOrE COMpLEX FOrMuLa LOGIC IN LaMBDa FuNCTION 197 

4 

I want us to agree that the above method is pretty ugly and not really reasonable. I don't want to 
have to explain the formulas that I used above, since we are abandoning that method. However, in case 
you really want to see the formulas, here they are:

All of the above is ugly. 630 formulas. If the phrase gets longer, you will need more formulas.

It can all be replaced with one LAMBDA function stored in a name called SLUGIFY.

As the author of this book, I am hoping you ignored everything above this. But I really hope you try and 
understand everything that follows. This is the part that shows you how recursive LAMBDAs work.

Start the function with =LAMBDA and name the two arguments that will be passed to it. The first argu-
ment is a phrase. The second argument will always be a 1 and will be stored in a variable called "ndx" be-
cause this sounds like "index" but is 40% shorter.

Tip: For the VBA programmers reading this, "ndx" is our loop counter. Unlike VBA where you could 
just create a variable on the fly, for LAMBDA, we have to send a 1 in as an argument.  Trust me - it is 
a small compromise.
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Start off with an IF function that checks to see if we are done. Is the ndx beyond the end of the phrase?.

The part in the box below is the Value_if_True part of the IF statement. If we aren't done with Slugify, then 
call Slugify again, but make the Index be 1 more than the last time.  The inner logic is described after the 
figure.

These six lines are the part of the formula that build the PHRASE for the next call to Slugify. If you use Excel 
frequently, all of the functions in this part should feel familiar. Use LOWER and MID to isolate this charac-
ter. Get the CODE of that character. If the CODE is a letter or digit, then use it, otherwise use a hyphen. The 
phrase for the next time is going to be the left part, the newly fixed character, and the right part.

Deep inside the LAMBDA is the one line that really does the work. If we have a letter or a digit, keep it. If it 
is one of the other 192 bad characters, then use a hyphen.
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The first time you call Slugify, it will be fixing the first character. The Excel calculation engine will then call 
Slugify to fix the 2nd character. This keeps going. Eventually, Excel calls Slugify to fix the 64th character, 
but that's bad because there are only 63 characters in this phrase. So, when ndx is greater than the LEN of 
the phrase, it is time to finally return the result. 

The SUBSTITUTE / TRIM / SUBSTITUTE logic replaces any multiple hyphens with a single hyphen.

Note that up to this point, I've been building the LAMBDA in notepad or in a textbox in Excel.

So, you've written your LAMBDA. You have to give it a name so you can call it. On the Formulas tab, click 
New Name. Name it Slugify. Paste the formula from the textbox, spaces and all into the Refers To box.

Here is the payoff... you now have a function called SLUGIFY that you can use repeatedly.

The rebel in me (and perhaps in you) wonders what would happen if I changed the 1 in the second argu-
ment to 5. What do I get with =Slugify(A2,5)? I tried it. It sort of works. It just does not fix any of the first 4 
characters. 
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Before LAMBDA, I would have created this as a VBA user-defined function. That requires you to understand 
VBA. And it won't ever work in Excel Online. Now, with LAMBDA, you can simply use familiar Excel logic to 
build a function that loops through all of the characters in a cell.

Bonus Tip: Branching in a LaMBDa
On an earlier version of the previous LAMBDA, I was getting multiple hyphens in the result. I wondered if 
you could have a second loop to clean those. Could you do the first task - replacing illegal characters with 
dash, and then have a second task of looping to look for consecutive hyphens.

Later, I realized that replacing - with space, using TRIM, and then replacing space with hyphen solved the 
problem without the need for a second loop. However, this formula assigned to the name Slugify.Plus is an 
example of branching, so I am leaving it in.

The following formula offers two routines. The Branch parameter controls which part of the code is used.

Note that the ndx argument is not used in Branch 2. But since LAMBDA arguments are not optional, you 
have to put something - I chose 0 - when calling branch 2.
Thanks to Suat Ozgur and Richard Simpson for help with Recursion and Branching.

Bonus Tip: using LaMBDa to return a picture
The Microsoft Research team in Cambridge and their Calc Intelligence project had a hand in dynamic 
arrays, data types, LET and LAMBDA. All of these work with LAMBDA, which means that LAMBDA can 
return arrays, query data types, and even return pictures.

In this figure, B2 & B3 allow you to choose movies. Note the icon to the left of the movie name indicating 
that the cells contain data types.
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The InBothCasts function gets a list of a people in the cast of the first movie and stores it in an array 
variable called CastOne. The people from the second movie are stored in a second array variable called 
CastTwo. You then do a lookup of everyone in CastOne to see if they are in CastTwo. This happens with an 
XMATCH and an IFNA. At this point, you have an array in memory with a list of people in the first movie 
and a second array with 1's or 0's to indicate if they are in second movie. To isolate just the people in both 
movies, use a FILTER function. The results for these two movies are four actors. But it is not just the name of 
the actor - it is a data type about the actor. You can get the .Image or .Name for each actor. 

Notice that one formula is returning an array of four cells. 
The picture of Geoffrey Blake is not available and returns a 
#FIELD! error. 

The last few lines of the LAMBDA check for the error 
and insert the name of the actor when the photo is not 
available.

Geoffrey Blake has been in thirty film projects. For what-
ever reason, Wikipedia does not have a photo of him, and 
subsequently, Wolfram Alpha doesn't have a photo either.

It actually is a good example of how you can work around 
the #FIELD! error and show another field from the Data 
Type.
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#96 New LaMBDa Helper Functions
About a year after LAMBDA was introduced, Microsoft realized that we needed some helper functions.  
They gave us MAP, REDUCE, SCAN, MAKEARRAY, BYROW, BYCOL, and ISOMITTED.

 ● The MAP function runs a LAMBDA on each cell in an array or range and returns an identical-sized array 
or range. 

 ● The REDUCE function runs a LAMBDA on each cell in an array or range but uses an accumulator vari-
able to return one single answer.

 ● The SCAN function is sort of a combination of the two. It runs a LAMBDA on each cell of an array or 
range and returns an array the same size as the input range, showing the accumulator value after each 
step.

 ● The MAKEARRAY function will create an array of any size that you specify. You provide a LAMBDA to 
calculate each cell in the new array.

 ● The BYROW function forces a LAMBDA to calculate on each row in a range instead of the entire range.

 ● The BYCOL function forces a LAMBDA to calculate on each column in a range.

 ● LAMBDAs now support optional arguments. You can test if an optional argument was skipped using 
the new ISOMITTED function.

Evaluating a LaMBDa for Each Cell in a range or ranges

The MAP function will perform a LAMBDA calculation for each cell in a range. In the example below, you 
are passing two ranges to MAP. Because there are two incoming ranges, your LAMBDA needs two incom-
ing variables A and B. Notice that each of the incoming arrays are 5 rows by 3 columns and the result from 
MAP is also 5 rows by 3 columns.

Note that MAP can accept multiple incoming arrays. This is not true for REDUCE, discussed next.
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accumulating a LaMBDa for Each Cell using rEDuCE

With REDUCE, a LAMBDA will be evaluated for each cell in an incoming array or range. On each pass 
through the logic, the result of the LAMBDA can be added to an accumulator variable. At the end of the 
calculation, the formula returns the final value of the accumulator variable.

In this image, a REDUCE formula in B8 calculates the total bonus pool after several shifts. The initial value is 
set to 0. The incoming array is each cell in B2:D6. Inside the LAMBDA, the first two arguments are the vari-
able for the accumulator and for the cell from the incoming array. The last argument in the LAMBDA is the 
logic. Notice how the logic is adding the previous value of the accumulator to some calculation from this 
cell of the incoming range.
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Seeing the results From Each Step of rEDuCE with SCaN

The SCAN function performs the same calculation as REDUCE shown on the previous page. However, in-
stead of returning a single value, it shows each intermediate value along the way.

In the image below,  the Monday morning shift with sales of $1533 did not qualify for a bonus, so B8 
shows 0. The Monday afternoon shift qualified for a $100 bonus, so C8 shows the total bonus earned so 
far is $100. The Monday evening shift earned another $100 for the bonus pool, so the total bonus as of the 
end of Monday is $200 shown in D8. Notice how the $3100 in sales for Tuesday evening kicked the bonus 
pool up from $200 to $800, with the $800 being shown in D9.
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Evaluate a LaMBDa for Each row or Column

Say that you asked for the MAX(A5:D11). You would get one single number that was the largest value in 
the range. Sometimes, though, it would be good to have MAX run on a column-by-column basis or a row-
by-row basis and return the results as a spillable array. The BYCOL and BYROW functions allow you to do 
this.
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Make an array of any Size

The MAKEARRAY function lets you specify a number of rows and columns for the new array. The third argu-
ment is a LAMBDA function with three arguments. The first is the row number. The second is the column 
number. The third argument is the logic to apply to this cell of the array.

Thanks to Chris Gross and his team in Redmond for these great new LAMBDA helper functions.

#97 Find Largest value That Meets One or More Criteria
One of the new Microsoft 365 functions added in February 2016 is the MAXIFS function. This function, 
which is similar to SUMIFS, finds the largest value that meets one or more criteria: You can either hard-
code the criterion as in row 7 below or point to cells as in row 9. A similar MINIFS function finds the small-
est value that meets one or more criteria.

While most people have probably heard of MAX and MIN, but how do you find the second largest value? 
Use LARGE (rows 2 and 3) or SMALL (rows 4 and 5).
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What if you need to sum the top seven values that meet criteria? The orange box below shows how to 
solve with the new Dynamic Arrays. The green box is the Ctrl+Shift+Enter formula required previously.

Bonus Tip: Concatenate a range by using TEXTJOIN

My favorite new calculation function in Microsoft 
365 is TEXTJOIN. What if you needed to con-
catenate all of the names in A1:A10? The for-
mula =A1&A2&A3&A4&A5&A6&A7&A8&A9&A10 
would jam everyone together like 
AndyBobCaroleDaleEdFloGloriaHelenIkeJill. By using 
TEXTJOIN, you can specify a delimiter such as ", ". 
The second argument lets you specify if blank cells 
should be ignored. =TEXTJOIN(", ",True,A1:A10) would 
produce Andy, Bob, Carole, and so on.

Tip: TEXTJOIN works with arrays. The array 
formula shown in A7 uses a criterion to find 
only the people who answered Yes. Make 
sure to hold down Ctrl + Shift while pressing 
Enter to accept this formula. The alternate 
formula shown in A8 uses the Dynamic 
Array FILTER function and does not require 
Ctrl+Shift+Enter.
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#98 Text Before or after a Specific Delimiter
The new TEXTBEFORE and TEXTAFTER functions debuted on March 16, 2022 for Microsoft 365 Insiders. 
These functions isolate the text before or after a specific delimiter.

The function syntax requires some text and the delimiter. Optional arguments: instance_num for which  
delimiter, match_mode for case sensitive, match_end prevents an #N/A if the delimiter is not found. 
TEXTBEFORE("Cher"," ") returns #N/A. =TEXTBEFORE("Cher"," ",,,1) returns Cher. 

Note the third argument lets you specify which delimiter. If you use a negative number here, it counts from 
the right edge of the cell. The formula in F5 finds the last word in a phrase by using -1 as the value for N.

#99 Split Text into words using TEXTSpLIT
Many people had been asking for TEXTSPLIT. It was one of the most popular requests on the Excel 
UserVoice site. I often used a three-line User-Defined Function from Excel MVP Brad Yundt to create a func-
tion to split text into words.

The version of TEXTSPLIT that made it to Excel is better than the simple UDF. The row_delimiter argument 
lets you split text into new rows. In the figure below, TEXTSPLIT is used without a column delimiter and has 
a row delimiter of ". " in order to put each sentence into a new row.

The ignore_empty argument will help with text that has multiple spaces between words. In the figure 
below, cells B3, E3, F3, H3, I3:M3 are empty because the text in A1 has multiple spaces between words. 
While you could solve this with =TEXTSPLIT(TRIM(A1)," "), you can also tell TEXTSPLIT to ignore empty with 
=TEXTSPLIT(A1," ",,TRUE). While TRIM removes multiple interior spaces, it is not a suitable solution for other 
delimiters such as a period or comma.
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When you use TEXTSPLIT for both rows and columns, the function fills any empty cells with #N/A errors. 
Use a Pad_With of "" to prevent the #N/A. Formulas shown below calculate the frequency of all words in 
the text.

#100 Less CSv Nagging and Better autoComplete
Some people have to create CSV files hundreds of times per day. Excel used to hassle you when you saved 
a CSV file: “Some features in your workbook might be lost if you save as CSV.” People who have to export as 
CSV understand this and wanted Excel to stop hassling them. Starting in 2017, people with Microsoft 365 
are no longer hassled for choosing to save as CSV.

Another small change in Microsoft 365: If you type 
an equals sign and start to type a function name, 
the tooltip offers partial matching. Type LOOK, and 
you will see all three functions that contain the text 
LOOK.

#101 protect all Formula Cells
The use of worksheet protection in Excel is a little strange. Using the steps below, you can quickly protect 
just the formula cells in your worksheet.

It seems unusual, but all 16 billion cells on a worksheet start out with their Locked property set to True. You 
need to unlock all of the cells first:

1. Select all cells by using the icon above and to the left of cell A1.

2. Press Ctrl+1 (that is the number 1) to open the Format Cells dialog.

3. In the Format Cells dialog, go to the Protection tab. Uncheck Locked. Click OK.
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While all cells are still selected, select Home, Find & Select, Formulas.

At this point, only the formula cells are selected. Press Ctrl+1 again to display 
the Format Cells dialog. On the Protection tab, choose Locked to lock all of 
the formula cells.

Locking cells does nothing until you protect the worksheet. On 
the Review tab, choose Protect Sheet. In the Protect Sheet dialog, 
choose if you want people to be able to select your formula cells 
or not. 

Note: Scroll down a few rows in the Protect Sheet dialog 
box to reveal popular choices: Use AutoFilter and Use 
PivotTable & PivotChart. If you want allow people to in-
teract with these features, scroll down and select them.

Caution: Don’t bother putting in a password. Passwords 
are easily broken and easily lost. You will find yourself 
paying $39 to the Estonians who sell the Office pass-
word-cracking software.

#102 Back into an answer by using Goal Seek
Do you remember from “"#52 Discover New Functions by Using fx" on page 129, that I showed you how 
to calculate a loan payment by using the Insert Function dialog? Back in that example, the monthly loan 
payment was going to be $493.54. I did not mention it at the time, but my monthly budget for car pay-
ments is $425.

If you are about the same age as me and spent your summers watching TV, you might remember a crazy 
game show called The Price Is Right. Long before Drew Carey, the venerable Bob Barker would give away 
prizes using a variety of games. One that I recall is the Hi Lo game. Bob would give you the car if you could 
state the price of the car. You would guess. Bob would shout “Higher” or “Lower.” I think you had 20 seconds 
to narrow your guesses to the exact price.

A lot of times, I feel like those summers watching Bob Barker trained me to find answers in Excel. Have you 
ever found yourself plugging in successively higher and lower values into an input cell, hoping to arrive at 
a certain answer?
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Illustration: Chad Thomas

A tool that is built in to Excel does exactly this set of steps. Select the cell with the Payment formula. On 
the Data tab, in the Data Tools group, look for the What-If Analysis dropdown and choose Goal Seek….

The figure below shows how you can try to set the 
payment in B5 to $425 by changing cell B1

. .

Goal Seek finds the correct answer within a second.

Note that the formula in B5 stays intact. The only thing that changes is the input value typed in B1.

Also, with Goal Seek, you are free to experiment with changing other input cells. You can still get the $425 
loan payment and the $25,995 car if your banker will offer you a 71.3379-month loan!
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Thanks to Jon Wittwer of Vertex42.com and to @BizNetSoftware for suggesting this Goal Seek trick.

#103 Do 60 what-If analyses with a Sensitivity analysis
Goal Seek lets you find the set of inputs that lead to a particular result. Sometimes, you want to see many 
different results from various combinations of inputs. Provided that you have only two input cells to 
change, the Data Table feature will do a sensitivity analysis.

Using the loan payment example, say that you want to calculate the price for a variety of principal bal-
ances and for a variety of terms.

Make sure that the formula you want to model is in the top-left corner of a range. Put various values for 
one variable down the left column and various values for another variable across the top.

From the Data tab, select What-If Analysis, Data Table….

You have values along the top row of the input table. You want Excel to plug those values into a certain 
input cell. Specify that input cell for Row Input Cell. 
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You have values along the left column. You want those plugged into another input cell. Specify that cell for 
the Column Input Cell.

When you click OK, Excel repeats the formula in the top-left column for all combinations of the top row 
and left column. In the image below, you see 60 different loan payments, based on various inputs.

Note: I formatted the table results to have no decimals and used Home, Conditional Formatting, 
Color Scale to add the red/yellow/green shading.

Here is the great part: This table is “live.” If you change the input cells along the left column or top row, the 
values in the table recalculate. Below, the values along the left are focused on the $23K to $24K range.

Tip: You can build far more complex models and still use a data table. In my podcast 2141 "Will 
Asteroid Bennu Strike the Earth" on YouTube, I had a model with 100K NORM.INV and 100K 

https://youtu.be/ZuzNrKeI7r8
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VLOOKUP. Those 200,000 formulas were sent to a SUM function that summarized them. I used a 
Data Table to run those 200,001 formulas 100 times. The whole thing recalcs in about 11 seconds. 

Thanks to Owen W. Green for suggesting this tables technique.

Bonus Tip: Create a Data Table from a Blank Cell
Note: If you took a class on financial modeling in college, you likely used a textbook written by 
Professor Simon Benninga. He showed me this cool Excel trick.

Simon Benninga tells a story of a game called Penny Pitching. You and another student would each flip a 
penny. If you get one head and one tail, you win the penny. If the coins match (heads/heads or tails/tails), 
the other student gets the penny.

It is simple to model this game in Excel. If RAND()>.5, you win a penny. Otherwise, you lose a penny. Do 
that for 25 rows and chart the result. Press F9 to play 25 more rounds. 

This is known as a Random Walk Down Wall Street. Simon would point out a result like the one below, 
where a hot young stock analyst is on fire with a series of wins, but then a series of losses wipe out the 
gain. This is why they say that past results are not a guarantee of future returns.

Instead of 25 trials, extend your table in columns A and B to run 250 trials. This would be like playing one 
round of penny pitching every work day for a year. Build a row of statistics about that year, as shown 
below.

Create an odd data table where the blank cell in column F is the corner cell. Leave Row Input Cell blank. 
Specify any blank cell for Column Input Cell.
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When you create the table, Excel runs the 250 coin flips, once per row. This 30-row table models the entire 
career of a stock analyst. Every time you press F9, Excel runs the 250-row model for each of 30 years. You 
can watch an entire 30-year career be modeled with the simple press of F9.

Note: The download 
file for this chapter 
shows a few different 
ways to calculate the 
Win Streak and Loss 
Streak.

Thanks to Professor Simon Benninga for showing me this technique.

#104 Find Optimal Solutions with Solver
Excel was not the first spreadsheet program. Lotus 1-2-3 was not the first spreadsheet program. The first 
spreadsheet program was VisiCalc in 1979. Developed by Dan Bricklin and Bob Frankston, VisiCalc was 
published by Dan Fylstra. Today, Dan runs Frontline Systems. His company wrote the Solver used in Excel. 
Frontline Systems has also developed a whole suite of analytics software that works with Excel.

If you have Excel, you have Solver. It may not be enabled, but you have it. To enable Solver in Excel, press 
Alt+T followed by I. Add a checkmark next to Solver Add-in.

To successfully use Solver, you have to build a worksheet model that has three elements:

 ● There has to be a single Goal cell. This is a cell that you either want to minimize, maximize, or set to a 
particular value.

 ● There can be many input cells. This is one fundamental improvement over Goal Seek, which can deal 
with only one input cell.

 ● There can be constraints.

Your goal is to build the scheduling requirements for an amusement park. Each employee will work five 
straight days and then have two days off. There are seven different possible ways to schedule someone for 
five straight days and two off days. These are shown as text in A4:A10 in the figure below. The blue cells in 
B4:B10 are the input cells. This is where you specify how many people you have working each schedule.

The Goal cell is total Payroll/Week, shown in B17. This is straight math: Total People from B11 times $68 
salary per person per day. You will ask Solver to find a way to minimize the weekly payroll.

The red box shows values that will not change. This is how many people you need working the park 
on each day of the week. You need at least 30 people on the busy weekend days—but as few as 12 on 
Monday and Tuesday. The orange cells use SUMPRODUCT to calculate how many people will be scheduled 
each day, based on the inputs in the blue cells.
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The icons in row 15 indicate whether you need more people or fewer people or whether you have exactly 
the right number of people.

First, I tried to solve this problem without Solver. I went with 4 employees each day. That was great, but I 
did not have enough people on Sunday. So, I started increasing schedules to get more Sunday employees. 
I ended up with something that works: 38 employees and $2,584 of weekly payroll.

Of course, there is an easier way to solve this problem. Click the Solver icon on the Data tab. Tell Solver that 
you are trying to set the payroll in B17 to the minimum. The input cells are B4:B10. 

Constraints fall into obvious and not-so-obvious 
categories.

The first obvious constraint is that D12:J12 has to 
be >= D14:J14.

But, if you tried to run Solver now, you would get 
bizarre results with fractional numbers of people 
and possibly a negative number of people working 
certain schedules.

While it seems obvious to you that you can’t hire 
0.39 people, you need to add constraints to tell 
Solver that B4:B10 are >= 0 and that B4:B10 are 
integers.

Choose Simplex LP as the solving method and click Solve. In a few moments, Solver presents one optimal 
solution.
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Solver finds a way to cover the amusement park staffing by using 30 employees instead of 38. The savings 
per week is $544—or more than $7000 over the course of the summer.

Notice the five stars below Employees Needed in the figure above. The schedule that Solver proposed 
meets your exact needs for five of the seven days. The by-product is that you will have more employees on 
Wednesday and Thursday than you really need.

I can understand how Solver came up with this solution. You need a lot of people on Saturday, Sunday, 
and Friday. One way to get people there on those day is to give them Monday and Tuesday off. That is why 
Solver gave 18 people Monday and Tuesday off.

But just because Solver came up with an optimal solution does not mean that there are not other equally 
optimal solutions. 

When I was just guessing at the staffing, I didn’t really have a good strategy. 

Now that Solver has given me one of the optimal solutions, I can put on my logic hat. Having 28 college-
age employees on Wednesday and Thursday when you only need 15 or 18 employees is going to lead to 
trouble. There won’t be enough to do. Plus, with exactly the right head count on five days, you will have to 
call in someone for overtime if someone else calls in sick.

I trust Solver that I need to have 30 people to make this work. But I bet that I can rearrange those people to 
even out the schedule and provide a small buffer on other days.

For example, giving someone Wednesday and Thursday off also ensures that the person is at work 
Friday, Saturday, and Sunday. So, I manually move some workers from the Monday, Tuesday row to the 
Wednesday, Thursday row. I keep manually plugging in different combinations and come up with the 
solution shown below which has the same payroll expense as Solver but better intangibles. The overstaff 
situation now exists on four days instead of two. That means you can handle absences on Monday through 
Thursday without having to call in someone from their weekend. 
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Is it bad that I was able to come up with a better solution than Solver? No. The fact is that I would not have 
been able to get to this solution without using Solver. Once Solver gave me a model that minimized costs, 
I was able to use logic about intangibles to keep the same payroll.

If you need to solve problems that are more complex than Solver can handle, check out the premium Excel 
solvers available from Frontline Systems: mrx.cl/solver77.
Thanks to Dan Fylstra and Frontline Systems for this example. Walter Moore illustrated the XL roller coaster.

#105 Interpolate between a starting and ending number
Say that you need to fill in blank cells between a starting and ending number.

Select the range as shown above. On the Home tab, select Fill, Series.
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The Fill Series dialog appears, with the correct Step value already filled in.

Click OK to fill interpolate.

Thanks to Bob Umlas for this technique.
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#106 Improve your Macro recording
I loved the 1985 version of the Macro Recorder in Lotus 1-2-3. The code was hard to understand, but it 
worked. There are some defaults in the Excel Macro Recorder that cause misery for anyone trying to record 
macros. Here are three tips to make the macro experience possibly better.

Tip 1: Turn on relative reference for Every Macro

Say that you start in A2 and record a simple macro that moves to A4. I would call that macro 
MoveDownTwoCells. But if you run this macro while the cell pointer is in J10, the macro will move to cell 
A4. This is rarely what you want to have happen. But you can change the behavior of the macro recorder 
by selecting View, Macros, Use Relative References before you record the macro.

If you record the MoveDownTwoCells macro with this setting turned on, the macro will work from any cell. 

Caution: The setting stays turned on only until you close Excel. Tomorrow, you will have to turn it 
back on again.

Tip: What if you actually need to record a macro that always jumps to cell A4? Even with Relative 
References enabled, you could press F5 for Go To and use the Go To dialog to go to A4. The macro 
recorder will record code that will always jump to A4.

Tip 2: use Ctrl+Shift+arrow to move to the end of a data set.

Say that you want to add a total at the bottom of yesterday‘s invoice register. You want the total to appear 
in row 9 today, but tomorrow, it might need to be in row 17 or row 5, depending on how many rows of 
data you have.

Find a column that is reliably 100% filled. From the top of that column, record the action of pressing 
Ctrl+Shift+Down Arrow. Press the Down Arrow key one more time, and you will know you are in the row 
where the totals should be.
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Tip 3: Type =SuM(E$2:E8) instead of pressing the autoSum button

The macro recorder will not record the intent of AutoSum. When you press AutoSum, you will get a sum 
function that starts in the cell above and extends up to the first non-numeric cell. It does not matter if you 
have Relative References on or off; the macro recorder will hard-code that you want to sum the seven cells 
above the active cell.

Instead of using the AutoSum icon, type a SUM function with a single dollar sign before the first row 
number: =SUM(E$2:E8). Use that formula while recording the macro, and the macro will reliably sum from 
the cell above the active cell all the way up to row 2, as shown below.

 

Bonus Tip: use TypeScript to write Macros for Excel Online
VBA has been the macro language in Excel for decades. This was fine when "Excel" meant Excel running on 
a PC with Windows or a Mac. But today, there are versions of "Excel" running on an iPhone, on Android, or 
in an browser. Microsoft is never going to support VBA in those endpoints. 

In 2020, they debuted a new macro language called TypeScript. It was designed for those people running 
Excel in a browser. TypeScript will let you run macros on a PC or Excel Online. As the usage of Excel Online 
picks up, there will be more scenarios where you want your macros developed in TypeScript.

The new language is hard to find. You need to opt into a preview. This video will get you started:  
https://www.youtube.com/watch?v=bNbu5ANUeAw

#107 Clean Data with power Query
Power Query is built in to Windows versions of Microsoft 365, Excel 2016, Excel 2019, Excel 2021 and is 
available as a free download in Windows versions of Excel 2010 and Excel 2013. The tool is designed to ex-
tract, transform, and load data into Excel from a variety of sources. The best part: Power Query remembers 
your steps and will play them back when you want to refresh the data. This means you can clean data on 
Day 1 in 80% of the normal time, and you can clean data on Days 2 through 400 by simply clicking Refresh.

I say this about a lot of new Excel features, but this really is the best feature to hit Excel in 20 years.

I tell a story in my live seminars about how Power Query was invented as a crutch for SQL Server Analysis 
Services customers who were forced to use Excel in order to access Power Pivot. But Power Query kept get-
ting better, and every person using Excel should be taking the time to learn Power Query.

Get power Query

You may already have Power Query. It is in the Get & Transform group on the Data tab.
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Note: The "From Selection" icon above has been renamed to announce that you can use the re-
sults of an Array formula as the source for Power Query. Previously, this icon said "From Table/
Range". It was briefly changed to "From Sheet" and then changed to "From Selection".

But if you are in Excel 2010 or Excel 2013, go to the Internet and search for Download Power Query. Your 
Power Query commands will appear on a dedicated Power Query tab in the Ribbon.

Clean Data the First Time in power Query

To give you an example of some of the awesomeness of Power Query, say that you get the file shown 
below every day. Column A is not filled in. Quarters are going across instead of down the page.

To start, save that workbook to your hard drive. Put it in a predictable place with a name that you will use 
for that file every day.

In Excel, select Get Data, From File, From Workbook.

Browse to the workbook. In the Preview pane, click on Sheet1. Instead of clicking Load, click Transform 
Data. You now see the workbook in a slightly different grid—the Power Query grid.

Now you need to fix all the blank cells in column A. If you were to do this in the Excel user interface, the 
unwieldy command sequence is Home, Find & Select, Go To Special, Blanks, Equals, Up Arrow, Ctrl+Enter.
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In Power Query, select Transform, Fill, Down.

All of the null values are replaced with the value from above. With Power Query, it takes three clicks instead 
of seven.

Next problem: The quarters are going across instead of down. In Excel, you can fix this with a Multiple 
Consolidation Range pivot table. This requires 12 steps and 23+ clicks.

In Power Query select the two columns that are not quarters. Open the Unpivot Columns dropdown on 
the Transform tab and choose Unpivot Other Columns, as shown below.

Right-click on the newly created Attribute column and rename it Quarter instead of Attribute. Twenty-plus 
clicks in Excel becomes five clicks in Power Query.

Now, to be fair, not every cleaning step is shorter in Power Query than in Excel. Removing a column still 
means right-clicking a column and choosing Remove Column. But to be honest, the story here is not 
about the time savings on Day 1.

When you are done cleaning the data, click Close & Load as shown below. 
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Tip: If your data is more than 1,048,576 rows, you can use the Close & Load dropdown to load the 
data directly to the Power Pivot Data Model, which can accommodate 995 million rows if you have 
enough memory installed on the machine.

In a few seconds, your transformed data appears in Excel. Awesome.

But wait: power Query remembers all of your Steps

Look on the right side of the Power Query window. There is a list called Applied Steps. It is an instant audit 
trail of all of your steps. Click any gear icon to change your choices in that step and have the changes cas-
cade through the future steps. Click on any step for a view of how the data looked before that step.

The payoff: Clean Data Tomorrow with One Click

But again, the Power Query story is not about the time 
savings on Day 1. When you select the data returned by 
Power Query, a Queries & Connections panel appears on 
the right side of Excel, and on it is a Refresh button. (We 
need an Edit button here, but because there isn't one, 
you have to right-click the original query to view or make 
changes to the original query).

It is fun to clean data on Day 1. I love doing something new. But when my manager sees the resulting 
report and says “Beautiful. Can you do this every day?” I quickly grow to hate the tedium of cleaning the 
same data set every day.
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So, to demonstrate Day 400 of cleaning the data, I have completely 
changed the original file. New products, new customers, smaller 
numbers, more rows, as shown here. I save this new version of the 
file in the same path and with the same filename as the original file. 

If I open the query workbook and click Refresh, in a few seconds, 
Power Query reports 92 rows instead of 68 rows.

Cleaning the data on Day 2, Day 3, Day, 4,...Day 400,...Day Infinity now takes two clicks.

This one example only scratches the surface of Power Query. I have several more YouTube videos in a playl-
ist at http://mrx.cl/pqplaylist. You will learn about other features, such as these:

 ● Combining all Excel or CSV files from a folder into a single Excel grid

 ● Converting a cell with Apple;Banana;Cherry;Dill;Eggplant to five rows in Excel

 ● Doing a VLOOKUP to a lookup workbook as you are bringing data into Power Query

 ● Making a single query into a function that can be applied to every row in Excel

Bonus Tip: Tame the Sequence of refresh all
Say that you have a Power Query and then build a pivot table on the results. When you go to the Data Tab 
and click Refresh All, you need the Power Query refresh to complete before the pivot table refreshes. Excel 
MVP Celia Alves from SolveAndExcel.ca offers this important tip:  Right-click the query in the Queries & 
Connections pane and choose Properties. Make sure to uncheck the Enable Background Refresh setting. 
This forces the Power Query to finish refreshing before the pivot table is updated. Otherwise, you will have 
to click Refresh All twice in order to get the pivot table to update.

Bonus Tip: Data profiling in power Query
Some excellent data profiling options appeared in late 2019. They are not obvious to find, as they are on 
the View tab in Power Query. Use the Column Quality, Column Distribution, and Column Profile boxes.
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My favorite is the Column Profile. As you would expect, Weekday has 7 distinct values.

Choose one column and then Column Profile. You will see a window at the bottom with statistics and a fre-
quency distribution.

Column Quality shows if you have any empty or 
error cells in each column:

For a complete description of Power Query, check out Master Your Data by Ken Puls and Miguel Escobar. 

Thanks to Miguel Escobar, Rob Garcia, Mike Girvin, Ray Hauser, and Colin Michael for nominating Power Query.
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#108 use Fuzzy Match in power Query
There’s a research and development team at Microsoft known as Microsoft Labs. Almost 10 years ago, it 
invented a free Fuzzy Match add-in for Excel. A fuzzy matching algorithm looks for words that share a per-
centage of characters in common.

The figure below shows two data sets that need to be matched. Columns A and B contain the list of em-
ployees. Columns D and E contain the names of the employees who filled out a required form. You need to 
identify the people who haven’t yet returned the form. Unfortunately, a VLOOKUP or XLOOKUP won’t work 
since column A uses a “last name, first name” format while column D contains a nickname and last name. 
These two data sets can be matched using the Fuzzy Match tool that’s now built into Windows versions of 
Microsoft 365.

Columns G and H show a translation table that will be used by the fuzzy match to help match full first 
names with their nicknames.   The translation table requires two columns, labeled “From” and “To.” The 
fuzzy match will likely match Kris and Kristy because they share many letters. But it will need an entry in 
the translation table for Bill and William or Bob and Robert. 

Before you can perform the match, all three ranges of data have to be converted to a table by selecting 
each individual range and pressing Ctrl+T. Then Rrname each table: Select one cell in a table. Go to the 
Table Tools tab in the Ribbon and type a meaningful name such as “Census,” “Forms,” and “Nicknames.”
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You need to convert each of the three 
tables to a connection in Excel. From cell 
A1, select, Data, From Table/Range (as 
shown at the red arrow in Figure 1). Excel 
will open the Power Query Editor. The 
first icon on the Home tab says “Close and 
Load.” Click the drop-down menu below it 
and choose “Close and Load To…” to open 
the Import Data dialog box. 

Choose the fourth item, called Only Create 
Connection.

Repeat the process of creating a connection for the other two tables, starting in cell D1 and cell G1, respec-
tively. If you created all three connections correctly, you should see three queries listed as “Connection 
Only” in the Queries & Connections panel on the right side of the Excel window.
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Select a blank cell in your worksheet. From the Data 
tab, select Get Data, Combine Queries, Merge to 
open the Merge dialog. 

There are many subtle settings in this dialog that 
aren’t intuitive. The figure at right shows the 8 steps: 

1. From the top drop-down menu, select the Census 
table. 

2. In the small data preview, click on the heading(s) of 
the fields to be used for the matching. In this case, it’s 
the Employee Name heading. 

3. From the second drop-down menu, choose the 
name of the lookup table. In this case, Forms. 

4. In the data preview, click on the heading(s) of the 
fields to be used for matching, such as Name.

5. Choose a Join Kind of Left Outer. Choose the box 
for “Use Fuzzy Matching to Perform the Merge.” 

6. Several special settings are hidden behind the 
Fuzzy Matching Options drop-down menu. Click the 
triangle to reveal this section. 

7. Scroll to the bottom of the section and set 
Nicknames as the Transformation Table. 

8. Verify that the number of matches found is the 
same as the number of records in the Forms table.

Tip: If you become comfortable with fuzzy matching, you might change the Join Kind from Left 
Outer to Left Anti in order to return only the list of people in the first table who do not have a 
match in the second table.

If there are fewer records than you expect, you might experiment with the “similarity threshhold.” By de-
fault, the similarity threshold requires an 80% match. You could try changing this to 0.7 or 0.6 to see if it 
improves the number of matches. But be careful. If you set this too low, you risk the chance of false match-
es happening. For example, at 0.4 similarity, both Mason Astley and Lucy Astley would be seen as a match.  

Click OK to perform the Merge. The grid in the Power Query editor will show columns for Employee Name, 
Department, and then a column called Forms. The value in each row for Forms simply says “Table” in each 
row. To the right of the “Forms” heading is an Expand icon with two arrows pointing left and right. Click this 
icon to choose which fields from the Forms table to return.
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By default, the new fields will have the table name followed by a period and then the field name (such as 
“Forms.Form Received”). To prevent this, uncheck the box for “Use Original Column Name As Prefix.”

Once you have the preview shown in the Power Query Editor, go to Home, Close & Load to deliver the re-
sults to a new table on a new worksheet. You could optionally use Close & Load To… and specify a location 
on an existing worksheet for the table.

At this point, review the results to make sure no false matches were found. If everything looks good, you 
can sort or filter to remove the records that show a match, leaving the people who haven’t turned in a 
form.
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There’s an easy audit method to look for people in the Forms table who did not show up in the Merge 
query. Use Data, Get Data, Combine Queries, Merge. Specify Forms as the first table, using Name as the key 
field. Specify Merge1 as the second table, using Name as the key field. For the Join Kind, specify Left Anti 
(Rows Only In the First Table}.

Ever since my Accounting 101 class, I was taught that “close” is never acceptable in accounting. This leads 
to a reluctance to trust the fuzzy matching algorithm. Yet there are cases where the fuzzy match tool is the 
only solution short of manually matching records.

As more people turn in their forms, choosing Data, Refresh All will automatically perform the fuzzy match 
again.

#109 Build a pivot Table on a Map using 3D Maps
3D Maps (formerly Power Map) is available in the Microsoft 365 versions of Excel 2013 and all versions of 
Excel 2016. Using 3D Maps, you can build a pivot table on a map. You can fly through your data and ani-
mate the data over time. 

3D Maps lets you see five dimensions: latitude, longitude, color, height, and time. Using it is a fascinating 
way to visualize large data sets.

3D Maps can work with simple one-sheet data sets or with multiple tables added to the Data 
Model. Select the data. On the Insert tab, choose 3D Map. (The icon is located to the right of 
the Charts group.) 

Next, you need to choose which fields are your geography fields. This could 
be Country, State, County, Zip Code, or even individual street addresses.

You are given a list of the fields in your data set and drop zones named Height, Category, and Time.

Hover over any point on the map to get details such as last sale date and amount.

In the default state of 3D Maps, each data point occupies about one city block. To be able to plot many 
houses on a street, select the Gear Wheel, Layer Options and change the thickness of the point to 10%.

To get the satellite imagery, open the Themes dropdown and use the second theme.

3D Maps provides a completely new way to look at your data. It is hard to believe that this is Excel.
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Here is a map of Merritt Island, Florida. The various 
colors are different housing allotments. Each col-
ored dot on the map is a house with a dock, either 
on a river or one of many canals dredged out in the 
1960s and 1970s.

Using the time slider, you can go back in time to 
any point. Here is the same area at the time when 
NASA landed the first man on the Moon. The NASA 
engineers had just started building waterfront 
homes here, a few miles south of Kennedy Space 
Center.

Use the wheel mouse to scroll in. You can actually 
see individual streets, canals, and driveways.

Hold down the Alt key and drag sideways to rotate 
the map. Hold down the Alt key and drag up to tip 
the map so your view is closer to the ground.

Thanks to Igor Peev and Scott Ruble at Microsoft for this cool new feature.
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#110 The Forecast Sheet Can Handle Some Seasonality
Before Excel 2016, Excel offered a few forecasting tools that did not fit in every situation. If your sales 
data included some seasonality, the old forecasting tools would do a bad job. Consider a movie theatre 
where sales peak on the weekend and plummet on Monday. Using the old linear trendline, Excel shows an 
R-Squared of 0.02, meaning that the trendline is doing a horrible job of predicting the future.

Excel 2016 introduced a new set of forecasting functions and an icon on the Data tab of the Ribbon to 
create a Forecast Sheet. If you have data with Date in column A and Sales in column B, select the data and 
choose Data, Forecast Sheet. 

In the Create Forecast Worksheet dialog, click Options and review the Seasonality and ask for stats. Click 
Create and Excel inserts a new worksheet with FORECAST.ETS functions to create a forecast. The 3% error 
shown means that this forecast is explaining most of the variability.

Caution: The Forecast Sheet works fine if you have one level of seasonality: More movie-goers on 
Friday or more gift buyers in November and December. But if your real-life data calls for both a 
December boom and a Saturday/Sunday peak, the FORECAST.ETS won't handle it.
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#111 perform Sentiment analysis in Excel
It is easy to quantify survey data when it is multiple choice: You use a pivot table to figure out the percent-
age for each answer. But what about free-form text answers? These are hard to process if you have hun-
dreds or thousands of them.

Sentiment analysis is a machine-based method for predicting if an answer is positive or negative. 
Microsoft offers a tool that does sentiment analysis in Excel. It is called Azure Machine Learning.

Traditional sentiment analysis requires a human to analyze and categorize 5% of the statements. Excel 
uses MPQA Subjectivity Lexicon. This generic dictionary includes 5,097 negative and 2,533 positive words. 
Each word is assigned a strong or weak polarity. This works great for short sentences, such as tweets or 
Facebook posts.

Look in the Add-ins group of the Insert tab. The first icon used to be called Store and now is called My 
Apps. Click that icon and search for Azure Machine Learning.

Specify an input range and two blank columns for the output range.

The heading for the input range has to match the schema tweet_text.

The results show positive, negative, or neutral and a percentage score. Items near 99% are very likely posi-
tive. Items near 0% are very likely negative.

#112 Build Org Charts with the visio Data visualizer in Excel

Most people with Microsoft 365 will have a new Visio Data 
Visualizer tool in Excel. It is found on the Insert tab, in the 
Add-Ins group.

The easiest way to get started is to go to File, New and search the templates for "flowcharts". There should 
be five results, but these three are for the Visio tool.
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Choose Org Chart and then click Create. There are five styles to choose from. Choose one style. Excel will 
open with some sample data, the chart from that data, and three more worksheets explaining how it 
works.

After you replace the sample data with your data, you click Refresh on the org chart.

Caution: There are resize handles on the diagram, but you have to first click on the edge of the 
frame around the diagram. This drove me crazy at first.

Note: The same tool can create flowcharts, swim-lane charts, process charts, and cross-functional 
org charts.

Tip: Same the workbook to OneDrive or SharePoint Online. Then when you View in Web, you have 
some additional functionality from Visio online.
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#113 Fill in a Flash
Excel 2013 added a data-cleansing tool called Flash Fill. 

In the figure below, you see full names in column 
A. You want to get the person’s first initial and 
last name in column B. Rather than try to puzzle 
out =PROPER(LEFT(A2,1)&" "&MID(A2,FIND(" 
",A2)+1,50)), you simply type a sample of what you 
want in B2.

Type the first initial in B3. Excel sees what you are 
doing and “grays in” a suggested result.

Press Enter to accept the suggestion. Bam! All of 
the data is filled in.

Look carefully through your data for exceptions to the rule. Two people here have middle initials listed. Do 
you want the middle initials to appear? If so, correct the suggestion for Dennis P. Jancsy in cell B4. Flash Fill 
will jump into action and fix Martha K. Wendel in B9 and any others that match the new pattern. The status 
bar will indicate how many changes were made.

In the above case, Excel gurus could figure out the formula. But Flash Fill is easier. In the example shown 
below, it would be harder to write a formula to get the last word from a phrase that has a different number 
of words and more than one hyphen.

Flash Fill makes this easy. Go to cell B3 and press Ctrl+E to invoke Flash Fill.
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Note: Flash Fill will not automatically fill in numbers. If you have numbers, you might see Flash Fill 
temporarily “gray in” a suggestion but then withdraw it. This is your signal to press Ctrl+E to give 
Flash Fill permission to fill in numbers.

Thanks to Chad Rothschiller at Microsoft for building this feature. Thanks also to Olga Kryuchkova.

#114 Format as a Façade
Excel is amazing at storing one number and presenting another number. Choose any cell and select 

Currency format. Excel adds a dollar sign and a 
comma and presents the number, rounded to 
two decimal places. In the figure below, cell D2 
actually contains 6.42452514. Thankfully, the 
built-in custom number format presents the re-
sults in an easy-to-read format.

The custom number format code in D2 is 
$#,##0.00. In this code, 0s are required digits. Any #s are optional digits. 

However, formatting codes can be far more complex. The code above has one format. That format is ap-
plied to every value in the cell. If you provide a code with two formats, 
the first format is for non-negative numbers, and the second format is for 
negative numbers. You separate the formats with semicolons. If you pro-
vide a code with three formats, the first is for positive, then negative, then 
zero. If you provide a code with four formats, they are used for positive, 
negative, zero, and text.

Even if you are using a built-in format, you can go to Format Cells, Number, Custom and see the code used 
to generate that format. The figure below shows the code for the accounting format.

To build your own custom format, go to Format Cells, Number, Custom and enter the code in the Type box. 
Check out the example in the Sample box to make sure everything looks correct.

In the following example, three zones are used. Text in quotes is added to the number format to customize 
the message.
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If you create a zone for zero but put nothing there, you will hide all zero values. The following code uses 
color codes for positive and negative. The code ends in a semicolon, creating a zone for zero values. But 
since the zone is empty, zero values are not shown.

Illustration: Walter Moore

You can extend this by making all zones blank.  A custom format code ;;; will hide values in the display and 
printout. However, you‘ll still be able to see the values in the formula bar. If you hide values by making the 
font white, the ;;; will stay hidden even if people change the fill color. The following figure includes some 
interesting formatting tricks.

In B2 and B3, if you put ** before the 
number code, Excel will fill to the left of 
the number with asterisks, like the old 
check writer machines would do. But 
there is nothing that says you have to 
use asterisks. Whatever you put after 
the first asterisk is repeated to fill the 
space. Row 3 uses *! to repeat exclama-
tion points.

In B4 and B5, each comma that you put after the final zero will divide the number by 1000. The code 0,K 
shows numbers in thousands, with a K afterward. If you want to show millions, use two commas. The "M" 
code must include quotation marks, since M already means months.

In B6, add a stern message in the fourth zone to alert anyone entering data that you want a number in the 
cell. If they accidentally enter text, the message will appear.

In B7 to B9, the normal zones Positives, Negatives, and Zero are overwritten by conditions that you put in 
square brackets. Numbers under 70 are red. Numbers over 90 are blue. Everything else is black.

In B10, those odd _( symbols in the accounting format are telling Excel to leave as much space as a left 
parenthesis would take. It turns out that an underscore followed by any character will leave as much white 
space as that character. In B10, the code contains 4 zeros. But there are different amounts of space be-
tween them. The space between the 1 and 2 is the width of 2 W characters. The space between 2 and 3 is 
the width of an N. The space between 3 and 4 is the width of a lowercase letter i.

The following figure shows various date formatting codes.
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Note: The mmmmm format in row 10 is useful for producing J F M A M J J A S O N D chart labels.
Thanks to Dave Baylis, Brad Edgar, Mike Girvin, and @best_excel for suggesting this feature.

#115 Show all Open workbooks in the windows Taskbar
Here is a great trick from Marlette Toole of the FL Space Coast chapter of the Institute of Internal Auditors. 
Since you are spending most of your work life in Excel, wouldn't it be nice to see all open workbooks in the 
Windows taskbar instead of just one tile with the Excel logo?

Right-click in an empty area of the Taskbar and choose Taskbar Settings. In the Combine Taskbar Settings 
drop-down menu, choose Never.

#116 paste to another Computer using Cloud Clipboard

Do you have two computers on 
your desk? Go to the Control Panel 
for the Clipboard and turn on Sync 
Across Devices and Automatically 
Sync Text That I Copy for both com-
puters. You can now Ctrl+C some 
cells on one computer. On the 
other computer, press Win+V and 
you can paste the clipboard from 
the first computer.  This eliminates 
any need to e-mail text from one 
computer to the other.
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#117 Surveys & Forms in Excel
I often start my live Excel seminars off by asking you to point your cell phone camera at a giant bar code I 
have projected on the screen. That QR code leads to a three-question survey. Answers automatically flow 
into my Excel worksheet and those answers get used in the afternoon demo of 3D Maps.

Start at Forms.Office.com.

A browser will open and you can build your form. Click New Question. Forms offers support for seven 
question types. Don't miss the useful Ranking or Likert types hidden behind the three dots.

Type the question and possible answers.

Branching is now supported: Click the 3 Dots icon in the top right corner of Forms.Office.Com.

When you are done with all questions, click Share in the top right corner. You can share via a link, or via 
e-mail, or using the QR Code. Try it: point your cell phone camera at the bar code on the right.
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#118 use the windows Magnifier
If you received this book while attending one of my live Power Excel seminars, you likely saw me use the 
Windows Magnifier. Someone always asks how to use this, so I will write up the key steps.

First, there are three versions of the magnifier. To start the magnifier, press the Windows key and the Plus 
sign on the Numeric Keypad. To stop the magnifier, press the Windows key and Esc.

The first time that you use the magnifier, it opens in a view called Full Screen. Everything on the screen 
becomes bigger and you can use the mouse to move around. I don't like this version. Look for the floating 
Magnifier toolbar. Open Views and choose Lens.

A magnifier lens follows your mouse cursor around the screen. You can use the Settings (gear wheel) icon 
in the toolbar to change the size of the lens.

On some computers, the Magnifier toolbar starts out as an icon that looks like a magnifying glass. Click the 
icon to open the toolbar.  More magnifier settings are in Windows, Settings, Ease of Access, Magnifier.
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#119 New Scrolling Tricks 
Excel now  offers horizontal scrolling and smooth scrolling. To scroll with the mouse wheel:

 ● Spin the mouse wheel to scroll vertically through the grid

 ● Ctrl+Spin the mouse wheel to change the Zoom level.

 ● Ctrl+Shift+Spin the mouse wheel to scroll horizontally. This functionality was added to Microsoft 365 
during 2021.

Smooth scrolling is a popular improvement, particu-
larly for people who store a lot of text in a cell.  Before 
Smooth scrolling, the following worksheet could be 
scrolled to show "In B2 and B3" or "In B4 and B5" at the 
top of the worksheet. There was no way to leave Excel 
parked with half of row 1 scrolled off the screen.

Now, with Smooth Scrolling, you can scroll part way 
through a cell. In the figure below, you can see that 
half of cell A1 is scrolled out of view.

You could even scroll sideways and have part of the column visible.

Note:  By default, when you scroll with the mouse wheel, it 
jumps three lines a a time. Visit the Control Panel and search for 
Scrolling to find these settings.
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#120 word for Excellers
Note: Katie Sullivan is a project manager on the Microsoft Word team. For this tip in the book, I 
turn the podium over to Katie.

While Excel fans sometimes tease that Word and PowerPoint are freeware apps that come with Excel, there 
are times when Microsoft Word offers a feature that Excel does not. In those cases, it makes sense to copy 
your data from Excel, paste to Word, do the command, then copy back to Excel. Here are some examples of 
techniques that are better handled in Word than in Excel.

Technique 1: Convert to upper, Lower, proper

If you have to convert from uppercase to lowercase or proper case, Word has a keystroke shortcut. Copy 
the data to Word and toggle the case using Shift+F3.

Technique 2: add Bullets

If you want to add bullets to Excel cells, it is far easier in Word than in Excel. Copy the cells to Word and 
apply a bullet style. Copy from Word and paste back to Excel. You might have to use the Reduce Indent 
icon a few times.

Tip: Since the first edition of this book, I learned of an easier way to do bullets in Excel. If you have 
a range of cells that contain text, select the range and press Ctrl+1 to open the Format Cells dialog. 
Then, on the Number tab, choose Custom from the list on the left. Click in the Type box and clear 
out whatever is there. Hold down the Alt key while pressing the 7 on the numeric keypad. A bullet 
should appear. Type a space and then an @.

Technique 3: visualize and Color Formulas

If you have a massively long formula, say one with 10 nested IF statements, you can paste to Word and use 
colors and Shift+Enter to space the formula to help make sense of it. (One rebuttal from the Excel team: 
You can expand the formula bar and use Alt+Enter to split a formula into many lines. Or, you can use the 
great RefTreeAnalyser add-in from Jan Karel Pieterse; see http://mrx.cl/jkpformula.)

Technique 4: Faster Smartart

Word offers the Convert Text to SmartArt option. While Excel offers SmartArt, too, it is not very handy there 
because you have to copy the entries one at a time into the SmartArt pane.

http://mrx.cl/jkpformula
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Technique 5: Extract Data from a pDF

Say that someone has an Excel workbook and saves that workbook as a PDF. They send it to you. This is an-
noying, and clearly they don‘t want you to reuse the data. If you open the PDF in Acrobat Reader, copy the 
data, and paste to Excel, it will unwind into a single column. But here is the secret: Paste that data to Word 
first. The rows and columns will paste properly. You can then copy from Word and paste back into Excel. (If 
you are stuck in a pre-2013 version of Office, I recommend Able2Extract: mrx.cl/pdftoxl.)

The original data is shown on the left below, and you can see on the right and how it looks when you paste 
directly from PDF to Excel. You can see that the data “unwinds,” with B1:C1 going to A2:A3 and so on.

Paste that same data to Word (below left), then copy from Word and paste to Excel (below right). The data 
stays in the original order. You can unapply Word Wrap and adjust the column widths to get back to the 
original data.

Technique 6: Change Formatting of words within Excel

If you have sentences of text in Excel, it is possible to select one word while in Edit mode and change the 
color of that word. But globally changing the color of all occurrences of 
the word in Excel is tedious. Instead, paste the data to Word and press 
Ctrl+H. Change dog to dog. Click More>> and then choose Format, Font. 
Choose Red. Click Replace All. Copy from Word and paste back to Excel. 
The figure below shows what you end up with.
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Technique 7: replace while keeping Character Formatting

Word also handles a similar problem: replacing text but leaving the text formatting as it is. Below is a 
survey about the best pet. Someone has highlighted certain words in the text.

Use Ctrl+H to do a Find and Replace, as 
shown on the left. When you use Replace 
All, if a sentence was changed, your in-cell 
formats will be lost. In the figure below, 
the strikethrough remains in the first row 
because that row did not have an occur-
rence of the word puppy and thus was not 
changed.

To keep the formatting in the original text, 
copy to Word. Do the replace in Word. Copy 
from Word and paste back to Excel.

Bonus Tip: Merge Shapes
Here‘s a brief plug for PowerPoint: If you need to create a shape in Excel that is a combination of other 
shapes, create the shapes in PowerPoint. Select all the shapes you want to include. On the Drawing Tools 
Format tab, choose Merge Shapes. You can then select Union, Combine, Fragment, Intersect, or Subtract to 
combine the shapes. (The Subtract feature lets you cut a hole in a shape.) Then copy that shape and paste 
to Excel (or Word).

Bonus Tip: use the Eye Dropper
Another feature unique to PowerPoint is the eye dropper. If you want to use a particular color, you can just 
click the eye dropper on the color. When you open the Power Point color menu again, choose More Colors, 
and you can see the RGB colors. To use the eye dropper outside the PowerPoint frame, hold down the left 
mouse button and pick from any website or picture you have visible on your desktop.
Thanks to Katie Sullivan (a project manager on the Word team!) for contributing this tip. Katie clearly prefers dogs to cats. Thanks 
to Glenna Shaw and Oz du Soleil for contributing ideas to this tip. Zack Barresse and Echo Swinford pointed out the Merge Shapes 
option in PowerPoint. Sam Radakovitz added the eye dropper tip and noted the Subtract feature for shapes.
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#121 avoid whiplash with Speak Cells
I hate having to hand-key data into Excel. Between the Internet and Power Query, there almost always is a 
way to find the data somewhere. I hate when people send a PDF where they scanned some numbers and 
are sending the numbers as a picture. A free trial of Able2Extract Pro (mrx.cl/ExtractPDF) will get the actual 
number into Excel. Even so, sometimes you end up keying data into Excel.

One of the painful parts about keying in data is that you have to proofread the numbers. So, you are look-
ing at the sheet of paper, then the screen, then the paper, then the screen. You will end up with a sore 
neck. Wouldn’t it be nice if you had someone to read you the screen so you can keep your eye on the 
paper? It’s built in to Excel.

Right-click on the Quick Access Toolbar and choose Customize Quick Access Toolbar.

Change the top-left dropdown to Commands Not in the Ribbon. Scroll down to the S entries until you find 
Speak Cells. Add all five of these commands to the Quick Access Toolbar.

Select your range of numbers and click Speak Cells. Excel reads you the numbers.

Tip: You can customize the voice in the Windows Control Panel. Search for Text to Speech. There is 
a setting for Voice Speed. Drag that slider to halfway between Normal and Fast to have the voice 
read your cells faster.

http://mrx.cl/ExtractPDF
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Bonus Tip: provide Feedback with Sound
New in July 2017: Go to Excel Options. From the left category list, choose Ease of Access. Select the check-
box for Provide Feedback with Sound and choose Modern. (The other choice, Classic, should be called 
Annoying!)

Excel now provides confirmation with gentle sounds when you do any of these tasks: Copy, Paste, Undo, 
Redo, AutoCorrect, Save, Insert Cells, Delete Cells.

Bonus Tip: a Great april Fool’s Day Trick 
Do you want a harmless prank to pull on a co-worker? When he leaves his desk to grab a cup of coffee, add 
the fifth icon to his Quick Access Toolbar: Speak Cells on Enter. Click the icon once, and the computer will 
say, “Cells will now be spoken on Enter.” 

Once you’ve turned on Speak Cells on Enter, right-click the icon in the Quick Access Toolbar and choose 
Remove from Quick Access Toolbar to hide any sign that you were there.

Your co-worker comes back, sits down, and starts to build a worksheet. The computer repeats back every-
thing the co-worker types.

If you have a little more time and want Speak Cells on Enter with attitude, add the following macro to the 
code pane for the current worksheet..
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#122 Customize the Quick access Toolbar
As I mentioned in "#44 Ask Excel's A.I. a Question About Your Data" on page 106, the Excel team had not 
added any new features to the Home tab since January 30, 2007. Ideas is the first feature that was deemed 
worthy of being on the Home tab.

Even though the Excel team does not think many features are Home-tab-worthy, you can add your favorite 
features to the Quick Access Toolbar (hereafter called QAT).

I always like asking people what they have added to their QAT. In a Twitter poll in January 2019, I had over 
70 suggestions of favorite features that could be added to the QAT.

To me, a "good" addition to the QAT is a command that you use frequently that is not already on the Home 
tab. Any of the features in the Commands Not In The Ribbon category are candidates if you ever have to 
use them.

Previously in this book, I've suggested the following icons on the QAT:

 ● The AutoFilter icon was used in "#4 Filter by Selection" on page 7

 ● Change Shape in "Bonus Tip: Old Style Comments Are Available as Notes" on page 36

 ● Speak Cells in "#121 Avoid Whiplash with Speak Cells" on page 246

 ● Speak Cells on Enter in "Bonus Tip: A Great April Fool’s Day Trick" on page 247

Below are more icons that you might want to add to your QAT.

The Easy way to add to the QaT

The easiest way to add an icon to the QAT is to right-click the icon in the Ribbon and choose Add to Quick 
Access Toolbar.

Adding Formulas, Calculation Options, Manual to the QAT gives you a clear indication of when your work-
book is in Manual calculation mode:
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The Hard way to add to the QaT

Sometimes, the command you want can not be right-clicked. For example, in "Bonus Tip: Copy the 
Subtotal Rows" on page 70, I suggested using Alt+; as a shortcut for Visible Cells in the Go To Special 
dialog box. 

Visible Cells Only is available to add to the QAT. But you can't add it by right-clicking in the dialog box. To 
make matters worse, when you follow these steps, you have to look for a command called "Select Visible 
Cells" instead of a command called "Visible Cells Only".

1. Right-click anywhere in the Ribbon and choose Customize Quick Access Toolbar. The Excel Options 
dialog box opens showing a list of Popular Commands. I reject many of these popular commands because 
they are already a single-click on the Home tab of the Ribbon.

2. Open the drop-down menu to the right of Popular Commands and choose either All Commands or 
Commands Not In the Ribbon.

3. Scroll through the left list box to find the command.
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4. Click the Add>> button in the center of the screen.

5. Click OK to close Excel Options.

6. Hover over the newly added icon to see the tooltip and possibly learn of a keyboard shortcut.

Favorite QaT Icons From Twitter

If you are looking for something to make Twitter more interesting, consider following @MrExcel. You can 
then play along in fun surveys like this one:

Presented below are several suggestions from people on Twitter.

Back in "#49 Quickly Convert Formulas to Values" on page 123 I had nine different ways to Paste Values. 
Here is a tenth way. The most popular suggestion on Twitter was the Paste Values icon. 

Thanks to ExcelCity, Adam Warrington, Dan Lanning, Christopher Broas. Bonus point to AJ Willikers who suggested both Paste 
Values and Paste Values and Number Formatting shown to the right of Paste Values above.
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Bonus Tip: Sometimes, you Don't want the Gallery
The next most popular command to add to the QAT is Freeze Panes. Go to the View tab. Open the Freeze 
Panes drop-down menu. Right-click on Freeze Panes and Excel offers "Add Gallery to the Quick Access 
Toolbar".

Freeze panes is a tricky command. If you want to freeze row 1 and columns A:B, you have to put the cell 
pointer in C2 before you invoke Freeze Panes.

Some people don't understand this, and in Excel 2007, the Excel team made the Freeze Panes gallery with 
choices to freeze top row and freeze first column for people who did not know to select C2 before invok-
ing Freeze Panes. 

Since you understand how Freeze Panes works, you don't want the gallery on the QAT. You just want the 
icon that does Freeze Panes.

When you look for commands in the Excel Options, there are two choices for Freeze Panes. The one with 
the arrow is the gallery. The first one is the one you want.

Thanks to Debra Dalgleish, Colin Foster and @Excel_City for suggesting Freeze Panes

In other cases, the Gallery version is superior to the non-gallery version. Here is an example. Jen (who ap-
parently is a @PFChangsAddict) suggested adding Save As to the QAT. Alex Waterton suggested adding 
Save As Other Formats. When I initially added the non-gallery version of Save As Other Formats, I realized 
that both icons open the Save As dialog box.
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Instead, use the Gallery version of Save As

Here are those four icons in the QAT. The Save As Other Format gallery offers the most choices.

If you are planning on creating a lot of PDF files, Colin Foster suggests adding Publish as PDF or XPS to the 
QAT.

The First 9 Icons in QaT Have Easy Shortcut keys

Most people who customize the QAT add new icons after the AutoSave, Save, Undo, Redo commands that 
are in the default QAT. But those first 9 QAT spots have super-easy keyboard shortcuts. AJ Willikers pointed 
out that the first 9 icons have easy short cut keys.

Press and release the Alt key. Key tips appear on each ribbon tab. So, Alt, H, S, O would sort descending. If 
you sort descending a lot, add the icon as one of the first 9 icons on the QAT. Press and release Alt, Then 
press 1 to invoke the first icon on the QAT. Note that the key tips for items 10 and beyond require you to 
press Alt, 0, 1 so they aren't quite as easy as the first 9 icons.
Thanks to AJ Willikers for pointing out the Alt 1-9 keyboard shortcuts.
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The Camera Tool versus paste as Linked picture

Another popular QAT command on Twitter was the Camera. This awesome hack dates back to Excel 97. It 
is great because it allows you to paste a live picture of cells from Sheet17 on the Dashboard worksheet. It 
was hard to use and Microsoft re-worked the tool in Excel 2007, rebranding it as Paste As Linked Picture. 
But the operation of the tool changed and some people like the old way better.

For background on the tool, see "Bonus Tip: Line Up Dashboard Sections with Different Column Widths" on 
page 99. Say that you wanted to paste a picture of these cells in your dashboard:

Old way: You could select the cells. Click the Camera icon. The mouse pointer changes to a cross hair. Click 
anywhere that you want to paste the picture of the cells.

New way: Copy the cells. Click in the new location. Choose Paste As Linked Picture. If you don't want the 
picture lined up with the top-left corner of the cell, drag to nudge the picture into position.

Thanks to Manoel Costa, Brad Edgar, and Duncan Williamson for suggesting the Camera.

Screen Clipping to Capture a Static Image From another application

One of my favorite commands for the QAT is Insert Screen Clipping. Say that you want to grab a picture 
of a website and put it in your Excel worksheet. To effectively use the tool, you need to make sure that the 
web page is the most-recent window behind the Excel workbook. So - visit the web page. Then switch 
directly to your Excel Workbook. Choose Insert Screen Clipping and wait a few moments. The Excel screen 
disappears, revealing the web page. Wait for the web page to grey out, then use the mouse pointer to 
drag a rectangle around the portion of the web page. When you release the mouse button, a static pic-
ture of the web page (or any application) will paste in Excel. The Screen Clipping is also great for putting 
Excel charts in Power Point. Until you add this command to the QAT, it is hidden at the bottom of Insert, 
Screenshot. I don't like the Screenshot options because they put the entire full screen in Excel. Screen 
Clipping lets you choose just a part of the screen.

Two Icons Might Lead to the Same place: Open recent and Open

One of the popular QAT commands in Excel 2010 and Excel 2013 was the folder with a star - Open Recent 
File…. This command disappeared from Excel in Excel 2016. But people discovered that if you exported 
your settings from 2013 and then imported to 2016 or 2019, the icon would appear!

As I considered the prospect of dragging my Excel 2013 .tlb file around for the rest of my life, I inadvertent-
ly realized that the Open icon leads to the exact same place as the Open Recent File icon.
Thanks to Colin Foster and Ed Hansberry for suggesting Open Recent File.
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Clear Filter and reapply Filter

You hopefully already have the AutoFilter on your QAT after reading "#4 Filter by Selection" on page 7. 
Debra Dalgleish, Excel_City, and AJ Willikers suggests Clear Filters. This is a great way to reset your filters 
without visiting the Data tab.

Bathazar Lawson suggests adding Reapply Filter to the QAT. Here is how this becomes handy. Let's say you 
have a list of projects. You don't need to see anything where the status code is Complete. You set up a filter 
for this.

You change the status code on 
some projects. Some of the proj-
ects that used to be In Review are 
now Complete.

Instead of re-opening the Filter 
drop-down, click Reapply Filter.

Excel will re-evaluate the data 
and hide the items which now 
have a 5.
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Some Future Features Debut on the QaT and then Become real Features

I was at a seminar in Topeka when Candace and Robert taught me that you could add an icon called 
Document Location to the QAT. 

If you need to copy the document location to the clipboard, you can select the text from the QAT, right-
click and choose Copy.

The Document Location has been available since at least Excel 2010. In early 2019, Microsoft 365 subscrib-
ers will notice that the File, Info screen now has new equivalents of Copy Path and Open File Location.

Easier Superscript and Subscripts

Add the new Superscript and Subscript icons to the QAT. As you are typing, click either icon to continue 
typing in subscript or superscript. This might be handy for a single character (such as the 2 in H20) or for 
several characters.

New Features from the Data Tab

The Data tab is like the Boardwalk and Park Place of the Excel ribbon. Every project manager wants to be 
on the Home tab, but most of the great features end up on the data tab. Excel 2016 introduced Get Data 
(Power Query), Relationships, and Refresh All. Add those to the QAT.
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Build Formulas without Ever Leaving the Mouse

Ha-ha! This advice flies in the face of what every Excel tipster teaches. Most people want you to build for-
mulas without ever leaving the keyboard. But what if you hate the keyboard and want to use the mouse? 
You can add these operators to your QAT:

Using the mouse, you can click the Equals sign, then click on C1, then Multiply, then D1, then Divide, then 
E1. To complete the formula, click the green checkmark next to the formula bar to Enter. Surprisingly, Enter 
is not available for the QAT. But the formula bar is usually always visible, so this would work.

Those seven icons shown above are not located in one section of the Customize dialog. You have to hunt 
for them in the E, P, M, M, D, E, and P section of the list.

Bonus Tip: Show QaT Below the ribbon
Right-click the Ribbon and choose Show Quick Access Toolbar Below The Ribbon. There are several advan-
tages. First, it is a shorter mouse move to reach the icons. Second, when the QAT is above the Ribbon, you 
have less space until the icons run into the file name.

#123 Create your Own QaT routines using vBa Macros
There are several short macros you can add to your Personal Macro Workbook and then add to the QAT. In 
this tip, you will see how to create the Personal Macro Workbook, type some macros, and then assign them 
to icons on the QAT.

Create a personal Macro workbook

Start from any workbook. Go to View, Macros, Record Macro.  In the Record Macro dialog, type a one-word 
name such as HelloWorld. Choose Personal Macro Workbook. Click OK.
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Type Hello in the active cell and press Enter. Then, select View, Macros, Stop Recording. These steps will 
create a Personal.xlsb on your computer where you can store new macros.

Open the vBa Editor and Find Module1 in personal.xlsb

From Excel, press Alt+F11. (If you don't have Alt+F11, you can add the Visual Basic command to the QAT 
and click that.

Your first time in the VBA editor, it might be a vast expanse of grey. From the VBA menu, select View, 
Project Explorer.

Look for an entry called VBAProject (PERSONAL.XLSB). Click the + icon to expand it.

Look for and expand Modules. Right-click Module1 and choose View Code.

You will see your HelloWorld code. After the End Sub, type any of these procedures.
Sub VeryHideActiveSheet()
    ActiveSheet.Visible = xlVeryHidden
End Sub
Sub ShowAllSheets()
    For Each sh In ActiveWorkbook.Worksheets
        sh.Visible = True
    Next sh
End Sub
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Sub UpperSelection()
    For Each cell In Selection.SpecialCells(2, 2)
        ' 2, 2 means xlCellTypeConstants, Text
        cell.Value = UCase(cell.Value)
    Next
End Sub
Sub LowerSelection()
    For Each cell In Selection.SpecialCells(2, 2)
        cell.Value = LCase(cell.Value)
    Next
End Sub
Sub ProperSelection()
    For Each cell In Selection.SpecialCells(2, 2)
        cell.Value = Application.WorksheetFunction.Proper(cell.Value)
    Next
End Sub

When you customize the QAT, choose Macros from the top left drop-down menu.

When you choose a macro and click Add>> the icon will default to a flow chart. Click Modify at the bottom 
right. Choose a new icon. Type a good tooltip.

Here is an explanation of how to use these five macros:

 ● very Hide: Worksheets can be visible, hidden or very hidden. Few people know about Very Hidden 
sheets because you have to use VBA to create them. A worksheet that is Very Hidden will not show up 
in Home, Format, Hide and Unhide, Worksheets. (Thanks to -Sagar Malik)

 ● Show all Sheets: It is easy to select 12 sheets and hide them in a single command. But then unhid-
ing the sheets is a one-at-a-time proposition. This macro will unhide all sheets (including very hidden 
sheets).

 ● upper Selection: Converts all text in the selection to upper case.

 ● Lower Selection: Converts all text in the selection to lower case.

 ● proper Selection: Converts all text in the selection to proper case.
Thanks to MF Wong for suggesting some of these macros.

Bonus Tip: Settings in the Excel Options Menu
Consider a few of these settings after you choose File, Options:

General, Start Up Options, Unselect Show The Start Screen When This Application Starts to skip the Home 
screen. Excel will open directly to a blank workbook. (Thanks to Dave Marriott)

Advanced, Editing Options, Unselect After Pressing Enter, Move Selection. When you type a value in a cell, 
Excel will stay in the same cell. (Thanks to Ed Hansberry)

Advanced, Editing Options, Automatically Insert a Decimal Point. You type 12345. Excel gets 123.45.
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#124 Favorite keyboard Shortcuts
As I started polling readers about their favorite Excel tips, a large number of them were keyboard short-
cuts. Some readers, such as Matt Kellett, Olga Kryuchkova, Mike Dolan Fliss, and @model_citizen, suggest-
ed that the book has to include a section on favorite keyboard shortcuts.

These are presented in order of popularity. If a lot of readers suggested a tip, it is at the top. After the first 
eight or so, they are then sorted by my subjective sequence.

1. Ctrl+1 to Format a Selection

Ctrl+1 (the number one) works to format whatever is selected. Whether it is a cell, SmartArt, a picture, a 
shape, or the March data point in a column chart, press Ctrl+1.
Thanks to Mitja Bezenšek, Alexa Gardner, Andrej Lapajne, Schmuel Oluwa, Jon Peltier, 
@ExcelNewss, and @JulianExcelTips.

2. Ctrl[+Shift]+arrow to Navigate or Select

Your cell pointer is sitting at the top of 50K rows of data, and you need to get to the bottom. If you have a 
column with no blanks, press Ctrl+Down Arrow to jump to the end of the data 
set. 

In the following figure, Ctrl+Down Arrow will jump to K545. Ctrl+Left Arrow will jump to A1. Ctrl+Right 
Arrow will jump the gap of empty cells and land on N1.

Add the Shift key in order to select from the active cell to the landing cell. Starting from A1 in the above 
figure, press Ctrl+Shift+Down Arrow to select A1:A545. While still holding down Ctrl+Shift, press the Right 
Arrow Key to select A1:K545. If it seems awkward at first, try it for a few days until you get the hang of it.
Thanks to Captain Excel, @Cintellis, José de Diego, Mike Girvin, Elchin Khalilov, Crystal Long, Paul Sasur, and @XLStudioWorks.

3. Ctrl+. to Jump to Next Corner

While you have a large range selected, press Ctrl+Period to move to the next corner of the selection. If the 
selection is rectangular, you move in a clockwise fashion. From the bottom-right corner, press Ctrl+. twice 
to move to the top left.
Thanks to Crystal Long, and Steve McCready.

4. Ctrl+5 for Strikethrough
This is great for crossing things off your to-do list. Why 5? If you are making hash marks, the fifth hash mark 
crosses out the first four.
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5. Ctrl+* to Select Current region

This one is easier if you have a number keypad so you don’t have to press Shift to get to an asterisk. If I 
could slow down enough to stop pressing Ctrl+Shift+Down Arrow followed by Ctrl+Shift+Right arrow, I 
would realize that Ctrl+* is much shorter and does not get tripped up by blank cells. It is really superior in 
every way to keyboard tip #2. But my muscle memory still prefers tip #2. Thanks to @Excelforo.

6. Ctrl+Enter to Copy Formula into Entire Selection

Ken Puls, who is the king of Power Query, says, “You would think my favorite Excel tip would be Unpivot 
with Power Query, but my favorite all-time is Ctrl+Enter.” Say that you want to enter a formula into 400 
cells. Select the 400 cells. Type the formula in the first cell. Press Ctrl+Enter, and Excel enters a similar for-
mula in all cells of the selection.

Gavin White points out another use. You enter a formula in G2. You need to copy the formula down but 
not the formatting. Select G2:G20. Press the F2 key to put the cell in Edit mode. When you press Ctrl+Enter, 
the formula is copied, but no formatting is copied. Thanks to Crystal Long, Schmuel Oluwa, Ken Puls, Peter Raiff, Sven 

Simon, and Gavin Whyte.

7. Ctrl(+Shift)+; to Time or Date Stamp

Press Ctrl+Shift+: to enter the current time. Press Ctrl+; for the current date. Note the shortcut enters the 
current time, not a formula. To put both the Date & time in one cell, type either keystroke, a space, then the 
other keystroke. Excel will interpret it as the proper Date & time.
Thanks to Olga Kryuchkova, Roger Govier and Tim O’Mara.

8. Ctrl+Backspace to Bring the active Cell into view

This is a great trick that I never knew. Say that C1 is the active cell. You’ve used the scrollbars, and now you 
are looking at ZZ999. To bring the window back to encompass the active cell, press Ctrl+Backspace. 
Thanks to Olga Kryuchkova and Schmuel Oluwa.

9. alt+= for autoSum

Press Alt+= to invoke the AutoSum function. Thanks to Dawn Bjork Buzbee and Olga Kryuchkova.

10. Ctrl+page Down and Ctrl+page up to Jump to Next worksheet

If you need to move from Sheet1 to Sheet5, press Ctrl+Page Down four times. If you are at Sheet9 and 
need to move to Sheet3, press Ctrl+Page Up six times. Thanks to Jeneta Hot.

11. Ctrl+Click to Select Noncontiguous Cells

If you have to select two regions, select the first one, then hold down Ctrl while clicking on other cells or 
regions. – Thanks toThomas Fries
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12. Tab to autoComplete

This one is maddening. You type =VL to start VLOOKUP. The AutoComplete shows that there is only one 
function that starts with VL. But if you press Enter, you get a #NAME? error.

The correct way to choose VLOOKUP is to press Tab! Thanks to Ashish Agarwal.

13. Shift+F8 to add to Selection

Select the first range. Press Shift+F8, and you are in Add to Selection mode. Scroll anywhere. Select the 
next range. Then select another range. And so on, without ever touching Ctrl. To return to normal, press 
Esc.  Thanks to Neil Charles. A bonus tip from Bill Hazlett: if you select A1, press F8, then click in S20, you will 
select from A1:S20. Press Esc to exit the Extend Selection mode. Watch for the indicator in the status bar:

14. Ctrl+Spacebar and Shift+Spacebar to Select an Entire Column or row

Ctrl+Spacebar selects a whole column. Shift+Spacebar selects a whole row. How can you remember which 
is which? The “C” in Ctrl stands for the “C” in column. Also, the “S” in Shift is adjacent in the alphabet to the 
“R” in row. Another way to remember which is which: The Shift key is much longer (like a row!) than Ctrl.
Thanks to Michael Byrne, Jeneta Hot, and Bob Umlas.

15. Ctrl+` to See all Formulas

Many folks in the United States think this is Ctrl+~, but it is actually the grave accent to toggle into and out 
of Show Formulas mode.

16. F3 to paste a Name into a Formula

I am not a huge fan of this, since you can start typing the name and then choose from AutoComplete. But I 
know the trick has its fans, including Mike Girvin and Johan van den Brink.

17. Ctrl+Shift+1 to apply  Number Formatting

I had never memorized these, but I am going to start using some of them. Ctrl+Shift+1 (also known as 
Ctrl+!), will apply a number format, 2 decimals, thousands separator, and negatives shown with a minus 
sign. The other five make some reasonable sense, as described below.

Thanks to Matthew Bernath.

18. Ctrl+Shift+2 to apply Time Formatting

Ctrl+Shift+2 or Ctrl+@ applies a time formatting. Say that you want to meet for dinner @ 5 o'click. Long 
before it became associated with e-mail addresses, the @ inferred time.
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19. Ctrl+Shift+3 to apply Date Formatting

Ctrl+Shift+3 or Ctrl+# applies a date formatting. The # symbol looks a bit like a calendar, if you lived in an 
alternate universe with three weeks per month and three days per week.

20. Ctrl+Shift+4 to apply Currency Formatting

Ctrl+Shift+4 or Ctrl+$ applies a currency format with two decimal places.

21. Ctrl+Shift+5 for percent Format

Ctrl+Shift+5 or Ctrl+% applies a percentage format with 0 decimal places.

22. Ctrl+Shift+6 for Scientific Format

Ctrl+Shift+6 or Ctrl+Shift+^ applies scientific notation. 1.23E+07 infers an exponent. A caret(^) is used to 
enter exponents in Excel.

23. Ctrl+[ to Jump to Linked Cell

You are in a cell that points to Sheet99!Z1000. Press Ctrl+[ to jump to that cell. This works if you have links 
between workbooks, even if the other workbook is closed! Thanks to @Heffa100 and Bob Umlas.

24. Ctrl+F1 to hide or show the ribbon

To toggle the Ribbon between Pinned and Hidden, use Ctrl+F1. 

25. Ctrl+Shift+F1 for Full Screen Mode

New in 2021: Use Ctrl+Shift+F1 to toggle into Full Screen Mode. In this mode, Excel hides the Status Bar, 
the Ribbon tabs and the Quick Access Toolbar but keeps the Formula Bar. On my large monitor, I can see 
55 rows in Excel, 60 rows in Excel after Ctrl+F1, and 64 rows after Ctrl+Shift+F1. None of these beat the 
QAT icon Full Screen Mode [Toggle Full Screen Mode]. This legacy icon hides the formula bar and shows 66 
rows in the grid.

26. alt+F1 to Chart the Selected Data

Select some data. Press Alt+F1. You get a chart of the data. You might remember F11 doing the same 
thing. But F11 creates the chart as a chart sheet. Alt+F1 embeds the chart in the current sheet.

27. Shift+F11 to Insert a worksheet

I never knew this one, but it makes sense as a corollary to F11. If F11 inserts a chart sheet, then Shift+F11 
inserts a new worksheet. You can also use Alt+I, W to insert a worksheet, Alt+I, R to insert a row, or Alt+I, C 
to insert a column. Thanks to Olga Kryuchkova.

28. alt+E, S, v to paste values

I can do Alt+E, S, V, Enter with my eyes closed. Alt+E opened the Excel 2003 Edit menu. S chose Paste 
Special. V chose Values. Enter selected OK. Thanks to Matthew Bernath and Laura Lewis.

29. alt+E, S, T to paste Formats

Alt+E, S, T, Enter pastes formats. Why t instead of f? Because Alt+E, S, F already was in use to paste formulas.

30. alt+E, S, F to paste Formulas

Alt+E, S, F, Enter pastes formulas without copying the cell formatting. This is handy to prevent cell borders 
from copying along with the formula.
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31. alt+E, S, w to paste Column widths

Alt+E, S, W pastes column widths. This is great to use with a block of columns. In the following figure. 
select A1:H1, copy, then select J1 and Alt+E, S, V, Enter to copy all 8 column widths.

32. alt+E, S, D, v to paste Special add

Alt+E, S, D, V does a Paste Special Add, but does not screw up the formatting. 

33. alt+E, S, E to Turn Data Sideways, I
Alt+E, S, E does a Transpose. To see all the possibilities, press Alt+E, S and then look for the underlined 
letters.

34. alt+T, M, S to Change Macro Security.
This shortut is really useful now that the settings are buried deep in Excel options. Thanks to Ron de Bruin.

35. alt+T, I to activate add-ins
Alt+T, I is faster than File, Options, Add-Ins, Manage Excel Add-ins, Go.

36. Ctrl+Shift+L to Enable the Filter Dropdowns
Toggle the filters on or off with Ctrl+Shift+L. In Excel 2013 and earlier, pressing Ctrl+Shift+L would scroll 
your screen to the end of the data set. Press Ctrl+Backspace to bring the active cell back in to view. Or, 
press and release Alt, A, T. Thanks to David Hager and Andrew Walker.

37. Hold Down alt to Snap to Grid
If you are drawing any shape, Alt will cause that shape to exactly line up with the borders of cells. Thanks to 

Rickard Wärnelid.

38. Ctrl+w to Close a workbook but Leave Excel Open
If you have one workbook open and you click the “X” in the top-right corner, you close Excel. Ctrl+W closes 
that workbook but leaves Excel open. Thanks to Dave Marriott.

39. F5 to Sneak into a Hidden Cell
You’ve hidden column D, but you need to see what is in D2. Press Ctrl+G or F5 to open the Go To dialog. 
Type D2 and press Enter. The cell pointer moves to the hidden cell D2, and you can see the value in the for-
mula bar. You can now use the Down Arrow key to move within the hidden column D, and you can always 
see the value in the formula bar.

40. alt+D, E, F to Convert Numbers Stored as Text to Numbers
Select a whole column and press Alt+D, E, F. The text numbers are converted to numbers. You are actually 
doing a default Text to Columns with this shortcut.

41. alt+O, C, a to autoFit a Column
Select some cells and press Alt+O, C, A to make the column wide enough for the longest value in the 
selection.
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42. Ctrl+’ to Copy the Exact Formula Down (aka Ditto)
You have to sum in D10 and average in D11. Create the AutoSum in D10. When you press Enter, you 
are in D11. Press Ctrl+’ to bring the exact formula down without changing the cell reference. If D10 is 
=SUM(D2:D9), the formula in D11 will also be =SUM(D2:D9).

From there, you can press F2, Home, Right, AVERAGE, Delete, Delete, Delete, Enter. It sounds crazy, but the 
engineers at General Electric in Cleveland swear by it.

43. Ctrl+Shift+" to Copy the Cell value from above
Use Ctrl+Shift+” to bring the value from above into the current cell, eliminating any formula.

44. Hold down alt while launching Excel to force it into a second instance

You might want each Excel workbook to have separate Undo stacks. This is one way.

45. press F2 to toggle EDIT or ENTEr while editing a formula in any dialog

Say you are typing =VLOCKUP( in the conditional formatting dialog. You press the left arrow key to go back 
to fix the typo, but Excel inserts a cell reference. Press F2 to change the lower left corner of the status bar 
from ENTER to EDIT and you can use the arrow keys to move through the formula.

46. alt+w, F, F to Freeze panes

There are hundreds more shortcuts like the ones above which you can easily learn. Press and release Alt in 
Excel to see key tips for each tab in the Ribbon (plus numbered key tips for the Quick Access Toolbar. Press 
the letter corresponding to a Ribbon tab to see the key tips for all of the commands on that tab. In this par-
ticular case, clicking Alt, W, F reveals a third level of key tips, and Alt, W, F, F completes the command. Thanks 

to Bradford Myers.

47. Ctrl+C to Copy

48. Ctrl+v to paste

49. Ctrl+X to Cut

50. Ctrl+B for Bold

51. Ctrl+I for Italics

52. Ctrl+u for underline

53. Ctrl+N for New workbook

54. Ctrl+p to print

55. Ctrl+T (or Ctrl+L) to Format as Table

56. Never Forget to right-click

Many timesavers that are linked to the right mouse button that are often forgotten. Thanks to Colin Foster. 

Hey! This is not a keyboard shortcut! But wait…it is. You can open that right-click menu by using the 
Application key on the bottom-right side of your keyboard or Shift+F10. For more on the Application key, 
see "For Those Who Prefer Using Keyboard Shortcuts" on page 124. Release the Application key and  then 
press any underlined letter to invoke the command. 
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#125 Ctrl+Click to unselect Cells

You've always had the ability to select multiple selections in 
Excel by Ctrl+Dragging to select cells. In the images below, 
you might click in B2 and drag to C6. Then Ctrl+Click in C8 
and drag to C11. Then Ctrl+Click on F2:and drag to B8. Then 
Ctrl+Click in F11.

You realize that you did not want to include F3 or F11 in the 
selection. In the past, there was no way to unselect one cell. 
You had to start all over with selecting B2:C6 and so on.

If you still have a copy of Excel 2013, try unselecting cells by 
Ctrl+Clicking them. An odd bug causes the cell to become pro-
gressively darker with each Ctrl+Click.

However - that bug was erased and new functionality 
added to Excel once a posting on Excel.UserVoice.com 
garnered 327 votes. This is a feature released in 2018 to 
Microsoft 365 subscribers. You can now Ctrl+Click on a 
cell that is in the selection and remove the cell from the 
selection.

Note: In 2021, Excel.UserVoice was replaced by 
feedbackportal.microsoft.com.

#126 Collapse the Search Box
It takes up way to much space. If you never use it, go to File, Options, General, Collapse the Microsoft 
Search Box by default. It will collapse to a magnifying glass and move to the top right of the screen.

https://feedbackportal.microsoft.com/feedback/forum/c23f3b77-f01b-ec11-b6e7-0022481f8472
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#127 More Excel Tips
More than 200 ideas were sent in for this book. While the following ideas did not get much press here, they 
are self-explanatory in a 140-character tweet.

 ● To make Excel open full-screen, right-click the Excel icon and change the Run setting to Maximized. 
-David Ringstrom, CPA

 ● Use a thin light border line to create useful scrollbar maximums when your worksheet contains charts 
that the scroll bars don’t recognize. -Chris Mack

 ● Highlight duplicate records with Conditional Formatting, Highlight Cells, Duplicate Records. -@Leaf_xl

 ● Color every other row with this conditional formatting formula: =MOD(ROW(),2)=0. -Pedro Millers

 ● Have a photo appear after a dropdown list in Excel http://t.co/TjbAtSkJ3t -Michael A. Rempel

 ● Use pictographs for charts (column and pie): Copy picture: select series, paste. -Olga Kryuchkova

 ● For a pie chart with too many slices: move small slices to second pie using Pie of Pie chart. -Olga 

Kryuchkova

 ● Use X/Y charts for drawing artwork. -Joerg Decker

 ● INDEX can return an entire row/column by using 0 for column/row. -Sumit Bansal
 ● CHOOSECOLS with negative instance number replaces INDEX but counts from the end. Two get the 2nd to last word from A1, 

use =CHOOSECOLS(TEXTSPLIT(A1," "),-2). - Diarmuid Early

 ● Put an apostrophe in front of an Excel formula to stop it from being evaluated. -@DiffEngineX

 ● DATEDIF(A2,B2,"Y")&" yrs, "&DATEDIF(A2,B2,"YM")&” mos, "&DATEDIF(A2,B2,"MD")&" days." -Paul Wright

 ● Insert rows without breaking formulas. Cell above is OFFSET(thisCell,-1,0) - Jon Wittwer, Vertex42.com

 ● Subtract 1 from NPV function to get the Net Present Value of the investment.  -Olen L. Greer

 ● Use EDATE to move the date out one month or year. -Justin Fishman

 ● Find mystery links in the Name Manager. Ta-da! -Lisa Burkett

 ● Formulas created in Notepad, saved as CSV, & opened in Excel work. Example: mike,=proper(A1) will 
give Mike. -@mdhExcel

 ● Double-click a formula. Excel color codes the cells referenced in the formula. -Cat Parkinson
 ● Turn off Edit Directly in Cell. Then double-click a formula to show cells used in that formula, even if in 

external workbook. -Sean Blessitt and David Ringstrom

 ● Go To Special, Constants helps spot constants within a block of formulas where a formula is overwrit-
ten with a number. -@HowToExcel

 ● Select a random 5% of data using =RAND()<.05. -Olga Kryuchkova

 ● Mark formulas with Conditional Formatting formula =HASFORMULA(A1). -Justin Fishman

 ● Double-click a number in a pivot to get the detail behind that number. -@Sheet1

 ● Array formula to count without COUNT: =SUM(IF(ISNUMBER(MyRange),1,0)). -Meni Porat

 ● In VBA, use Range("A1").CurrentRegion instead of RANGE(). It is like pressing Ctrl+*. -Arnout Brandt

 ● You can use hyperlinks to launch VBA macros. Smaller than buttons. -Cecelia Rieb

 ● Use a macro to color the heading cells that have filters applied. -Peter Edwards

 ● Use Environ("UserName") in VBA code for restricting workbook access. -Angelina Teneva

 ● Use a UDF in a hyperlink to change cells mrx.cl/udfhyperlink -Jordan Goldmeier

 ● There are a variety of games written in Excel (2048, MissileCommand, pleuroku, TowerDefense, Pac-
Man, Rubic’s Cube,  Yahtzee, Tetris). -Olga Kryuchkova

 ● POINT mode in Excel lets you build a formula using arrow keys to point to cells or ranges. If this stops 
working, see if you inadvertently pressed ScrLk key. You will see SCROLL LOCK near left side of Status 
Bar. (ScrLk is near PrtScrn and Break keys). -Vijay Krishnan

http://t.co/TjbAtSkJ3t
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#128 Excel Stories

Live – On Stage – In person: The power Excel Seminars

That poster from Hatch Show Print  on my website sort of started out as a joke. I was flying through 
Nashville and saw a display of old country 
music letterpress posters on the wall. The 
little sign by the posters said they were pro-
duced on a 100-year-old hand-cranked 
press and that the company was still operat-
ing in Nashville. I called them and hired 
them to produce a “concert” poster for my 
live Excel seminars. They had to think I was a 
little nuts. The print shop manager, Jim 
Sherraden, often did an informative presen-
tation about the history of Hatch, and he 
cited my poster as the first to list a website 
URL.

I do my half-day or 1-day seminar for ac-
counting groups across the country. Every 
large city has a local chapter of the Institute 
of Managerial Accountants or the Institute 
of Internal Auditors. The people who belong 

to these groups usually need 20-30 hours of continuing education (CPE) each year. If you join the organi-
zation and go to 12 lunch meetings, half of your CPE is done. The organizations will often sponsor a 1- or 
2-day event with speakers so their members can earn the remaining CPE at one time. I often am invited 
to speak at these events. The poster on the door lets people know that they are not in for the usual tax 
update. (I don’t mean to offend the wonderful people going through the new tax laws…someone’s got to 
do that.)

Excel is used on 750 million devices. I’ve met a lady in Appalachia who used Excel to design original quilt 
patterns. I’ve met people who have designed workbooks in Excel that train people how to fly 737 jets. 
From quilts to jets, Excel is used everywhere. 

When you hand the world’s most flexible software to 750 million people, everyone finds interesting things 
to do or interesting ways to use Excel. I love traveling to do the in-person Excel seminars because I get to 
meet these people. At every seminar, someone has an interesting story of how they are using Excel. At 
every seminar, I always learn a few new Excel tricks from the people in the seminar. I joke that my job is col-
lecting the cool and obscure tricks in Excel from people along the road and passing them on to people fur-
ther on up the road. Many of the amazing tricks in this book came from people in my live Excel seminars.

This is truly a win-win. I have fun doing the seminars. The audience get to take home a cool Excel book. 
Among the 75 tricks that I show in a day, hopefully everyone will find a few that they can take back to work 
to start becoming more efficient the next day. Plus, people earn the CPE hours without hearing about any 
tax updates. Even at the Association for Computers and Taxation, where their annual meeting is all about 
tax updates, they bring me in to do a 2-hour session to offer a little levity between the tax updates!
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The Excel Guru Mission patch

Do you own a the highly-coveted Excel Guru mission patch?

When I do my live Power Excel seminars, I always encourage the audience to “show me up.” Someone in 
that room is going to have a better way to do something in Excel. I used to  offer a small prize to the first 
person to teach me something during the seminar. I would also predict that the first person to show me 
up that day walked into the room and sat in row 2.

I have no idea why they often sit in row 2. But I noticed early on that the best Exceller often chooses a seat 
in row 2. They want to be close. But not front-row close. Almost every time, the first cool idea from the 
audience comes to row 2. (On the times when the first tip comes from another row, I quip, “Did you arrive 
late, and row 2 was already full?”)

Over the years, the prize varied from a laminated tip card to an Excel Master enamel pin. The current prize 
is an embroidered Excel Guru patch designed by the same guy who designs mission patches for Cape 
Canaveral rocket launches.
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as Seen in the wall Street Journal: the Excel Function Clock

It was a Friday afternoon at work and time was dragging. I would look at the clock, do some VLOOKUPs, 
then look back at the clock and barely a minute had passed.

it struck me that it would be funny if someone made a clock where the 3 was replaced with the Excel func-
tion =PI(). This simple function with no arguments returns 3.14. So, =PI() wouldn't be exactly at 3. It would 
have to be just a bit beyond the 3. The solution would be to use the INT function to return just the integer 
portion of PI(). =INT(PI()) returns just 3. Perfect! I am sure I pitched both of these ideas to Kevin Adkins, who 
probably didn't think it was a funny as I did. That never deters me, though.

After writing all 12 functions, I actually found the graphic designer who designed the clocks for the old 
Signals mail order catalog. The Excel function clock was on Call For Help a few times. Once, Leo Laporte at-
tached it to a lanyard and wore the clock as if he were rapper Flavor Flav. It was funny stuff. 

The clock became famous, though, in 2017 when it was featured in a Wall Street Journal article about the 
CFO of PF Changs saying he was going to dump Excel. People were furious and the WSJ ran a follow-up ar-
ticle with a quote by me and also a picture of my clock. I sold a lot of clocks that week!

Here are the 12 formulas:

1. =MIN(1,10). Min returns the minimum number. Since 1<10, the function returns 1.

2. =MONTH(23790). That is the serial number for my birthday, February 17, 1965. That is month number 2.

3. =INT(PI()).  =PI() would've been 1/7 of the way past 3, so =INT returns the integer 3.

4. =LEN("FOUR"). I used LEN daily. =MID(A2,LEN(A2)-7,2) gets the last 2 characters. How long is FOUR? 4.

5. =SQRT(25). The square root of 25 is 5.

6. =FACT(3). Factorials are used to calculate lottery probability. The Factorial of 3 is 3x2x1 or 6.

7. =GCD(77,49). Middle school match is simpler with Excel. The greatest common divisor of 77 and 49 is 7

8. =2^3. The ^ raises 2 to the 3 power. =2*2*2 is 8.

9. =PMT(9%,9,-53.96). If you borrowed $53.96 from the bank to buy some MrExcel books and had to pay it 
back over 9 years with a 9% interest rate, each yearly payment would be $9.

10. =LCM(2,5). Another one for the 7th graders. The Lowest Common Multiple of 2 and 5 is 10.

11. =ROMAN(2). Hmm. My fascination with =ROMAN() began before my 40th book. The =ROMAN(2) is II, 
which looks sort of like 11. Just like XL sounds sort of like Excel.

12. =COLUMN(L1). tells you the column number of a cell. L is column number 12.

If you are thinking you need to get one of these for yourself, head over to mrx.cl/excelclock.
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The MrExcel Message Board Community answered 1 Million Excel Questions

When I launched MrExcel.com in November 1998, I would get up every morning and answers yesterday's 
e-mailed questions before heading in to work. Initially, it was a question or two each weekday. But, by May 
1999, I was getting more questions than I could answer in an hour. I was answering questions from 5 AM 
to 6 AM and then heading in to work. I either had to start getting up at 4 AM or find another way.

I downloaded WWWBoard from Matt’s Script Archive. I asked people to post their question at the message 
board. And I asked that, after posting, they look at the last few questions to see if they could help someone 
else out. It was like the take-a-penny, leave-a-penny tray at a cash register. If you need help, post a ques-
tion. If you can help someone else out, help them out. It worked. People started posting and answering 
questions.

In the early days, I noticed a few people would stop by almost every day and answer a question or two. 
Ivan F. Moala. Cecilia. The late Dave Hawley.

One day, at work. I was stumped. I went out to my own message board, and described my problem. An 
hour later, Ivan F. Moala from New Zealand had posted an amazing answer. I knew I had something.

The board transformed over the years, morphing into bigger platforms. I was on a $10-a-month hosting 
plan at Pair Networks in Pittsburgh. One day, I get a call from them wondering what I was doing. “You are 
on a $10-a-month plan, but you are using as much traffic as our $1,000-a-month plan!” Apparently, the 
MrExcel Message Board had taken on a life of its own.

Today, the amazing people at the MrExcel Message Board have answered 1 million questions about Excel. 
We’ve attempted to keep every question live on the site. There are some massive competitors (I won't 
name them, but their anagram is "is Comfort" or "of Mr Stoic") who have competing forums, but they have 
no problem wiping out their history. I run into people all the time who say they use my forum. I ask what 
their UserID is. “Oh – I’ve never had to post – I just search. Every answer is already there.”

The MrExcel community is staffed by volunteers. Over the years, various experts have worked tirelessly 
as moderators and administrators. My sincere thanks to Andrew Poulsom, barry houdini, Colo, fairwinds, 
Ivan F Moala, Joe4, Jon von der Heyden, Juan Pablo Gonzalez, NateO, PaddyD, Peter_SSs, Richard Schollar, 
RoryA, Scott Huish, Smitty, Starl, SydneyGeek, VoG, Von Pookie, zenou, and Zack Barresse.  
Suat Ozgur and Scott Pierson handled the tech issues with the board.

As far as the people answering questions, 45 people have answered more than 10,000 questions at the 
board. This is a staggering contribution to the Excel community. Thanks to Aladin Akyurek with 85,000 
posts. Norie and Andrew Poulsom have over 70,000 posts each. VoG has over 63,000 posts. Others with 
over 10K posts: Joe4, Jonmo1, Peter SSs, Rick Rothstein, RoryA, Fluff, Smitty, Richard Schollar, mikerickson, 
shg, barry houdini, Scott Huish, pgc01, Domenic, erik.van.geit, Michael M, hiker95, jindon, JoeMo, T. Valko, 
xenou, Marcelo Branco, AlphaFrog, My Aswer Is This, MickG, PaddyD, lenze, Von Pookie, SydneyGeek, Juan 
Pablo Gonzalez, Mark W., Yogi Anand, MARK858, Tom Urtis, JLGWhiz, GlennUK, tusharm, oldbrewer, Zack 
Barresse, Jon von der Heyden, just jon, and Greg Truby, and Mole999. Many of the experts at MrExcel.com 
are awarded the MVP Award in Excel from Microsoft.

If you ask Google any Excel question, the odds are pretty good that one of the top answers will be from 
MrExcel. If you can’t find your answer on Google, it is free to post a new question. Make sure to give the 
post a title that describes what you are trying to do. Even in the middle of the night, someone will likely 
have an answer.

In late 2019, the message board was migrated to a modern Xenforo platform, complete with the ability to 
post screenshots of your Excel problem.
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How to post your Question to the MrExcel Forum

Here are a few tips to getting an answer quickly at the MrExcel forum.

1. Before posting, do a Search. With a million threads, it is likely someone has had this problem before. You 
do not have to register to search.

2. In order to post, you have to Register. Give yourself a clever name such as XLGoddess or VLOOKUPKing. 
We ask for your e-mail address for password resets. I am not doing this to spam you. I won't spam you (be-
cause I can't figure out how to spam this many people without getting thrown off the Internet). We used 
to allow "Anonymous" to post to the board, but when five different "Anonymous" started posting in the 
same thread, it became impossible to follow the conversation. After registering, click the link in the confir-
mation e-mail that we send.

3. Start in the Excel Questions forum (there are other forums for Access, Power BI, and so on).

4. Click the Post Thread button in the top right.

5. Include a meaningful title that is specific to your question. Here is an example of a good title: "Excel VBA 
Type Mismatch Error". Your goal with the title is to get an expert to be interested in your question. Titles 
such as "Excel Help" or "Help" are not useful.

6. State your question clearly, including your entire need at the start.

7. Add some representative sample data - actual data is much better than an image. There are free tools to 
help you post your data to the board. See "How to Show Your Worksheet in a Post" below.

8. Tell us what formula/code you have currently, and why your results are not what you want.

9. Include which version of Excel and Operating System you are using.

10. If you are looking for help with an error received, what is the actual error message and where exactly 
does it occur?

11. Before posting, read your question back to yourself to check it will make sense to somebody unfamiliar 
with your worksheet.

12. If the answer you receive is inadequate for some reason, post a reply stating why the answer does not 
work and/or with more information (if needed) in the same thread.

If one or more posts were particularly helpful, click the Like button on that post. Getting Likes increases a 
person's reputation.

How to Show your worksheet in a post

There are two ways to show your worksheet when posting to the MrExcel Message Board. First, you can 
use any screen clipping tool, copy a portion of the screen to your clipboard, then paste it into a post at the 
board. While pasting a picture can allow someone to see what is going on, in many cases, the volunteer 
who is going to answer your question will want to test some formulas in Excel, and a picture forces them 

https://www.mrexcel.com/board/help/searching-in-the-board/
https://www.mrexcel.com/board/register/
https://www.mrexcel.com/board/forums/excel-questions.10/
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to re-create your worksheet. Instead, our awesome web developer, Suat Ozgur has produced a free Excel 
add-in called XL2BB which allows you to post your worksheet to the board and allows the volunteer to 
then copy this data to Excel.

1. Download XL2BB and install following the instructions at http://mrx.cl/XL2BB.

2. You will see a new xl2BB tab in the Ribbon.

3. Select the portion of the worksheet you would like to share and click Mini Sheet. 

4. Switch back to the MrExcel forum and Ctrl+V to paste the code into your question. Initially, it will be a 
scary-looking bunch of codes, like this:

6. Click the Preview button
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7. And you will see a version of your worksheet:

Here is why going to these extra steps will get you a better answer. When you post your worksheet to the 
board, the volunteer Excel experts love this view of the data for several reasons:

1. They can hover over any value in a cell with a yellow triangle to see the formula in that cell. 

2. If they click the value, the formula is displayed in the formula bar and automatically copied to the clip-
board so the volunteer expert can paste it into their copy of Excel.

3. If they click the "Select All" icon above and to the left of cell A1, the code for the worksheet is copied to 
the clipboard. They can then paste this code to a blank workbook and test their formula ideas.
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#129 Excel Function Quick reference
This is an alphabetical listing of Excel's functions as of March 2021.
ABS - Returns the absolute value of a number (Math and trigonometry)
ACCRINT - Returns the accrued interest for a security that pays periodic interest (Financial)
ACCRINTM - Returns the accrued interest for a security that pays interest at maturity (Financial)
ACOS - Returns the arccosine of a number (Math and trigonometry)
ACOSH - Returns the inverse hyperbolic cosine of a number (Math and trigonometry)
ACOT - Returns the arccotangent of a number (Math and trigonometry)
ACOTH - Returns the hyperbolic arccotangent of a number (Math and trigonometry)
ADDRESS - Returns a reference as text to a single cell in a worksheet (Lookup and reference)
AGGREGATE - Returns an aggregate in a list or database (Math and trigonometry)
AMORDEGRC - Returns the depreciation for each accounting period by using a depreciation coefficient (Financial)
AMORLINC - Returns the depreciation for each accounting period (Financial)
AND - Returns TRUE if all of its arguments are TRUE (Logical)
ARABIC - Converts a Roman number to Arabic, as a number (Math and trigonometry)
AREAS - Returns the number of areas in a reference (Lookup and reference)
ARRAYTOTEXT - Returns an array of text values from any specified range (Text)
ASC - Changes full-width (double-byte) English letters or katakana within a character string to half-width (single-byte) characters 
(Text)
ASIN - Returns the arcsine of a number (Math and trigonometry)
ASINH - Returns the inverse hyperbolic sine of a number (Math and trigonometry)
ATAN - Returns the arctangent of a number (Math and trigonometry)
ATAN2 - Returns the arctangent from x- and y-coordinates (Math and trigonometry)
ATANH - Returns the inverse hyperbolic tangent of a number (Math and trigonometry)
AVEDEV - Returns the average of the absolute deviations of data points from their mean (Statistical)
AVERAGE - Returns the average of its arguments (Statistical)
AVERAGEA - Returns the average of its arguments, including numbers, text, and logical values (Statistical)
AVERAGEIF - Returns the average (arithmetic mean) of all the cells in a range that meet a given criteria (Statistical)
AVERAGEIFS - Returns the average (arithmetic mean) of all cells that meet multiple criteria. (Statistical)
BAHTTEXT - Converts a number to text, using the ß (baht) currency format (Text)
BASE - Converts a number into a text representation with the given radix (base) (Math and trigonometry)
BESSELI - Returns the modified Bessel function In(x) (Engineering)
BESSELJ - Returns the Bessel function Jn(x) (Engineering)
BESSELK - Returns the modified Bessel function Kn(x) (Engineering)
BESSELY - Returns the Bessel function Yn(x) (Engineering)
BETA.DIST - Returns the beta cumulative distribution function (Statistical)
BETA.INV - Returns the inverse of the cumulative distribution function for a specified beta distribution (Statistical)
BETADIST - Returns the beta cumulative distribution functionIn Excel 2007, this is a Statistical function. (Compatibility)
BETAINV - Returns the inverse of the cumulative distribution function for a specified beta distributionIn Excel 2007, this is a 
Statistical function. (Compatibility)
BIN2DEC - Converts a binary number to decimal (Engineering)
BIN2HEX - Converts a binary number to hexadecimal (Engineering)
BIN2OCT - Converts a binary number to octal (Engineering)
BINOM.DIST - Returns the individual term binomial distribution probability (Statistical)
BINOM.DIST.RANGE - Returns the probability of a trial result using a binomial distribution (Statistical)
BINOM.INV - Returns the smallest value for which the cumulative binomial distribution is less than or equal to a criterion value 
(Statistical)
BINOMDIST - Returns the individual term binomial distribution probabilityIn Excel 2007, this is a Statistical function. 
(Compatibility)
BITAND - Returns a 'Bitwise And' of two numbers (Engineering)
BITLSHIFT - Returns a value number shifted left by shift_amount bits (Engineering)
BITOR - Returns a bitwise OR of 2 numbers (Engineering)
BITRSHIFT - Returns a value number shifted right by shift_amount bits (Engineering)
BITXOR - Returns a bitwise 'Exclusive Or' of two numbers (Engineering)
BYCOL - Applies a LAMBDA to each column and returns an array of the results. For example, if the original array is 3 columns by 2 
rows, the returned array is 3 columns by 1 row. (Logical)
BYROW - Applies a LAMBDA to each row and returns an array of the results. For example, if the original array is 3 columns by 2 
rows, the returned array is 1 column by 2 rows.  (Logical)
CALL - Calls a procedure in a dynamic link library or code resource (Add-in and Automation)
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CEILING - Rounds a number to the nearest integer or to the nearest multiple of significance (Compatibility)
CEILING.MATH - Rounds a number up, to the nearest integer or to the nearest multiple of significance (Math and trigonometry)
CEILING.PRECISE - Rounds a number the nearest integer or to the nearest multiple of significance. Regardless of the sign of the 
number, the number is rounded up. (Math and trigonometry)
CELL - Returns information about the formatting, location, or contents of a cellThis function is not available in Excel for the web. 
(Information)
CHAR - Returns the character specified by the code number (Text)
CHIDIST - Returns the one-tailed probability of the chi-squared distributionNote: In Excel 2007, this is a Statistical function. 
(Compatibility)
CHIINV - Returns the inverse of the one-tailed probability of the chi-squared distributionNote: In Excel 2007, this is a Statistical 
function. (Compatibility)
CHISQ.DIST - Returns the cumulative beta probability density function (Statistical)
CHISQ.DIST.RT - Returns the one-tailed probability of the chi-squared distribution (Statistical)
CHISQ.INV - Returns the cumulative beta probability density function (Statistical)
CHISQ.INV.RT - Returns the inverse of the one-tailed probability of the chi-squared distribution (Statistical)
CHISQ.TEST - Returns the test for independence (Statistical)
CHITEST - Returns the test for independenceNote: In Excel 2007, this is a Statistical function. (Compatibility)
CHOOSE - Chooses a value from a list of values (Lookup and reference)
CHOOSECOLS - Returns an array containing just the rows specified. (Lookup)
CHOOSEROWS -  Returns an array containing just the columns specified. (Text)
CLEAN - Removes all nonprintable characters from text (Text)
CODE - Returns a numeric code for the first character in a text string (Text)
COLUMN - Returns the column number of a reference (Lookup and reference)
COLUMNS - Returns the number of columns in a reference (Lookup and reference)
COMBIN - Returns the number of combinations for a given number of objects (Math and trigonometry)
COMBINA - Returns the number of combinations with repetitions for a given number of items (Math and trigonometry)
COMPLEX - Converts real and imaginary coefficients into a complex number (Engineering)
CONCAT - Combines the text from multiple ranges and/or strings, but it doesn't provide the delimiter or IgnoreEmpty arguments. 
(Text)
CONCATENATE - Joins several text items into one text item (Text)
CONFIDENCE - Returns the confidence interval for a population meanIn Excel 2007, this is a Statistical function. (Compatibility)
CONFIDENCE.NORM - Returns the confidence interval for a population mean (Statistical)
CONFIDENCE.T - Returns the confidence interval for a population mean, using a Student's t distribution (Statistical)
CONVERT - Converts a number from one measurement system to another (Engineering)
CORREL - Returns the correlation coefficient between two data sets (Statistical)
COS - Returns the cosine of a number (Math and trigonometry)
COSH - Returns the hyperbolic cosine of a number (Math and trigonometry)
COT - Returns the hyperbolic cosine of a number (Math and trigonometry)
COTH - Returns the cotangent of an angle (Math and trigonometry)
COUNT - Counts how many numbers are in the list of arguments (Statistical)
COUNTA - Counts how many values are in the list of arguments (Statistical)
COUNTBLANK - Counts the number of blank cells within a range (Statistical)
COUNTIF - Counts the number of cells within a range that meet the given criteria (Statistical)
COUNTIFS - Counts the number of cells within a range that meet multiple criteria (Statistical)
COUPDAYBS - Returns the number of days from the beginning of the coupon period to the settlement date (Financial)
COUPDAYS - Returns the number of days in the coupon period that contains the settlement date (Financial)
COUPDAYSNC - Returns the number of days from the settlement date to the next coupon date (Financial)
COUPNCD - Returns the next coupon date after the settlement date (Financial)
COUPNUM - Returns the number of coupons payable between the settlement date and maturity date (Financial)
COUPPCD - Returns the previous coupon date before the settlement date (Financial)
COVAR - Returns covariance, the average of the products of paired deviationsIn Excel 2007, this is a Statistical function. 
(Compatibility)
COVARIANCE.P - Returns covariance, the average of the products of paired deviations (Statistical)
COVARIANCE.S - Returns the sample covariance, the average of the products deviations for each data point pair in two data sets 
(Statistical)
CRITBINOM - Returns the smallest value for which the cumulative binomial distribution is less than or equal to a criterion valueIn 
Excel 2007, this is a Statistical function. (Compatibility)
CSC - Returns the cosecant of an angle (Math and trigonometry)
CSCH - Returns the hyperbolic cosecant of an angle (Math and trigonometry)
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CUBEKPIMEMBER - Returns a key performance indicator (KPI) name, property, and measure, and displays the name and property 
in the cell. A KPI is a quantifiable measurement, such as monthly gross profit or quarterly employee turnover, used to monitor an 
organization's performance. (Cube)
CUBEMEMBER - Returns a member or tuple in a cube hierarchy. Use to validate that the member or tuple exists in the cube. (Cube)
CUBEMEMBERPROPERTY - Returns the value of a member property in the cube. Use to validate that a member name exists within 
the cube and to return the specified property for this member. (Cube)
CUBERANKEDMEMBER - Returns the nth, or ranked, member in a set. Use to return one or more elements in a set, such as the top 
sales performer or top 10 students. (Cube)
CUBESET - Defines a calculated set of members or tuples by sending a set expression to the cube on the server, which creates the 
set, and then returns that set to Microsoft Office Excel. (Cube)
CUBESETCOUNT - Returns the number of items in a set. (Cube)
CUBEVALUE - Returns an aggregated value from a cube. (Cube)
CUMIPMT - Returns the cumulative interest paid between two periods (Financial)
CUMPRINC - Returns the cumulative principal paid on a loan between two periods (Financial)
DATE - Returns the serial number of a particular date (Date and time)
DATEDIF - Calculates the number of days, months, or years between two dates. This function is useful in formulas where you need 
to calculate an age. (Date and time)
DATEVALUE - Converts a date in the form of text to a serial number (Date and time)
DAVERAGE - Returns the average of selected database entries (Database)
DAY - Converts a serial number to a day of the month (Date and time)
DAYS - Returns the number of days between two dates (Date and time)
DAYS360 - Calculates the number of days between two dates based on a 360-day year (Date and time)
DB - Returns the depreciation of an asset for a specified period by using the fixed-declining balance method (Financial)
DBCS - Changes half-width (single-byte) English letters or katakana within a character string to full-width (double-byte) characters 
(Text)
DCOUNT - Counts the cells that contain numbers in a database (Database)
DCOUNTA - Counts nonblank cells in a database (Database)
DDB - Returns the depreciation of an asset for a specified period by using the double-declining balance method or some other 
method that you specify (Financial)
DEC2BIN - Converts a decimal number to binary (Engineering)
DEC2HEX - Converts a decimal number to hexadecimal (Engineering)
DEC2OCT - Converts a decimal number to octal (Engineering)
DECIMAL - Converts a text representation of a number in a given base into a decimal number (Math and trigonometry)
DEGREES - Converts radians to degrees (Math and trigonometry)
DELTA - Tests whether two values are equal (Engineering)
DEVSQ - Returns the sum of squares of deviations (Statistical)
DGET - Extracts from a database a single record that matches the specified criteria (Database)
DISC - Returns the discount rate for a security (Financial)
DMAX - Returns the maximum value from selected database entries (Database)
DMIN - Returns the minimum value from selected database entries (Database)
DOLLAR - Converts a number to text, using the $ (dollar) currency format (Text)
DOLLARDE - Converts a dollar price, expressed as a fraction, into a dollar price, expressed as a decimal number (Financial)
DOLLARFR - Converts a dollar price, expressed as a decimal number, into a dollar price, expressed as a fraction (Financial)
DPRODUCT - Multiplies the values in a particular field of records that match the criteria in a database (Database)
DROP - Excludes a specified number of contiguous rows or columns from the start or end of an array. (Lookup)
DSTDEV - Estimates the standard deviation based on a sample of selected database entries (Database)
DSTDEVP - Calculates the standard deviation based on the entire population of selected database entries (Database)
DSUM - Adds the numbers in the field column of records in the database that match the criteria (Database)
DURATION - Returns the annual duration of a security with periodic interest payments (Financial)
DVAR - Estimates variance based on a sample from selected database entries (Database)
DVARP - Calculates variance based on the entire population of selected database entries (Database)
EDATE - Returns the serial number of the date that is the indicated number of months before or after the start date (Date and time)
EFFECT - Returns the effective annual interest rate (Financial)
ENCODEURL - Returns a URL-encoded stringThis function is not available in Excel for the web. (Web)
EOMONTH - Returns the serial number of the last day of the month before or after a specified number of months (Date and time)
ERF - Returns the error function (Engineering)
ERF.PRECISE - Returns the error function (Engineering)
ERFC - Returns the complementary error function (Engineering)
ERFC.PRECISE - Returns the complementary ERF function integrated between x and infinity (Engineering)
ERROR.TYPE - Returns a number corresponding to an error type (Information)
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EUROCONVERT - Converts a number to euros, converts a number from euros to a euro member currency, or converts a number 
from one euro member currency to another by using the euro as an intermediary (triangulation). (Add-in and Automation)
EVEN - Rounds a number up to the nearest even integer (Math and trigonometry)
EXACT - Checks to see if two text values are identical (Text)
EXP - Returns e raised to the power of a given number (Math and trigonometry)
EXPAND - Expands or pads an array to specified row and column dimensions.  (Lookup)
EXPON.DIST - Returns the exponential distribution (Statistical)
EXPONDIST - Returns the exponential distributionIn Excel 2007, this is a Statistical function. (Compatibility)
F.DIST - Returns the F probability distribution (Statistical)
F.DIST.RT - Returns the F probability distribution (Statistical)
F.INV - Returns the inverse of the F probability distribution (Statistical)
F.INV.RT - Returns the inverse of the F probability distribution (Statistical)
F.TEST - Returns the result of an F-test (Statistical)
FACT - Returns the factorial of a number (Math and trigonometry)
FACTDOUBLE - Returns the double factorial of a number (Math and trigonometry)
FALSE - Returns the logical value FALSE (Logical)
FDIST - Returns the F probability distributionIn Excel 2007, this is a Statistical function. (Compatibility)
FILTER - Filters a range of data based on criteria you define (Lookup and reference)
FILTERXML - Returns specific data from the XML content by using the specified XPathThis function is not available in Excel for the 
web. (Web)
FIND, FINDBs - Finds one text value within another (case-sensitive) (Text)
FINV - Returns the inverse of the F probability distributionIn Excel 2007this is a Statistical function. (Compatibility)
FISHER - Returns the Fisher transformation (Statistical)
FISHERINV - Returns the inverse of the Fisher transformation (Statistical)
FIXED - Formats a number as text with a fixed number of decimals (Text)
FLOOR - Rounds a number down, toward zeroIn Excel 2007 and Excel 2010, this is a Math and trigonometry function. 
(Compatibility)
FLOOR.MATH - Rounds a number down, to the nearest integer or to the nearest multiple of significance (Math and trigonometry)
FLOOR.PRECISE - Rounds a number the nearest integer or to the nearest multiple of significance. Regardless of the sign of the 
number, the number is rounded up. (Math and trigonometry)
FORECAST - Returns a value along a linear trendIn Excel 2016, this function is replaced with FORECAST.LINEAR as part of the new 
Forecasting functions, but it's still available for compatibility with earlier versions. (Statistical)
FORECAST.ETS - Returns a future value based on existing (historical) values by using the AAA version of the Exponential 
Smoothing (ETS) algorithm (Statistical)
FORECAST.ETS.CONFINT - Returns a confidence interval for the forecast value at the specified target date (Statistical)
FORECAST.ETS.SEASONALITY - Returns the length of the repetitive pattern Excel detects for the specified time series (Statistical)
FORECAST.ETS.STAT - Returns a statistical value as a result of time series forecasting (Statistical)
FORECAST.LINEAR - Returns a future value based on existing values (Statistical)
FORMULATEXT - Returns the formula at the given reference as text (Lookup and reference)
FREQUENCY - Returns a frequency distribution as a vertical array (Statistical)
FTEST - Returns the result of an F-testIn Excel 2007, this is a Statistical function. (Compatibility)
FV - Returns the future value of an investment (Financial)
FVSCHEDULE - Returns the future value of an initial principal after applying a series of compound interest rates (Financial)
GAMMA - Returns the Gamma function value (Statistical)
GAMMA.DIST - Returns the gamma distribution (Statistical)
GAMMA.INV - Returns the inverse of the gamma cumulative distribution (Statistical)
GAMMADIST - Returns the gamma distributionIn Excel 2007, this is a Statistical function. (Compatibility)
GAMMAINV - Returns the inverse of the gamma cumulative distributionIn Excel 2007, this is a Statistical function. (Compatibility)
GAMMALN - Returns the natural logarithm of the gamma function, Γ(x) (Statistical)
GAMMALN.PRECISE - Returns the natural logarithm of the gamma function, Γ(x) (Statistical)
GAUSS - Returns 0.5 less than the standard normal cumulative distribution (Statistical)
GCD - Returns the greatest common divisor (Math and trigonometry)
GEOMEAN - Returns the geometric mean (Statistical)
GESTEP - Tests whether a number is greater than a threshold value (Engineering)
GETPIVOTDATA - Returns data stored in a PivotTable report (Lookup and reference)
GROWTH - Returns values along an exponential trend (Statistical)
HARMEAN - Returns the harmonic mean (Statistical)
HEX2BIN - Converts a hexadecimal number to binary (Engineering)
HEX2DEC - Converts a hexadecimal number to decimal (Engineering)
HEX2OCT - Converts a hexadecimal number to octal (Engineering)
HLOOKUP - Looks in the top row of an array and returns the value of the indicated cell (Lookup and reference)
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HOUR - Converts a serial number to an hour (Date and time)
HSTACK - HSTACK returns the array formed by appending each of the array arguments in a column-wise fashion. (Lookup)
HYPERLINK - Creates a shortcut or jump that opens a document stored on a network server, an intranet, or the Internet (Lookup 
and reference)
HYPGEOM.DIST - Returns the hypergeometric distribution (Statistical)
HYPGEOMDIST - Returns the hypergeometric distributionIn Excel 2007, this is a Statistical function. (Compatibility)
IF - Specifies a logical test to perform (Logical)
IFERROR - Returns a value you specify if a formula evaluates to an error; otherwise, returns the result of the formula (Logical)
IFNA - Returns the value you specify if the expression resolves to #N/A, otherwise returns the result of the expression (Logical)
IFS - Checks whether one or more conditions are met and returns a value that corresponds to the first TRUE condition. (Logical)
IMABS - Returns the absolute value (modulus) of a complex number (Engineering)
IMAGINARY - Returns the imaginary coefficient of a complex number (Engineering)
IMARGUMENT - Returns the argument theta, an angle expressed in radians (Engineering)
IMCONJUGATE - Returns the complex conjugate of a complex number (Engineering)
IMCOS - Returns the cosine of a complex number (Engineering)
IMCOSH - Returns the hyperbolic cosine of a complex number (Engineering)
IMCOT - Returns the cotangent of a complex number (Engineering)
IMCSC - Returns the cosecant of a complex number (Engineering)
IMCSCH - Returns the hyperbolic cosecant of a complex number (Engineering)
IMDIV - Returns the quotient of two complex numbers (Engineering)
IMEXP - Returns the exponential of a complex number (Engineering)
IMLN - Returns the natural logarithm of a complex number (Engineering)
IMLOG10 - Returns the base-10 logarithm of a complex number (Engineering)
IMLOG2 - Returns the base-2 logarithm of a complex number (Engineering)
IMPOWER - Returns a complex number raised to an integer power (Engineering)
IMPRODUCT - Returns the product of complex numbers (Engineering)
IMREAL - Returns the real coefficient of a complex number (Engineering)
IMSEC - Returns the secant of a complex number (Engineering)
IMSECH - Returns the hyperbolic secant of a complex number (Engineering)
IMSIN - Returns the sine of a complex number (Engineering)
IMSINH - Returns the hyperbolic sine of a complex number (Engineering)
IMSQRT - Returns the square root of a complex number (Engineering)
IMSUB - Returns the difference between two complex numbers (Engineering)
IMSUM - Returns the sum of complex numbers (Engineering)
IMTAN - Returns the tangent of a complex number (Engineering)
INDEX - Uses an index to choose a value from a reference or array (Lookup and reference)
INDIRECT - Returns a reference indicated by a text value (Lookup and reference)
INFO - Returns information about the current operating environmentThis function is not available in Excel for the web. 
(Information)
INT - Rounds a number down to the nearest integer (Math and trigonometry)
INTERCEPT - Returns the intercept of the linear regression line (Statistical)
INTRATE - Returns the interest rate for a fully invested security (Financial)
IPMT - Returns the interest payment for an investment for a given period (Financial)
IRR - Returns the internal rate of return for a series of cash flows (Financial)
ISBLANK - Returns TRUE if the value is blank (Information)
ISERR - Returns TRUE if the value is any error value except #N/A (Information)
ISERROR - Returns TRUE if the value is any error value (Information)
ISEVEN - Returns TRUE if the number is even (Information)
ISFORMULA - Returns TRUE if there is a reference to a cell that contains a formula (Information)
ISLOGICAL - Returns TRUE if the value is a logical value (Information)
ISNA - Returns TRUE if the value is the #N/A error value (Information)
ISNONTEXT - Returns TRUE if the value is not text (Information)
ISNUMBER - Returns TRUE if the value is a number (Information)
ISO.CEILING - Returns a number that is rounded up to the nearest integer or to the nearest multiple of significance (Math and 
trigonometry)
ISODD - Returns TRUE if the number is odd (Information)
ISOMITTED - Checks whether the value in a LAMBDA is missing and returns TRUE or FALSE.  (Information)
ISOWEEKNUM - Returns the number of the ISO week number of the year for a given date (Date and time)
ISPMT - Calculates the interest paid during a specific period of an investment (Financial)
ISREF - Returns TRUE if the value is a reference (Information)
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ISTEXT - Returns TRUE if the value is text (Information)
JIS - Changes half-width (single-byte) characters within a string to full-width (double-byte) characters (Text)
KURT - Returns the kurtosis of a data set (Statistical)
LARGE - Returns the k-th largest value in a data set (Statistical)
LCM - Returns the least common multiple (Math and trigonometry)
LEFT, LEFTBs - Returns the leftmost characters from a text value (Text)
LEN, LENBs - Returns the number of characters in a text string (Text)
LET - Assigns names to calculation results to allow storing intermediate calculations, values, or defining names inside a formula 
(Math and trigonometry)
LINEST - Returns the parameters of a linear trend (Statistical)
LN - Returns the natural logarithm of a number (Math and trigonometry)
LOG - Returns the logarithm of a number to a specified base (Math and trigonometry)
LOG10 - Returns the base-10 logarithm of a number (Math and trigonometry)
LOGEST - Returns the parameters of an exponential trend (Statistical)
LOGINV - Returns the inverse of the lognormal cumulative distribution (Compatibility)
LOGNORM.DIST - Returns the cumulative lognormal distribution (Statistical)
LOGNORM.INV - Returns the inverse of the lognormal cumulative distribution (Statistical)
LOGNORMDIST - Returns the cumulative lognormal distribution (Compatibility)
LOOKUP - Looks up values in a vector or array (Lookup and reference)
LOWER - Converts text to lowercase (Text)
MAKEARRAY - Returns a calculated array of a specified row and column size, by applying a LAMBDA. (Logical)
MAP - Returns an array formed by mapping each value in the array(s) to a new value by applying a LAMBDA to create a new value.  
(Logical)
MATCH - Looks up values in a reference or array (Lookup and reference)
MAX - Returns the maximum value in a list of arguments (Statistical)
MAXA - Returns the maximum value in a list of arguments, including numbers, text, and logical values (Statistical)
MAXIFS - Returns the maximum value among cells specified by a given set of conditions or criteria (Statistical)
MDETERM - Returns the matrix determinant of an array (Math and trigonometry)
MDURATION - Returns the Macauley modified duration for a security with an assumed par value of $100 (Financial)
MEDIAN - Returns the median of the given numbers (Statistical)
MID, MIDBs - Returns a specific number of characters from a text string starting at the position you specify (Text)
MIN - Returns the minimum value in a list of arguments (Statistical)
MINA - Returns the smallest value in a list of arguments, including numbers, text, and logical values (Statistical)
MINIFS - Returns the minimum value among cells specified by a given set of conditions or criteria. (Statistical)
MINUTE - Converts a serial number to a minute (Date and time)
MINVERSE - Returns the matrix inverse of an array (Math and trigonometry)
MIRR - Returns the internal rate of return where positive and negative cash flows are financed at different rates (Financial)
MMULT - Returns the matrix product of two arrays (Math and trigonometry)
MOD - Returns the remainder from division (Math and trigonometry)
MODE - Returns the most common value in a data setIn Excel 2007, this is a Statistical function. (Compatibility)
MODE.MULT - Returns a vertical array of the most frequently occurring, or repetitive values in an array or range of data (Statistical)
MODE.SNGL - Returns the most common value in a data set (Statistical)
MONTH - Converts a serial number to a month (Date and time)
MROUND - Returns a number rounded to the desired multiple (Math and trigonometry)
MULTINOMIAL - Returns the multinomial of a set of numbers (Math and trigonometry)
MUNIT - Returns the unit matrix or the specified dimension (Math and trigonometry)
N - Returns a value converted to a number (Information)
NA - Returns the error value #N/A (Information)
NEGBINOM.DIST - Returns the negative binomial distribution (Statistical)
NEGBINOMDIST - Returns the negative binomial distributionIn Excel 2007, this is a Statistical function. (Compatibility)
NETWORKDAYS - Returns the number of whole workdays between two dates (Date and time)
NETWORKDAYS.INTL - Returns the number of whole workdays between two dates using parameters to indicate which and how 
many days are weekend days (Date and time)
NOMINAL - Returns the annual nominal interest rate (Financial)
NORM.DIST - Returns the normal cumulative distribution (Statistical)
NORM.INV - Returns the inverse of the normal cumulative distributionNote: In Excel 2007, this is a Statistical function. 
(Compatibility)
NORM.S.DIST - Returns the standard normal cumulative distribution (Statistical)
NORM.S.INV - Returns the inverse of the standard normal cumulative distribution (Statistical)
NORMDIST - Returns the normal cumulative distributionIn Excel 2007, this is a Statistical function. (Compatibility)
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NORMINV - Returns the inverse of the normal cumulative distribution (Statistical)
NORMSDIST - Returns the standard normal cumulative distributionIn Excel 2007, this is a Statistical function. (Compatibility)
NORMSINV - Returns the inverse of the standard normal cumulative distributionIn Excel 2007, this is a Statistical function. 
(Compatibility)
NOT - Reverses the logic of its argument (Logical)
NOW - Returns the serial number of the current date and time (Date and time)
NPER - Returns the number of periods for an investment (Financial)
NPV - Returns the net present value of an investment based on a series of periodic cash flows and a discount rate (Financial)
NUMBERVALUE - Converts text to number in a locale-independent manner (Text)
OCT2BIN - Converts an octal number to binary (Engineering)
OCT2DEC - Converts an octal number to decimal (Engineering)
OCT2HEX - Converts an octal number to hexadecimal (Engineering)
ODD - Rounds a number up to the nearest odd integer (Math and trigonometry)
ODDFPRICE - Returns the price per $100 face value of a security with an odd first period (Financial)
ODDFYIELD - Returns the yield of a security with an odd first period (Financial)
ODDLPRICE - Returns the price per $100 face value of a security with an odd last period (Financial)
ODDLYIELD - Returns the yield of a security with an odd last period (Financial)
OFFSET - Returns a reference offset from a given reference (Lookup and reference)
OR - Returns TRUE if any argument is TRUE (Logical)
PDURATION - Returns the number of periods required by an investment to reach a specified value (Financial)
PEARSON - Returns the Pearson product moment correlation coefficient (Statistical)
PERCENTILE - Returns the k-th percentile of values in a rangeIn Excel 2007, this is a Statistical function. (Compatibility)
PERCENTILE.EXC - Returns the k-th percentile of values in a range, where k is in the range 0..1, exclusive (Statistical)
PERCENTILE.INC - Returns the k-th percentile of values in a range (Statistical)
PERCENTRANK - Returns the percentage rank of a value in a data setIn Excel 2007, this is a Statistical function. (Compatibility)
PERCENTRANK.EXC - Returns the rank of a value in a data set as a percentage (0..1, exclusive) of the data set (Statistical)
PERCENTRANK.INC - Returns the percentage rank of a value in a data set (Statistical)
PERMUT - Returns the number of permutations for a given number of objects (Statistical)
PERMUTATIONA - Returns the number of permutations for a given number of objects (with repetitions) that can be selected from 
the total objects (Statistical)
PHI - Returns the value of the density function for a standard normal distribution (Statistical)
PHONETIC - Extracts the phonetic (furigana) characters from a text string (Text)
PI - Returns the value of pi (Math and trigonometry)
PMT - Returns the periodic payment for an annuity (Financial)
POISSON - Returns the Poisson distributionIn Excel 2007, this is a Statistical function. (Compatibility)
POISSON.DIST - Returns the Poisson distribution (Statistical)
POWER - Returns the result of a number raised to a power (Math and trigonometry)
PPMT - Returns the payment on the principal for an investment for a given period (Financial)
PRICE - Returns the price per $100 face value of a security that pays periodic interest (Financial)
PRICEDISC - Returns the price per $100 face value of a discounted security (Financial)
PRICEMAT - Returns the price per $100 face value of a security that pays interest at maturity (Financial)
PROB - Returns the probability that values in a range are between two limits (Statistical)
PRODUCT - Multiplies its arguments (Math and trigonometry)
PROPER - Capitalizes the first letter in each word of a text value (Text)
PV - Returns the present value of an investment (Financial)
QUARTILE - Returns the quartile of a data setIn Excel 2007, this is a Statistical function. (Compatibility)
QUARTILE.EXC - Returns the quartile of the data set, based on percentile values from 0..1, exclusive (Statistical)
QUARTILE.INC - Returns the quartile of a data set (Statistical)
QUOTIENT - Returns the integer portion of a division (Math and trigonometry)
RADIANS - Converts degrees to radians (Math and trigonometry)
RAND - Returns a random number between 0 and 1 (Math and trigonometry)
RANDARRAY - Returns an array of random numbers between 0 and 1. However, you can specify the number of rows and columns 
to fill, minimum and maximum values, and whether to return whole numbers or decimal values. (Math and trigonometry)
RANDBETWEEN - Returns a random number between the numbers you specify (Math and trigonometry)
RANK - Returns the rank of a number in a list of numbersIn Excel 2007, this is a Statistical function. (Compatibility)
RANK.AVG - Returns the rank of a number in a list of numbers (Statistical)
RANK.EQ - Returns the rank of a number in a list of numbers (Statistical)
RATE - Returns the interest rate per period of an annuity (Financial)
RECEIVED - Returns the amount received at maturity for a fully invested security (Financial)
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REDUCE - Reduces an array to an accumulated value by applying a LAMBDA to each value and returning the total value in the ac-
cumulator.  (Logical)
REGISTER.ID - Returns the register ID of the specified dynamic link library (DLL) or code resource that has been previously regis-
tered (Add-in and Automation)
REPLACE, REPLACEBs - Replaces characters within text (Text)
REPT - Repeats text a given number of times (Text)
RIGHT, RIGHTBs - Returns the rightmost characters from a text value (Text)
ROMAN - Converts an arabic numeral to roman, as text (Math and trigonometry)
ROUND - Rounds a number to a specified number of digits (Math and trigonometry)
ROUNDDOWN - Rounds a number down, toward zero (Math and trigonometry)
ROUNDUP - Rounds a number up, away from zero (Math and trigonometry)
ROW - Returns the row number of a reference (Lookup and reference)
ROWS - Returns the number of rows in a reference (Lookup and reference)
RRI - Returns an equivalent interest rate for the growth of an investment (Financial)
RSQ - Returns the square of the Pearson product moment correlation coefficient (Statistical)
RTD - Retrieves real-time data from a program that supports COM automation (Lookup and reference)
SCAN - Scans an array by applying a LAMBDA to each value and returns an array that has each intermediate value.  (Logical)
SEARCH, SEARCHBs - Finds one text value within another (not case-sensitive) (Text)
SEC - Returns the secant of an angle (Math and trigonometry)
SECH - Returns the hyperbolic secant of an angle (Math and trigonometry)
SECOND - Converts a serial number to a second (Date and time)
SEQUENCE - Generates a list of sequential numbers in an array, such as 1, 2, 3, 4 (Math and trigonometry)
SERIESSUM - Returns the sum of a power series based on the formula (Math and trigonometry)
SHEET - Returns the sheet number of the referenced sheet (Information)
SHEETS - Returns the number of sheets in a reference (Information)
SIGN - Returns the sign of a number (Math and trigonometry)
SIN - Returns the sine of the given angle (Math and trigonometry)
SINH - Returns the hyperbolic sine of a number (Math and trigonometry)
SKEW - Returns the skewness of a distribution (Statistical)
SKEW.P - Returns the skewness of a distribution based on a population: a characterization of the degree of asymmetry of a distri-
bution around its mean (Statistical)
SLN - Returns the straight-line depreciation of an asset for one period (Financial)
SLOPE - Returns the slope of the linear regression line (Statistical)
SMALL - Returns the k-th smallest value in a data set (Statistical)
SORT - Sorts the contents of a range or array (Lookup and reference)
SORTBY - Sorts the contents of a range or array based on the values in a corresponding range or array (Lookup and reference)
SQRT - Returns a positive square root (Math and trigonometry)
SQRTPI - Returns the square root of (number * pi) (Math and trigonometry)
STANDARDIZE - Returns a normalized value (Statistical)
STDEV - Estimates standard deviation based on a sample (Compatibility)
STDEV.P - Calculates standard deviation based on the entire population (Statistical)
STDEV.S - Estimates standard deviation based on a sample (Statistical)
STDEVA - Estimates standard deviation based on a sample, including numbers, text, and logical values (Statistical)
STDEVP - Calculates standard deviation based on the entire populationIn Excel 2007, this is a Statistical function. (Compatibility)
STDEVPA - Calculates standard deviation based on the entire population, including numbers, text, and logical values (Statistical)
STEYX - Returns the standard error of the predicted y-value for each x in the regression (Statistical)
STOCKHISTORY - Retrieves historical data about a financial instrument (Financial)
SUBSTITUTE - Substitutes new text for old text in a text string (Text)
SUBTOTAL - Returns a subtotal in a list or database (Math and trigonometry)
SUM - Adds its arguments (Math and trigonometry)
SUMIF - Adds the cells specified by a given criteria (Math and trigonometry)
SUMIFS - Adds the cells in a range that meet multiple criteria (Math and trigonometry)
SUMPRODUCT - Returns the sum of the products of corresponding array components (Math and trigonometry)
SUMSQ - Returns the sum of the squares of the arguments (Math and trigonometry)
SUMX2MY2 - Returns the sum of the difference of squares of corresponding values in two arrays (Math and trigonometry)
SUMX2PY2 - Returns the sum of the sum of squares of corresponding values in two arrays (Math and trigonometry)
SUMXMY2 - Returns the sum of squares of differences of corresponding values in two arrays (Math and trigonometry)
SWITCH - Evaluates an expression against a list of values and returns the result corresponding to the first matching value. If there is 
no match, an optional default value may be returned. (Logical)
SYD - Returns the sum-of-years' digits depreciation of an asset for a specified period (Financial)
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T - Converts its arguments to text (Text)
T.DIST - Returns the Percentage Points (probability) for the Student t-distribution (Statistical)
T.DIST.2T - Returns the Percentage Points (probability) for the Student t-distribution (Statistical)
T.DIST.RT - Returns the Student's t-distribution (Statistical)
T.INV - Returns the t-value of the Student's t-distribution as a function of the probability and the degrees of freedom (Statistical)
T.INV.2T - Returns the inverse of the Student's t-distribution (Statistical)
T.TEST - Returns the probability associated with a Student's t-test (Statistical)
TAKE - Returns a specified number of contiguous rows or columns from the start or end of an array. (Lookup)
TAN - Returns the tangent of a number (Math and trigonometry)
TANH - Returns the hyperbolic tangent of a number (Math and trigonometry)
TBILLEQ - Returns the bond-equivalent yield for a Treasury bill (Financial)
TBILLPRICE - Returns the price per $100 face value for a Treasury bill (Financial)
TBILLYIELD - Returns the yield for a Treasury bill (Financial)
TDIST - Returns the Student's t-distribution (Compatibility)
TEXT - Formats a number and converts it to text (Text)
TEXTAFTER -  Returns a string of text that occurs after a given substring in that string. (Text)
TEXTBEFORE - Returns a string of text that occurs before a given substring in that string. (Text)
TEXTJOIN - Combines the text from multiple ranges and/or strings, and includes a delimiter you specify between each text value 
that will be combined. If the delimiter is an empty text string, this function will effectively concatenate the ranges. (Text)
TEXTSPLIT - Splits text strings by using column and row delimiters. (Text)
TIME - Returns the serial number of a particular time (Date and time)
TIMEVALUE - Converts a time in the form of text to a serial number (Date and time)
TINV - Returns the inverse of the Student's t-distribution (Compatibility)
TOCOL - Returns a column vector containing all the items in the source array.  (Lookup)
TODAY - Returns the serial number of today's date (Date and time)
TOROW - Returns a row vector containing all the items in the source array.  (Lookup)
TRANSPOSE - Returns the transpose of an array (Lookup and reference)
TREND - Returns values along a linear trend (Statistical)
TRIM - Removes spaces from text (Text)
TRIMMEAN - Returns the mean of the interior of a data set (Statistical)
TRUE - Returns the logical value TRUE (Logical)
TRUNC - Truncates a number to an integer (Math and trigonometry)
TTEST - Returns the probability associated with a Student's t-testIn Excel 2007, this is a Statistical function. (Compatibility)
TYPE - Returns a number indicating the data type of a value (Information)
UNICHAR - Returns the Unicode character that is references by the given numeric value (Text)
UNICODE - Returns the number (code point) that corresponds to the first character of the text (Text)
UNIQUE - Returns a list of unique values in a list or range (Lookup and reference)
UPPER - Converts text to uppercase (Text)
VALUE - Converts a text argument to a number (Text)
VALUETOTEXT - Returns text from any specified value (Text)
VAR - Estimates variance based on a sampleIn Excel 2007, this is a Statistical function. (Compatibility)
VAR.P - Calculates variance based on the entire population (Statistical)
VAR.S - Estimates variance based on a sample (Statistical)
VARA - Estimates variance based on a sample, including numbers, text, and logical values (Statistical)
VARP - Calculates variance based on the entire populationIn Excel 2007, this is a Statistical function. (Compatibility)
VARPA - Calculates variance based on the entire population, including numbers, text, and logical values (Statistical)
VDB - Returns the depreciation of an asset for a specified or partial period by using a declining balance method (Financial)
VLOOKUP - Looks in the first column of an array and moves across the row to return the value of a cell (Lookup and reference)
VSTACK - Appends data to the first blank cell at the bottom of a range.  (Lookup)
WEBSERVICE - Returns data from a web service.This function is not available in Excel for the web. (Web)
WEEKDAY - Converts a serial number to a day of the week (Date and time)
WEEKNUM - Converts a serial number to a number representing where the week falls numerically with a year (Date and time)
WEIBULL - Calculates variance based on the entire population, including numbers, text, and logical valuesIn Excel 2007, this is a 
Statistical function. (Compatibility)
WEIBULL.DIST - Returns the Weibull distribution (Statistical)
WORKDAY - Returns the serial number of the date before or after a specified number of workdays (Date and time)
WORKDAY.INTL - Returns the serial number of the date before or after a specified number of workdays using parameters to indi-
cate which and how many days are weekend days (Date and time)
WRAPCOLS - Wraps the provided vector by columns after a specified number of elements. (Lookup)
WRAPROWS - Wraps the provided vector by rows after a specified number of elements. (Lookup)
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XIRR - Returns the internal rate of return for a schedule of cash flows that is not necessarily periodic (Financial)
XLOOKUP - Searches a range or an array, and returns an item corresponding to the first match it finds. If a match doesn't exist, then 
XLOOKUP can return the closest (approximate) match. (Lookup and reference)
XMATCH - Returns the relative position of an item in an array or range of cells. (Lookup and reference)
XNPV - Returns the net present value for a schedule of cash flows that is not necessarily periodic (Financial)
XOR - Returns a logical exclusive OR of all arguments (Logical)
YEAR - Converts a serial number to a year (Date and time)
YEARFRAC - Returns the year fraction representing the number of whole days between start_date and end_date (Date and time)
YIELD - Returns the yield on a security that pays periodic interest (Financial)
YIELDDISC - Returns the annual yield for a discounted security; for example, a Treasury bill (Financial)
YIELDMAT - Returns the annual yield of a security that pays interest at maturity (Financial)
Z.TEST - Returns the one-tailed probability-value of a z-test (Statistical)
ZTEST - Returns the one-tailed probability-value of a z-testIn Excel 2007, this is a Statistical function. (Compatibility)

Tip: The sample workbook for this chapter contains a refreshable Power Query script to update 
this list.

Dedication
To The Space Coast Chapter of The IIA. I promised I would have this book done in time for our March 23, 
2022 webinar!
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3D Map  231
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Action pen  186
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Add to Selection  261
Adkins, Kevin  269
Advanced Formula Environment  190
Agarwal, Ashish  261
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Albert, Peter  90
Alexander (cutout person)  56
Ali, Areef  41
AlphaFrog  270
Alt+;  69
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Alt+DEF  141, 263
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Alt+Enter  63
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Alt+F1  41, 262
Alt+OCA  66, 263
Alt+TI  215, 263
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Alt for snap to grid  263
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Analyze Data  106
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Animal  160
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Application key  124
Applied Steps  224
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Arceneaux, Hayley  283
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Arif (cutout person)  56
Armstrong, Ron  129
Arnott, Myles  122
Array constant  170
Array formula

Dynamic arrays  165
for range of dates  175

Artificial intelligence  106
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Inquire  127
Trace Dependents  127
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AutoComplete  261
AutoFill  14
AutoFilter  7, 83
Autofit columns  66, 263
AutoRecover

Recover unsaved changes  26
AutoSave  31
AutoSum
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in a Macro  221

AVERAGE  50
AVERAGEIFS  153
Avoiding blank columns  61
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Baak, Charley  90
Babin, Jo Ann  24
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Back into answer  210
Bagel flavors  13
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Banana  160
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Bansal, Sumit  266
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Barker, Bob  210
Barresse, Zack  245, 270
Barry Houdini  270
Baylis, Dave  239
Bell curve  48
Benaim, David  161
Benninga, Simon  214
Bennu asteroid  213
Berlin, George  112, 283
Bernath, Matthew  261, 262
Best_excel  239
Bezenšek, Mitja  259
Bilingual worksheet  165
Billboard magazine  171
Bing  155
Birthday  269
BizNetSoftware  212
Blake, Geoffrey  201
Blank rows, avoiding  61
Blessitt, Sean  266
Bonus formula  137
Book.xltx

Cumulative  22
for SheetName formula  15

Boolean logic  138
Bott, Ed  125
Branching  200, 240
Branco, Marcelo  270
Brandt, Arnout  266
Break apart data  3
Bricklin, Dan  215
Broas, Christopher  250
Brown, Derek  246
Budget versus actual  112
Bullet point shortcut  196
Bullets  243
Burkett, Lisa  266
Buzbee, Dawn Bjork  260
BYCOL  205
Byrne, Michael  261
BYROW  205
Bоробьев, Александр  81

C
Caballero, Miguel  86
Café  125
Calendar with SEQUENCE  173
Call for Help  269
Cambridge  200
Camera tool  58, 93, 100, 253
Captain Excel  259
Carey, Drew  210
Carmichael, D.  3
Carruthers, Scatman  161
Cartoon Bob  283
Cartoon people  56
Case, changing

in Word  243
with VBA  258
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Cecilia  270
CELL  15
Cell reference

from INDEX  183
from XLOOKUP  147

Cell styles  126
Modifying  21

Cell tooltip  38
Celsius  162
CEO  158
Change all sheets  16
Changes pane, clearing  29
Charles, Neil  261
Charts

Bell curve  48
Combo  45
Ctrl+T  89
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Funnel  47
Gap width  46
Hiding data  43
in 1 Click  39
Interactive  43
Labels from cells  51
Map  47
Paste new data  41
Pictographs  266
Remove data  42
Resizing handle  42
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Sparklines  95
Switch Row/Column  44
Template  40
Two pie  266
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Chat  36
Check for Errors  185
Check writer  238
Chemistry  160
Cher  1
Chis, John  64
CHOOSECOLS  179

like INDEX from end  266
CHOOSEROWS  179
Church, Alonzo  190
Cintellis  259
Clark, Khalif John  141
Clean data  221
Clean Excess Cell Formatting  129
Clear filter  254
Cleveland, Ohio  264
Clipboard

Performance improvements  185
Sync across devices  239

Clock  269
Close & Load  223
Cloud clipboard  239
Cloud-shaped note  36
Co-authoring  30
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COBOL  140
Cockpit simulator  267
Collapse Ribbon  99
Collie, Rob  112, 114
Colo  270
Color scale  52, 213
Columbus, Indiana  123, 161
COLUMN  269
Column by example

Flash Fill  236
Column labels  76
Columns

Change sequence  65
Column widths, lining up  99
Comma style  23
Comments  36

Legacy  36
Compare files with Inquire  129
Compare lists  92

Go To Special  94
Computer America radio  283
Concatenate range  207
CONCATENATEX  115
Conditional formatting

Banded rows  266
Color scales  52
Data bars  53
Data visualizations  52
for Duplicates  266
Icon sets  54

Conditions, multiple  152
Consolidate  71
Constraints  216
Contextures.com  86
CONVERT

for temperature  162
Convert to Number  185
Copy Here As Values Only  124
Copy worksheet  14
Cosine  195
Count distinct  111
COUNTIF  152
COUNTIFS  153
Count without COUNT  266
CPE  267
Crash  188
Create relationship  110
Create Table dialog  87
CSV hassle  209
Ctrl+.  259
Ctrl+’  264
Ctrl+[  262
Ctrl+*  260
Ctrl+`  261
Ctrl++  69
Ctrl+1  209, 259
Ctrl+5  259
Ctrl+Arrow  259
Ctrl+B  264
Ctrl+Backspace  260
Ctrl+C  264
Ctrl+D  2
Ctrl+Enter  260
Ctrl+I  264
Ctrl+J  5, 63
Ctrl+N  19, 264
Ctrl+PageDown  260
Ctrl+Shift+Enter  165, 207

versus Dynamic arrays  175
Ctrl+Shift+L  263
Ctrl+T  264

for Chart data  89
for Pivot data  87

Ctrl+U  264
Ctrl+V  264

Ctrl+W  263
Ctrl+X  264
CTroy  73
Currency format  237
Current region  61

in VBA  266
Custom lists  12
Custom number format  237
Custom sort  64
Cutout People  55

D
Dalgleish, Debra  86, 254
D’Amico, Bob  ii, 71, 118, 283
Dan from Philly  86
Dashboard  59

with Slicers  95
Data bars  53
Data card  160
Data Consolidate  71
Data Model

Budget versus actual  112
Count distinct  111
for Top 10  85
from Power Query  224
Replaces VLOOKUP  109

Data profile  225
Data setup  61
Data table  212
Data types  154

Custom with Power Query  164
Refreshing  157

Data Validation
for tooltip  38
partial matching  38
using Custom number format  238
with a formula  176

Data visualizations  52
DATE  188
DATEDIF  266
Date formatting codes  238
Date rollups in pivot table  79
Dates

Copy instead of fill  12
Date stamp  260
DATEVALUE  162
DAX formula language  114
DAY  175, 188
de Bruin, Ron  263
Decker, Joerg  266
de Diego, José  259
Default settings  19
Delete all unsaved workbooks  26
Delimiters, Consecutive  5
Denis, Othneil  18
Dependent validation

with COUNTIF formula  176
with Dynamic arrays  176

DeVito, Danny  161
Diagram view  117
Dialog launcher  23
Dickerman, Howie  79
DiffEngineX  266
Distinct count  111
Ditto  264
Document Location  255
Domenic  270
Don‘t Save All  25
Dot leaders  5
Double underline  106
Drawing data  186
Drawing with X/Y  266
Drill down in pivot table  266
DROP  178
Duplicates

Preview  149
Remove  112

with Cond. Formatting  266
Durran, John  92
du Soleil, Oz  245
Dynamic arrays  165

Dependent validation  176
inside COUNTIF  172
in XLOOKUP  146
Spiller notation F5#  172
versus Ctrl+Shift+Enter  175

E
Early, Diarmuid  266
EDATE  266
Edgar, Brad  239
Edit Custom Lists  12
Edit Directly in Cell  266
Edwards, Peter  266
Eikeland, Snorre  90
El Paso, TX  154
Employee calendar  135
Enable Background Refresh  225
End-of-Table marker  88
EOMONTH  188
Errors, suppress  151
Escobar, Miguel  226
Evaluate Formula  147
Exact match VLOOKUP  139
Excelapalooza  22
Excel by Joe  152
ExcelCity  250
Excel Encyclopedia  161
Excelforo  260
Excel function clock  269
ExcelIsFun  109
ExcelKOS  141
Excel master pin  268
ExcelNewss  259
Excel Online, accessing  28
Excel Options  258
Excel Turbo  165
Exchange rates  157
EXPAND  178
Expanding range  120, 149
Exponent  269
Exponential trend smoothing  233
Extract to Grid  160
Eye Dropper  245

F
F1 Key missing  126
F2 & Esc  125
F4  118
F5  263
FACT  269
Factorial  269
Fahrenheit  162
fairwinds  270
Farmers' market  134
Fast formula copy  1
Federice, Nancy  90
Feechan, Glen  122
Feedback  187
FeedbackPortal  87
Feedback to Excel team  87
Feedback with sound  247
File types  21
Fill blanks with 0  72
Fill down  2
Fill Handle

Custom list  12
for a Series  11
for Formula copying  1
Right-click  12
with Ctrl  11

Fill outline view  222
Fill series

of 100K  14
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to interpolate  219
Fill weekdays  12, 133
Filter

by Color  70
by Selection  7
Color used headings  266
Over/under  9
Reapply  254
Using Search box  7
Visible sum  10

FILTER  168, 207
Filter Connections  97
Filtered Data

Inserting columns  185
FIND  15
Find & Replace formats  244
Fintega Financial Modelling  183
Fiscal year  14
Fishel, Shelley  3, 122
Fishman, Justin  152, 266
Flash Fill  236

after Consolidate  72
Flavor Flav  269
Fliss, Mike Dolan  259
Flowcharts  235
FL Space Coast chapter of IIA  239
Fluff  270
Food  160
FORECAST.ETS  233
Forecast sheet  233
For Empty Cells, Show  78
Forgot to save  25
Format as Table

before Data model  109
for VLOOKUP or charts  89

Format cells to protect  209
Format Comment dialog  37
Format one cell  77
Format subtotals  69
Forms  240
Formula

Copying  1
for Unique  171
Highlight all  126
Highlight with CF  266
Protect  209
Select  210
to Filter  168
to Sort  166
to Values  123
Visualize  243
with Mouse  256

FORMULATEXT  136
Foster, Colin  264
Fraley, Derek  66, 70
Frankston, Bob  215
Freeze Panes  251
Fries, Thomas  260
From Selection  222
Frontline Systems  215
Full screen Excel  266
Full Screen mode  262
Function Arguments dialog  129

with Nested functions  131
Function clock  269
Funnel charts  47
Fuzzy Match  227
Fx icon  129
Fylstra, Dan  215

G
Gainer, David  246
Galvão, Cristiano  165
Games in Excel  266
Gamestop  159
Garcia, Rob  226
Gardner, Alexa  259

GCD  269
General Electric  264
Geography data types  154
GetPivotData

Preventing  80, 103
Syntax  105
Uses for  103

Gilbert, Dawn  3
Gilmer, Stephen  152
Girvin, Mike  151, 175, 226, 239, 259, 261
GitHub  193
GlennUK  270
Goal Seek  210
Goldmeier, Jordan  266
Gold star  54
Gonzalez, Juan Pablo  270
Go To Special  69

Blanks  222
Constants  126, 266
Row Differences  95

Govier, Roger  174, 260
Graphs. See Charts
Grave accent (`)  125
Greatest common denominator  269
Greer, Olen L.  266
Gridlines, hiding  99
Group and Outline buttons  66
Group dates  79
Group mode  16
Group objects  61
Grove, Harlan  18

H
Hager, David  263
Hahn, Patty  141
Hansberry, Ed  258
Hartville Marketplace  91
Hatch Show Print  267
Hauser, Ray  226
Hawighorst, Ingeborg  172
Hawley, Dave  270
Hazlett, Bill  261
Headings, single row  61
Heffa100  262
Help via notes  36
Henning, Tom  141
Hidden cell, Selecting with F5  263
Hide Excel  99
Hide Ribbon  99
Hiding data with ;;;  238
hiker95  270
Holidays  133
Hot, Jeneta  260
Houdini, Barry  270
HowToExcel  266
HSTACK  178
Huish, Scott  270

I
IBM  5
Icons  56, 100
Icon sets  54

Up/Down markers  93
Ideas  106
Idora Park  216, 217
IF  137

Nested versus lookup  150
with AND  138

IFERROR  151
IFNA  141, 152, 201
IFS  151
Illustrations  56
Implicit intersection  165
Include Filtered Items  85
INDEX  59, 136

from end with CHOOSECOLS  266
Returning entire column  266

with :  183
INDEX/MATCH  131
INDIRECT

between worksheets  18
INDZARA  152
Inquire  127
Insert Cells shortcut  69
Insert Function icon  129
Insights  106
Institute of Internal Auditors  267
Institute of Managerial Accountants  267
INT  269
Interest calculation  173
Interest rate  130
International Text Comparison  185
Interpolate  218
IPMT function  173
Isaacman, Jared  283
ISERR  151
ISERROR  151
ISNA  151
ISNUMBER  266
ISOMITTED  202
iTrainerMX  106

J
Jancsy, Dennis P.  236
jindon  270
JLGWhiz  270
Joe4  270
JoeMo  270
Joiners  112
Joining text and date  2
Join tables  109
Jonmo1  270
Jon von der Heyden  270
Juhasz, Szilvia  90, 91
JulianExcelTips  259
just jon  270

k
Kasem, Casey  172
Kellett, Matt  259
Kennedy Space Center  232
Kent, Ohio  12
Khalilov, Elchin  259
Knowles, Don  90
Knutsford_admi  3
Krishnan, Vijay  266
Kryuchkova, Olga  18, 41, 87, 129, 237, 259, 

260, 266

L
LAMBDA  190

Branching  200
Looping in  195
to return photo  200

LAMBDA editor  190
Lambda Explorer Add-in  194
Lane, Greg Lambert  3
Lanning, Dan  250
Lapajne, Andrej  259
Laporte, Leo  269, 283
LARGE  206
Las Vegas, NV  163
Lawson, Bathazar  254
LCM  269
Leading zeros  4
Leaf_xl  266
Least common multiple  269
Legg, Colin  122
Lehrbass, Kevin  92
LEN  269
Lenovo  124
lenze  270
LET  188
Lewis, Laura  125, 262
Likert survey  240
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Linefeed  5, 63
Lining up dashboard tiles  99
Linked Cell with Ctrl+[  262
LinkedIn  291
Linked picture  58

Up/Down markers  93
verses Camera  253

Links, Finding  266
List format  61
Ljung, Tobias  80
Loan payment  129
Location  160
Locked property  209
Logan, Francis  3, 90
Logical test, multiplying by  138
Long, Crystal  259, 260
Longitude  156
Look-ahead validation  38
Lookup pictures  100
Loop counter  197
Loop in LAMBDA  195
Lotus 1-2-3  215, 220
Lower case with VBA  258

M
Mac, Danny  151
Mack, Chris  266
Macro Recorder

Power Query  221
VBA  220

Madonna  1
Magic cell  83
Magnifier  241
Malik, Sagar  258
Manual calculation  248
MAP  202
Map Charts  47
Map icon  154
Mapping Excel data  231
Margins  20
MARK858  270
Mark W.  270
Marriott, Dave  258, 263
Master Your Data  226
Matt’s Script Archive  270
MAX  206
MAXIFS  206
Mayoh, Dan  183
McCarthy, Patricia  70
McClelland, Mac  22
McCready, Steve  259
McDaid, Joe  142, 145, 174
McLean, Ken  125
mdhExcel  266
Medical data type  160
Melton, Beth  26
Mention  36
Meonske, Norm  12, 14
Merged Cells

Deleting  185
Merged cells for sparklines  98
Merge Shapes  245
Merritt Island, Florida  232
Met, Melih  125
Michael, Colin  90, 111, 226
Michaloudis, John  97
MickG  270
Microsoft 365  183
Microsoft Research  200
MID  15
mikerickson  270
MILES between cities  195
Millers, Pedro  266
Millions  238

Chart display units  39
MIN  206, 269
MINIFS  206

Minus sign, trailing  5
Mixed reference  120
MN Excel Consulting  151
Moala, Ivan F.  270
model_citizen  259
ModelOff  126
Moede, James E.  90
Mole999  270
Momrik, Al  18
Monroe, Marilyn  161
MONTH  188, 269
Months, filling  11, 12
Moore, Walter  ii, 200, 218, 238
Mourad, Nabil  131
Move or Copy, alternative  14
Movie data type  160
Multiple Consolidation Ranges  73
Music data type  160
Mvmcos  151
Myers, Bradford  264
MyExcelOnline.com  97

N
Name

Instead of $  122
Paste  261
Shift+Enter in  14

NAND  138
NASA  232
Nashville, Tennessee  267
NateO  270
Nature data type  160
NeedForExcel  65
Nested functions  131
NETWORKDAYS  133
NETWORKDAYS.INTL  133
New versus New...  21
Njoko, Nathi  153
Non-contiguous cells  260
Norie  270
NORM.DIST  49
NOT  138
Notepad formulas  266
Notes  36
NPV  266
NPV Error  266
Number formats

Examples  237
Shortcuts  261

O
Obstructing cells  166
Office 365  183
OfficeInstructor.com  131
OFFSET  59, 100, 266

versus INDEX  183
Oldbrewer  270
Oliver, Nate  270
Oluwa, Schmuel  259, 260
O'Mara, Tim  260
OneDrive  28
One hit wonders  172
Open in Excel  31
OR  138
Orders of Magnitude  45
Ortenberg, Michael  3
Osman, Abshir  153
Outlook  31
Ozgur, Suat  196, 200, 270, 272

p
PaddyD  270
Parentheses color  151
Parkinson, Cat  266
Parsing data  3
Passwords are unreliable  210
Paste from Clipboard  185
Paste Linked Picture  61, 100, 253

Paste Options  135
Paste Special  6

Formulas  106
Skip Blanks  124

Paste Values  123, 250
Patel, Keyur  90
Paterson, Jon  3
PDF

Publish as  252
PDF to Excel  244, 246
Peev, Igor  232
Pele  1
Peltier, Jon  259
Pen, Action  186
Penny pitching  214
People, Cutout  55
People data type  160
Performance Improvements  185
Personal macro workbook  256
Peter_SSs  270
Peton, Paul  90
Petrova, Boriana  151
PFChangsAddict  251
pgc01  270
Photos from Dropdown List  266
PhotoShop  60
PI  269
Picture lookup  100
Pictures, Toggle  58
Pie chart with two pies  266
Pierson, Scott  270
Pieterse, Jan Karel  243
Piñata  125
Pivot Power add-in  86
Pivot table  174

asterisk  86
Autofilter  83
Bug with 32768  116
Change Data Source  87
Changing calculation  81
Colors & format  76
Column Labels  76
Compare lists  92
CONCATENATEX  115
Consolidation  73
Count distinct  111
Count instead of sum  81
Data model  85
Date rollups  79
Defaults  86
Default theme  20
% Difference from  80
Drill down  266
Dynamic arrays  174
Expandable  87
Field Settings Shortcut  81
Fields pane  74
Fields Pane side-by-side  79
Filling blanks  78
First  74
for Dashboards  96
Format one cell  77
Formats  76
Grand totals  80
Group Field  79
Icons  75
Measures  114
Multiple Consolidation Ranges  72
New data  87
Number format  77
% of Column Total  81
Outline view  78
Pivoting  76
Rearranging fields  76
Refresh  88
Removing field  76
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Repeat Item Labels  78
Replicate for each  90
Slicer Connections  97
Tabular Form  76
Text  115
Top 5  81
Value filters  82
with Data model  109
with GetPivotData  106
Year-over-year  79

Plant data type  160
Plural conditions  152
PMT  131, 269
Point mode stops  266
Population  154
Pop-up pictures  37
Porat, Meni  266
Portable formulas  114
Poulsom, Andrew  270
Power Map  231
Power Pivot

Budget versus actual  112
Diagram view  117
Formulas  114
Replaces VLOOKUP  109

PowerPivotPro.com  112
PowerPoint

Eye Dropper  245
Merge shapes  245

Power Query  221
Applied Steps  224
Create data types  164
Data profile  225

Precedents  266
Presence, muting  31
Previous Version  29
Price is Right, The  210
Price Waterhouse  138
Proctor, Sian  283
Prodiance  128
Program key  124
Project Explorer  257
Project yellow  154
Proper case

with PROPER  1
with VBA  258

Protect formulas  209
Protecting rows  136
Protect Sheet  210
Puls, Ken  226, 260

Q
Quarters, filling  11
Quarter & year, filling  11
Quibdo, Colombia  163
Quiceno, Alejandro  111
Quick Access Toolbar  248

AutoFilter  7
Below the ribbon  256
Gallery vs. icon  251
Shortcuts  252
VBA macros  256

Quick sum  16
Quilt patterns in Excel  267

r
Radakovitz, Sam  10
Raiff, Peter  260
RAND  174
RANDARRAY  174
RANDBETWEEN  126, 174
Random numbers  174
Random selection  266
Random walk  214
Real-Time Data bottlenecks  185
Reapply filter  254
Recent Files icon alternative  253

Recent Workbooks  27
Recover unsaved workbooks  25
Recursive LAMBDA  195
Redo with F4  121
REDUCE  203
Reekers, Martijn  126
Refresh All  158, 225
Refresh Power Query  224
Refresh Settings  158
Relationship diagrams, Inquire  128
Relationships  113

Creating  110
Remove Background  60
Remove Duplicates  112, 149
Rempel, Michael A.  266
Repeat with F4  118
Reshaping array  180
Resource Optimizer  237
Ribbon, collapse  99
Rieb, Cecelia  90, 266
Right-click  264
Right-click key  124
Ringstrom, David  71, 266
ROMAN  269
RoryA  270
Rotation  57
Rothschiller, Chad  237
Rothstein, Rick  270
ROW  136, 175
Row 2  268
Row Differences  95
Ruble, Scott  232
Russell, Scott  153

S
Sales Funnel  47
Sales tax  119
Sasur, Paul  259
Save a Copy  32
Save As Other Formats  251
Scale to Fit  19
SCAN  204
Schollar, Richard  270
Screen clipping  253
Scrollbar maximums  266
Scrollbars, hiding  99
Scrolling tips  242
Scroll Lock  266
Seaman, Paul  26
Search box, Collapse  265
Search for a function  129
Search for files  27
Seasonality  233
Second instance  264
See all formulas  125, 261
Select all sheets  17
Select entire column  261
Select Formulas  210
Select obstructing cells  166
Sembroski, Chris  283
Sensitivity analysis  212
Sentiment analysis  234
SEQUENCE function  173
Set As Default Chart  40
Settings, default  19
Set Transparent Color  60
Shapes, Merge  245
Shared With Me  30, 31
Shared workbook  30
Shaw, Glenna  245
SheetName  15
Sheet name formula  15
Sheet tabs, hiding  99
Sheet View  32
Sherraden, Jim  267
shg  270
Shift+Enter with Name box  14

Shift+F11  262
Shift Cells Down  69
Show all sheets  258
Show Changes  28
Show formulas  125
Show Report Filter Pages  91
Sideways, turn  135
SIGN  93
Sign, adding text  57
Signals catalog  269
Similarity threshold  229
Simon, Sven  129, 260
Simplex LP  216
Simpson, Richard  143, 200
Sitoy, Ryan  153
Skip Blanks  124
Slicer Connections  97
Slicers  95

as Title  102
for 2 data sets  116
for 2 Pivot tables  97
for a Table  44

Slipstream  20
Slugify  196
SMALL  206
SmartArt  243
Smith, Chris  270
Smitty  270
Smooth scrolling  242
SnagIt  253
Snap to grid  263
Snipping tool  61, 253
SolveAndExcel.ca  225
Solver  215
Sorting

by Color  70
Custom  64
Left to right  65
SORT  166
SORTBY  166
Subtotals  66
West to east  156

Sound  247
Space Coast IIA  239
Space data type  160
Spacing

using Custom number formats  238
Spain, Andrew  12, 237
Sparklines  95
Speak Cells  246
Spearing sum  17
Spiller reference  172
Split to Rows  184, 225
Sprakes, Wendy  41
Spreadsheet Inquire  127
Springfield, Missouri  66, 154, 160
SQRT  269
Starl  270
Start Screen  258
State charts  47
Status bar stats  16
STDEV.P  50
Stewart-Seume, Bryony  125
Stickers  56
Stock data type  157

Refresh setting  158
STOCKHISTORY  159
Stock price  158
Strategic Finance  283
Strikethrough  259
Subscript  184, 255
SUBTOTAL  10
Subtotals

Adding  66
Copying total rows  69
Filling text field  68
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Formatting  69
Sorting  66

Suggestion box for Excel  87
Sullivan, Kevin J.  237
SUMIF  152
SUMIFS  152

Speed  185
Summary report with INDIRECT  18
Summing visible  10
SUMPRODUCT  153, 175
Sum through sheets  17
Superscript  255
Survey in Excel  240
Swim-lane chart  235
Swinford, Echo  245
SydneyGeek  270
Syrstad, Tracy  90, 270

T
Tables

Chart data  89
for Formula copy  2
for Pivot data  87

Task Panes, Collapsing  187
Template for charts  40
TEXT  112, 188
TEXTAFTER  208
TEXTBEFORE  208
Textbox  57
TEXT function  2
TEXTJOIN  102, 207
Text numbers

Converting  263
Text Numbers  5
TEXTSPLIT  208
Text to Columns  3

for Alt+Enter  63
Teylyn  172
Thehos, Andreas  151
Theme  20
Thomas, Chad  ii, 211
Thousands  238
Threaded comments  36
Three triangles  93
Tilde (~)  125
Time stamp  260
Tiny charts  95
TOCOL  180
tomatecaolho  141
Toole, Marlette  239
Tooltip for a cell  38
Top 10 AutoFilter  84
Top 80%  82
Topaz Mask AI  60
Top level budget  112
TOROW  180
Total

after December  14
all sheets  17
in 1 click  16
visible  10

Trace Dependents  127
Trace Precedents  127
Trailing minus  5
Trailing spaces  140
Transparent

Images  60
Text box  57

TRANSPOSE  135
Transpose data  135
Treacy, Mynda  101
TRIM  15, 140
Truby, Greg  270
Tufte, Edward  98
Turing, Alan  190
Turn data sideways  135
Turner, Kathleen  160

tusharm  270
Twisted lookup  148
Twitter  250, 291
Two-way XLOOKUP  148
TypeScript  221

u
UDF in Hyperlink  266
Umlas, Bob  122, 219, 262
Undo stacks, separate  264
Undo with co-authoring  32
Ungroup sheets  17
Unhide multiple sheets  186
UNIQUE

versus Distinct  171
Unique count in pivot table  111
University data type  160
University of Akron  91
Unpivot  223
Unsaved workbooks  25
Up/Down markers  93
Upper case with VBA  258
Urtis, Tom  270
user-defined functions  194
UserVoice  87

moved to Feedbackportal  87

v
Vachris, Alfred  38
Validation

Dependent  176
for Tooltip  38
look-ahead  38
with Formula  176

Valko, Tony  270
VALUES dax function  115
van den Brink, Johan  261
Van Geit, Erik  270
Variables in Formula  188
VBA

Alternative - TypeScript  221
CurrentRegion  266
for QAT  256
Launch with hyperlinks  266
Macro recorder  220
Synchronize slicers  97
UserName  266

VBA Editor  257
Version history  29, 32
Versions, rolling back  29
Vertex42  101
Very hidden sheets  258
Veto, minimizing  31
Visible Cells Only  69, 249
Visible cells, total  10
VisiCalc  215
Visualizations  52
VLOOKUP

ends in False  139
Explained  139
#N/A error  139
Numbers as text  141
Pictures  100
Replace with Data Model  109
Trailing spaces  140
Troubleshooting  139
Two tables  141

VoG  270
Voice  246
Volatile function  152

OFFSET  183
von der Heyden, Jon  270
Von Pookie  270
VSTACK  178

w
Walker, Andrew  263
Wärnelid, Rickard  263

Warrington, Adam  250
Waterfall chart  46
Waterton, Alex  251
Weather  161
WEEKDAY  175
Weekdays, filling  12
Wendel, Marti  236
What-If, using Data Table  212
Whyte, Gavin  260
Wildcard

in VLOOKUP  141
in XLOOKUP  146
Searching for  126

Williams, Charles  194
Williams, Tracia  137
Willikers, AJ  250
Wilson, Kitty  ii
Wilson, Ryan  101
Win streak  215
Wittwer, Jon  101, 212, 266
Wolfram Alpha  160
Wong, MF  258
Word

for PDF  244
Replace format  244

Word tricks  243
Word Wrap  63
Workbook Analysis  128
Work calendar  135
WORKDAY.INTL  133
Worksheet copy  14
Worksheet name from formula  15
Work week  133
WRAPCOLS  135, 182
WRAPROWS  182
Wright, Paul  266
WSJ stock chart labels  239
WWWBoard  270

X
Xenforo  270
xenou  270
XL2BB  272
XLOOKUP  142

last match  145
with Wildcard  141

XLSB opens faster  21
XLStudioWorks  259
XMATCH  201
XOR  138
XY-Scatter  50

y
YEAR  188
Year-over-year  79
Year & quarter

Filling  11
Years, filling  12
Year To Date  45
Yoga data type  160
Young, Colleen  95
YouTube  55, 143, 291
Yundt, Brad  208
YYYYMMDD format  5

z
Zelany, Nathan  122
zenou  270
Zeros, leading  4
Zip code boundaries  47
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Connect with Bill Jelen on Twitter, LinkedIn and youTube

Follow @MrExcel on Twitter 
for Excel Tips in 280 charac-
ters plus retweets of cool Excel 
tips from my friends.

Search for Bill Jelen on LinkedIn 
and click Connect. Optionally, 
mention "I was in your seminar" 
or "I read your book". However - I 
accept all connection requests on 
LinkedIn.

Search for MrExcel.com on 
YouTube for a collection of 
2300 Excel videos. Click Sub-
scribe and ring the bell to hear 
when there is a feature newer 
than this book.
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what is New in this 2022 Edition
Thanks for buying the 2022 edition of my book. What's new as of this 2022 edition:
"#10 Search While Using File Open" on page 27
"Bonus Tip: Pin an Item to the Top of the Recent Files" on page 27
"#11 Show Changes From Last 60 Days" on page 28
"Bonus Tip: Roll Back to a Previous Version of the Workbook" on page 29
"Bonus Tip: Avoiding the Veto" on page 31
"Bonus Tip: Data Validation Partial Matching Added in 2022" on page 38
Cartoon people added "#25 Use  People to Add Interest to Your Worksheet" on page 55
"Bonus Tip: Replace Blank Values Cells With Zero" on page 78
Changed "#35 Create a Year-over-Year Report in a Pivot Table" on page 79
"XLOOKUP Benefit 9: Return All 12 Months in a Single Formula!" on page 146
Updated "Bonus Tip: Use Data, Refresh All to Update Stock Data" on page 157
"#77 Generating Random Numbers in Excel" on page 174
"#81 Stack Multiple Arrays" on page 178
"#82 Dropping, Taking, or Choosing from an Array" on page 178
"#83 Reshaping an Array to a Vector and Back" on page 180
"#84 Getting the UNIQUE of a Rectangular Range" on page 181
"#85 Shuffling and Dealing a Deck of Cards" on page 181
Updated "#95 Store Complex Formula Logic in LAMBDA function" on page 190
"#96 New LAMBDA Helper Functions" on page 202
"#98 Text Before or After a Specific Delimiter" on page 208
"#99 Split Text into Words Using TEXTSPLIT" on page 208
"#105 Interpolate between a starting and ending number" on page 218
"#116 Paste to Another Computer Using Cloud Clipboard" on page 239
"#119 New Scrolling Tricks" on page 242
"25. Ctrl+Shift+F1 for Full Screen Mode" on page 262

What's new in 2021:
Updates to "#44 Ask Excel's A.I. a Question About Your Data" on page 106
Faster "#3 Convert Text Numbers to Numbers Quickly" on page 5
"#13 Save Filter & Sorting in Sheet View" on page 32
Resolve comments in "#14 New Threaded Comments Allow Conversations" on page 36
"#25 Use  People to Add Interest to Your Worksheet" on page 55
"Bonus Tip: Use a Formula to Toggle Pictures" on page 58
"#26 Make an Image Semi-Transparent" on page 60
"#27 Save Any Object as an Image" on page 61
"#65 Get Historical Stock History from STOCKHISTORY" on page 159
"#66 More Data Types from Wolfram Alpha" on page 160
"#67 Getting Historical Weather For a City" on page 161
"#89 Unhide Multiple Worksheets" on page 186
"#90 Write Your Data with the Action Pen" on page 186
"#91 Many Task Panes Now Collapse into a Tab Strip" on page 187
"#94 Use the LET Function to Re-Use Variables in a Formula" on page 188
"#95 Store Complex Formula Logic in LAMBDA function" on page 190
"Bonus Tip: Use TypeScript to Write Macros for Excel Online" on page 221
"Bonus Tip: Tame the Sequence of Refresh All" on page 225
"#129 Excel Function Quick Reference" on page 274
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